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16 Understanding iLife ’05
Can’t make the ﬁve apps living in Apple’s new creativity suite get along? Our
experts answer questions and give advice about common GarageBand 2, iPhoto
5, iMovie HD, iDVD 5, and iTunes issues. by Shelly Brisbin, Brad Miser, Andrew
Tokuda, and Johnathon Williams
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Too much typing turning your
mitts into twisted talons? Here
are some keyboards that may help
save your wrists. Just don’t get too
self-conscious—some of them look
kinda funny. by Jake Widman
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Don’t know xD from SD? Wondering where to shove your Memory
Stick? Our ﬁeld guide to media cards will help you keep your
digital-camera storage options straight. by Fredric Paul

how to
52 Ask Us

We show you how to make Yahoo and Hotmail get along with Mail, train you how to break
the password protection on encrypted PDFs, and teach you what to do with those annoying
expired demos that just won’t go away. We’ve even got a sewing tip this month!

54 Max Out
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mini just the way it is, but
our resident mad scientist (and How-To
editor) knows secret ways to unlock its
hidden potential–some of which are
crazier than others. by Niko Coucouvanis

59 Convert PC Video
Files to QuickTime
Sick of running into WMV and AVI ﬁles
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Here’s how to translate alien video
formats into something QuickTime can
understand. by Johnathon Williams

60 Put Linux on Your iPod
Prove your supreme geekery to the
world by installing everyone’s favorite
open-source operating system on your
personal music player. Make a penguin
proud! by Alex Handy

61 Use Skype
to Chat While
Gaming
Typing’s so 2004.
You can speak with
your friends in World of Warcraft and
other online games by using Skype, a
powerful, simple-to-set-up online voicechat app. by Chris Barylick
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78 Letters
Our readers tell us their blog
secrets, show us their crafty iPod
cases, and—best of all—share
their cookies! Also, one astute
reader uncovers a disc-design
conspiracy worthy of The X-Files.
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speakers from DVForge and have
your neighbors call the cops on
your next party.
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Apple’s mass-market
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FROM THIS MONTH’S ISSUE

WIRELESS MINI
Upgrading a Mac
mini’s RAM, hard
drive, and optical
drive is a simple
procedure that most people can do at
home. Adding AirPort and Bluetooth,
however, requires parts that only an
authorized Apple representative can
supply—and install.
From “Max Out Your Mac mini,” p54.
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BRAKE BEFORE
TURNING
Tight corners are
great places to
improve your time in
any MTX: Mototrax
race. The trick is to
press the clutch (or let up on the gas)
just before a turn, then punch it about
midway through the turn.
From Reviews, p49.

iMPROVISE
Need a low-budget microphone? Apple’s
in-ear iPod headphones work in a pinch.
From “Put Linux on Your iPod,” p60.

FIND & REPLACE BUG
Be careful when using iWork’s Find &
Replace. It puts your replacement word
wherever your cursor is located before it
seeks out the ﬁrst instance of the word.
From Reviews, p36.

Everything to concept, collaborate and create.
(Well, except the great ideas.)

Apple® Power Mac® G5
•
•
•
•

Dual 2.0GHz PowerPC G5 processors
Memory: 512MB
160GB Serial ATA hard drive
DVD-R/CD-RW SuperDrive
TM

2495
- 30

$

DESKTOP

CDW 653856

TRADE-IN1

2465

$

Adobe® Creative Suite (CS)
Premium Bundle

Kingston 1GB Memory Module for
Apple® Power Mac® G5

• CS Premium combines full-version upgrades
of Adobe’s leading professional tools–Adobe®
Photoshop® CS, Adobe Illustrator® CS, Adobe
InDesign® CS, Adobe GoLive® CS and Adobe
Acrobat® 7.0 Professional
• Create outstanding imagery, stunning graphics
and striking layouts while easily tracking
file versions
• Bundle includes Adobe® Creative Suite Premium
and Total Training Tips and Tricks

• 100% compatibility guaranteed
• Free manufacturer’s lifetime warranty and
technical support
• Legendary reliability and superior quality
• Visit CDW.com/kingston to find your
memory solution

FULL VERSION FOR MAC®

Recommended Service:
AppleCare® 3-year onsite protection plan
$249 (CDW 442761)

The Mac Solutions You Need When You Need Them.
When you’re bringing ideas to life, your technology should work with
you, not against you. CDW has all the top-name technology you need
to improve workflow. Our account managers provide fast answers to
your product questions. And with access to the industry’s largest in-stock
inventories, you’ll get what you need, when you need it. So why wait?
Get new systems today and start creating tomorrow.
Processors eligible for trade-in include PowerPC G3, G4, G5, Intel Pentium II, III, 4 or Intel Celeron; AMD processors do
not qualify; trade-in values are estimates only; actual trade-in values may vary from $25 to $500; all products must be in
good working condition and have a fair market value; call your CDW account manager for details. Offer subject to CDW’s
standard terms and conditions of sale, available at CDW.com. © 2005 CDW Corporation

1

1155

$

CDW 723879

22912

$

CDW 511657

06

CONTENTS

a better machine. a better magazine.

the disc

EDITORIAL
EDITOR IN CHIEF Rik Myslewski
MANAGING EDITOR Sean Molloy
FEATURES EDITOR Jake Widman
HOW-TO EDITOR Niko Coucouvanis
REVIEWS EDITOR Roman Loyola
INTERN Noah Tsutsui
WEB MONKEY Nick Muerdter
EPONYMEDITOR Max
CONTRIBUTING EDITORS David Biedny, Joseph O. Holmes,
Helmut Kobler, Cathy Lu, Steven Parke, Ian Sammis, Deborah
Shadovitz, Andrew Tokuda, Buz Zoller

Become a guitar god with eMedia’s
Rock Guitar Method, record audio
passing through your Mac with
Rogue Amoeba’s Audio Hijack, make
free long-distance Internet phone
calls with Skype—and then dig into
the rest of this month’s collection of
55 killer apps and utilities.

ART
ART DIRECTOR Mark Rosenthal
ASSISTANT ART DIRECTOR Peter Marshutz
PHOTOGRAPHER Mark Madeo
CONTRIBUTING PHOTOGRAPHER Samantha Berg

Skype freeware

Rock Guitar
Method demo

Audio Hijack
shareware

A guitar pro teaches you
all the techniques you’ll
ever need if you want
to play rock, punk, and
metal.

Record the sound
output of any Cocoa or
Carbon app—including
Internet radio—and
save it as a ﬁle.

With Skype, you’ll be
making free Internet
phone calls in no
time—and it’s good for
chatting while playing
online games, as well.

BUSINESS
PUBLISHER Chris Coelho
ASSOCIATE PUBLISHER
Bernie Lanigan, 212-768-2966 x4001
EASTERN ADVERTISING MANAGER
Anthony Danzi, 646-723-5453
EASTERN ADVERTISING DIRECTOR
Dave Lynn, 949-360-4443
WESTERN ADVERTISING MANAGER
Stacey Levy, 925-964-1205
NATIONAL ACCOUNT MANAGER
Nate Hunt, 415-656-8536
SENIOR ACCOUNTS MANAGER, DIRECT SALES
Ana Epstein, 415-656-8416
MARKETING MANAGER Kathleen Reilly
ADVERTISING COORDINATOR Jose Urrutia, 415-656-8313
PRODUCTION
PRODUCTION DIRECTOR Richard Lesovoy
PRODUCTION COORDINATOR Larry Briseno
CIRCULATION
GROUP CIRCULATION DIRECTOR Amy Leder
NEWSSTAND MARKETING MANAGER Bill Shewey
BILLING AND RENEWAL MANAGER Mike Hill
FULFILLMENT MANAGER Peggy Mores
DIRECT MARKETING SPECIALIST Robin Connell
FUTURE NETWORK USA
150 North Hill Drive, Brisbane, CA 94005
www.futurenetworkusa.com

AUDIO & MUSIC

Audio Hijack 2.1.3
shareware
Make Bookmarkable
freeware
MPFreaker 1.0 shareware
Rock Guitar Method demo
WireTap Pro 1.0.1 shareware

DEVELOPMENT

REALbasic OS X 5.5.4
demo
TextWrangler 2.0 freeware

FUN & GAMES

A Farewell to Kings 2.0.4
shareware
Lugaru 1.01 shareware
Midnight Mansion 1.0.1
shareware
MTX: Mototrax 1.0 demo
Pow Pow’s Puzzle Attack
1.0 demo
Solitaire XL 1.1 freeware
wordSword 1.0 shareware

GRAPHICS & MULTIMEDIA
CandyBar 2.0.1 shareware
Forty-Two DVDVX Plus 2.4
shareware
iDive 1.2.5 shareware
iPhoto Diet 3.0.2 freeware
iPhoto Library Manager
2.0 freeware
Photo to Movie 3.1.1
shareware

UPGRADE

Picture Rescue 1.1.0 trial
Shoebox 1.0.2 shareware
Slick Sampler freeware

MailArchive 1.1
shareware
Photon 1.1 freeware
PhotoToTypePad 1.1
freeware
INTERNET &
phpMyAdmin 2.6.1-pl2
COMMUNICATION
freeware
BetterHTMLExport (for
iPhoto 4) 2.0.19 shareware Skype 1.0.0.7 freeware
BetterHTMLExport (for
iPhoto 5) 2.1 shareware
PRODUCTIVITY
Conference Recorder
AquaScribus freeware
1.0.1 shareware
Directors Boards 1.1
Direct Mail 1.4.3 shareware freeware
Directors NoteBook
Feeder 1.0.2 shareware
SA 1.6.1d shareware
FlickrExport 1.2.1 freeware
HTTPMail Plugin (Jaguar) Directors NotePad 1.0h
shareware
1.42 freeware
HTTPMail Plugin (Panther) iClip 3.5.2 shareware
1.42 freeware
iPresent It 1.1.1 shareware
JiWire Portable Hotspot
Presentation Prompter 4.1
Locator 1.0 freeware
shareware
Mail Forward X 2.4
Scribus 1.2.1 freeware
shareware

UTILITIES

BatChmod 1.34 freeware
DiskTracker (Classic) 2.3
shareware
DiskTracker (OS X) 2.3
shareware
DoubleCommand 1.5.3
freeware
Fink 0.7.1 freeware
FinkCommander 0.5.3
freeware
iPhoto Extractor 2.0b6
freeware
iPodLinux Installer 0.3a
freeware
uControl 1.4.6 freeware

SPONSORS

JiWire Portable Hotspot
Locator 1.0 freeware
Photo to Movie 3.1.1
shareware
Picture Rescue 1.1.0 trial

Staff Video:

The New Guy (Redux)
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If you don’t receive the Disc with your copy of MacAddict, you might want to consider upgrading. Each monthly
disc contains cool demos, useful shareware and freeware, and the inimitable MacAddict Staff Video. To get 12
issues of MacAddict that include this value-packed disc with your subscription (prorated if necessary) for just $1
more per issue, call 888-771-6222—the operator will take care of everything.
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EDITORS’ PAGE
a note from the kernel

Doing the Numbers
Marketing types rarely understate a
product’s capabilities. And so it was with
some puzzlement that I read an ad for the
1GB iPod shufﬂe’s random-play feature,
which stated, “240 songs. A million
possibilities.” Now, I’m no math wiz, but
I do know that 240 songs could most
deﬁnitely be played in more than a million
different sequences.
“But how many more?” I wondered. So
I ﬁred up my copy of Wolfram Research’s Mathematica (
Apr/05, p47), entered the appropriate query—and stared goggleeyed at the answer: The number of different orders in which you can
play 240 songs is 4,067,885,363,647,058,120,493,575,921,486,
885,310,172,051,259,182,827,146,069,755,969,081,486,918,925,
585,104,009,100,729,728,348,522,923,820,890,245,870,098,
659,147,156,051,905,732,563,147,381,599,098,459,244,752,463,
027,688,115,705,371,704,628,286,326,621,238,456,543,307,267,
608,612,545,168,337,779,669,138,759,451,760,395,968,217,423,
617,954,330,737,034,164,596,496,963,986,817,722,252,221,059,
768,080,852,489,940,995,605,579,171,999,666,916,004,042,965,
293,896,799,800,598,079,985,264,195,119,506,681,577,622,056,
215,044,851,618,236,292,136,960,000,000,000,000,000,000,
000,000,000,000,000,000,000,000,000,000,000,000,000. We’ll
call that a bit over “a million possibilities.”
Just how big is this number (which, by the way, most sentient
beings round off to the number 4 followed by 468 zeros—sciencetypes write that as 4x10468)? Well, some theorists opine that all
matter will decay after the universe turns 1035 years old, so if you
played your iPod shufﬂe continuously until you went through all the
possible combinations of 240 four-minute songs, you’d have to play
them for 7.4x10430 life cycles of the universe. Better get started.
While in math mode, I decided to delve into a few more Applerelated stats. In early March, the iTunes Music Store sold its 300
millionth song—it’d take you over 2,283 years to listen to them all,
during which time a snail crawling at 0.013 meters per second could
circumnavigate the Earth more than 23 times. The 10 millionth iPod
was sold in mid-December 2004—laid end to end, all those iPods
would reach almost from Atlanta to Philadelphia. Around 55 million
people have visited Apple Stores worldwide—that’s roughly the
population of Spain, Greece, and Denmark combined.
Enjoy,

STAFF RANTS
Q. What’s your favorite statistic?

Niko Coucouvanis BORN 20 MILLION MINUTES AGO
What’s your favorite statistic?

My favorite is actually a meta-statistic: the fact that
marketing greed-weasels can twist numbers and
hard data into pretty much whatever bottom line they
want—such as the relationship between market share by
revenue and by actual number of units sold. And no, I’m not talking
about the iPod. OK, I am.

Mark Rosenthal DR. ANIMALS
What’s your favorite statistic?

Ratio of nuts buried by squirrels but never recovered to
those buried and recovered—80:1.

Sean Molloy MATHEMAGICIAN
What’s your favorite statistic?

It’s a tie between two useless stats I actually heard
TV news reporters use to express shocking hugeness:
either how many postage stamps you can ﬁt on an IMAX
screen, or how long it would take Niagara Falls to ﬁll
the dome of some new sports stadium if you turned that dome
upside down.

Peter Marshutz PETER REPEATER
What’s your favorite statistic?

My favorite statistic is the recently revised average life
expectancy for American males. We now have 77 years
to live—that’s 28,105 days, 674,520 hours, or 40,471,200
minutes.

Jake Widman ONE OUT OF FIVE EDITORS
What’s your favorite statistic?

The utterly useless stats that are offered during
sports broadcasts. “The team’s gone 18-34 with him
in the lineup, 9-17 with him hurt,” or “He bats 0.254
left-handed, 0.263 right.” 93.6 percent of the time,
they tell you nothing.

Roman Loyola BELLY ITCHER
What’s your favorite statistic?

Springtime. Statistics. Naturally, baseball comes to
mind. Hall of Famer Dennis Eckersley’s 1990 season as
a closer was amazing: 48 saves, 73 strikeouts in 73.3
innings, a 0.61 ERA, and he walked only four batters.
Plus, he had one of the greatest mullets of all time—and there’s no
way to quantify that.

Max PARISIANIAC
What’s your favorite statistic?

Over 2,400,000 copies of MacAddict are printed
each year—that’s more than enough copies for each
and every resident of Paris, France; Paris, Arkansas;
Paris, Idaho; Paris, Kentucky; Paris, Michigan; Paris,
Mississippi; Paris, Missouri; Paris, Ohio; Paris, Tennessee; Paris,
Texas; and Paris, Virginia.

comingsoon:june2005
Here’s what our editors are preparing for the next issue of MacAddict.

We’ll teach you how to improve your photographs with iPhoto 5’s new tools—and tell you when it’s time to turn to Adobe
Photoshop and its plethora of plug-ins. We’ll show you how to set up your Mac for your kids’ summer vacation, and
explain all optical-disc formats, including CD-R, DVD+ and DVD–, and archival discs. We’ll plug an IR transmitter into a
Mac to create the ultimate universal remote, soup up our wireless network with homebrew Wi-Fi antennae, and share
our favorite PowerBook travel tips. Finally, we’ll take a look at the Sonos Digital Music System, Adobe Acrobat 7.0,
Aspyr’s Doom 3, and a whole lot more.
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the news of the month in bite-size chunks

iPODS FOR EV E

The World’s Greatest Music Players Form
a United Front Against All Competition.

iPOD MINI
We thought that the original iPod mini
was a bit too pricey for mass acceptance
when it appeared in January 2004 at a
relatively hefty $249. We were wrong.
Style-conscious music lovers snapped
up millions of the petite multicolored
beauties. Now the 4GB iPod mini has
slipped beneath the magic $200 barrier,
and a 6GB bigger brother ($249) has
joined it. Sister, actually, if Apple’s new
iPod mini marketing materials are any
gauge of their targeted buyers—Apple’s
Web site touts the mini’s vastly
improved 18-hour battery life (the
original mini was rated at 8 hours) as

W

hen Apple announced its new iPod lineup in late February,
the company made it clear to its competitors that it had no
intention of relinquishing any segment of its commanding
lead in the digital-music-player biz—and also made it clear to all us
Mac addicts that there’s no reason to even think of buying a player
that’s not an iPod. From $99 to $449, Apple’s got us all covered.

IMAGES COURTESY OF APPLE

iPOD SHUFFLE
There’s not much new to report about
the iPod shufﬂe (
Apr/05,
p39). The wee white 0.78-ounce shufﬂe
still comes in two ﬂavors: the 512MB
base model ($99) and the twice-ascapacious 1GB model ($149)—no price
changes, no changes in features or
functions. The only new ponderable is
why would you not want to plunk down
an extra ﬁfty bucks for a 4GB iPod mini
($199). Unless, of course, you’re a
marathoner who needs the ultimate in
skip protection and for whom each and
every ounce counts. Or, for that matter, if
you’re the owner of a hard drive–based
iPod who wants a second ’Pod for when
10
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you’re out and about—or, if you happen
to live in Saskatchewan, for when you’re
oot and aboot.

What’s Another
Fifty Bucks?

It now costs $50 per notch to
climb Apple’s iPod ladder from the
120-song 512MB iPod shufﬂe to
the 15,000-song 60GB iPod photo.
Well, sure, the last step up is a
hundred bucks, but you get the
picture—there’s now an iPod for
every economic strata.

Price
$99
+$50
$149

Model

Capacity

Songs

Battery Life

iPod shufﬂe

512MB

120

12 hours

iPod shufﬂe

1GB

240

12 hours

4GB

1,000

18 hours

6GB

1,500

18 hours

20GB

5,000

12 hours

30GB

7,500

15 hours

60GB

15,000

15 hours

+$50
$199 iPod mini
+$50
$249 iPod mini
+$50
$299 iPod
+$50
$349 iPod photo
+$100
$449 iPod photo
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iPOD CLASSIC
No, that’s not what Apple calls it; that’s
just what we call it here in the MacAddict
Intergalactic Nerve Center. The nosurname iPod now comes in only one
lonely model: a 20GB version for $299.
Although both USB 2.0 and FireWire
cables are included, you have to pay $39
extra for a Dock.
It’s not strictly correct to call the 20GB
iPod the only classic ’Pod still available.
As of press time, Apple was still offering
the $349 iPod U2 Special Edition; the
extra ﬁfty bucks buys you a sleek black
case, red clickwheel, and $50 off The
Complete U2 digital box set of 400 U2
tunes—UTunes?—available from the
iTunes Music Store for $149. Personally,
we’re waiting for the iPod 50 Cent Special
Edition with faux bullet holes on its case.

iPOD PHOTO

When we reviewed the iPod photo
(
Jan/05, p34), we had two
major beefs: Its two-inch screen was too
small for effective image viewing, and
there was no way to download photos
to it directly from a digital camera—you
had to put your photos into iPhoto and
then politely ask iTunes to convert
them and transfer them to your ’Pod.
Well, the kind folks at Apple have
answered one of our complaints with a
new iPod Camera Connector (more on
that in a bit), but they’ve kept the iPod
photo’s squintalicious two-inch color
LCD—which, it must be admitted, is a
vast improvement over the classic ’Pod’s
monochrome display. As if by way of
apology, Apple has lowered the price of
the 60GB model a full 25 percent, from
$599 to $449. We accept the apology.
The 40GB iPod photo ($499) has been
sent packing; its replacement is a slim
(0.63-inch) 30GB model that comes in at
a cool $349. The bad news? If you want
to equip either model with a Dock, the
iPod photo Dock Kit will cost you another
$39. Want to connect either to a TV?
You’ll need the optional $19 iPod photo
AV Cable. Both were included with the
original iPod photo, making the price
drop a bit less impressive.
But, as we said, we’re in a forgiving
mood—and the reason is the iPod
Camera Connector we mentioned
before. Set to ship by the time you read
this, the $29 Camera Connector lets you
connect your iPod photo to your digital
camera and download photos directly
from your camera into your ’Pod.
You’ll then be able to view the photos
individually or in a slide show, and
then upload the originals into iPhoto
when you’re back at your Mac. OK, so
the iPod photo should have had this
capability from the beginning, and we’d
prefer it to be built into the ’Pod and not
a $29 option, but it’s still a welcome
addition to the ﬂagship of Apple’s moreaffordable iPod line.—Rik Myslewski

Canon EOS Digital
Rebel XT
$999 (with lens),
$899 (body only)
www.canon.com
Available: Now

Its cause? Fast,
ﬁne-lookin’ pics.

Nikon’s latest digital SLR camera doesn’t
replace the EOS Digital Rebel (
Mar/04, p48)—it ﬁlls the quality slot
above it. The Rebel XT is smaller, lighter,
and faster than its predecessor, and it
features an 8-megapixel CMOS sensor
and Canon’s speedy DIGIC II image-signal
processor. Oakland Raiders fans rejoice:
You can choose between either a silver or
black body.

IMAGE COURTESY OF CANON

being sufﬁcient for “a transatlantic ﬂight,
the limo ride to your hotel, and a few solid
hours of boutique shopping,” coos that
it “goes with everything: Macs,
PCs, sequins, and tees,” and
refers to its aluminum matteﬁnish case as sturdy enough to
survive “the jostle of overzealous
paparazzi.”
The mini now comes in four
colors: silver, and punched-up
versions of the original pink,
blue, and green—if you own an
original gold mini, you now have
a collector’s item. In another nod
to fashion, the clickwheel icons
now match the case color—
gray is so passé. Stylin’ new
armbands are available in gray,
orange, yellow, blue, and pink—but unless
your taste runs to the aforementioned
passé gray, you’ll need to purchase your
armband at Apple’s online store. A new
mini lanyard is also available for $19.
Not all the news is good, however.
Although both minis ship with—and sync
and charge over—a USB 2.0 cable, a
FireWire cable is now a $19 option; so is a
$39 iPod mini Dock.

4 REBEL SWELL

4 SMART STORAGE
CONTROL

ProSoft Drive Genius
$99
www.prosofteng.com
Available: Now

An organized utility for

Your hard drive needs your disk in disarray.
some tender lovin’
care, and Drive Genius just might be the
proper caretaker. This set of hard drive
utilities includes an optimizer, a disk
tester and analyzer, a volume rebuilder,
benchmark tools, and more—and they’re
all accessible through a friendly interface.
Drive Genius can also securely wipe
out data using standards set by the
Department of Defense.

4 WATCH OUT, WACOM
Adesso CyberTablet
12000
$169
www.adesso.com
Available: Now

This 12-by-9-inch
We haven’t seen
tablet comes with a
the previous 11,999
mouse and pressure- versions.
sensitive pen—both
wireless—for use with image editing and
illustration apps. The pen has two buttons
and 512 gradations of pressure sensitivity,
and the two-button mouse can be used by
lefties or righties.
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DROOLWORTHY
Sexy Stuff We Can’t Wait to Get Our Mitts On

Ball and
RefrainB

IMAGE COURTESY OF BLUE MICROPHONES

Blue Microphones’ Snowball
($139, www.bluemic.com) is a USB
microphone designed for professional
recording. It has three recording capsules:
one for vocals, one for instruments, and a
third for combined vocal and instrument
recordings. Snowball can be used with any
recording app, including GarageBand and
Logic Pro.
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Who’s afraid of
the punk-ass
wolf? Not this
bunny.

PAWS OF FURY

ON THE

DISC

4In Lugaru, Turner the ninja rabbit is on a quest to
avenge his family. To save his kind from slavery, he
uses his paws, knives, swords, staffs, and stealth
to defeat corrupt fellow rabbits and their allies, the
wolves. This unique 3D ﬁghting game relies less on
button combos and more on countering your
enemies’ attacks.—Matt Osborn

Lugaru 1.01

Lugaru
Price Free (demo),
$19.95 (full version)
Available Now
Wolfire Software
www.wolfire.com/lugaru.html

HALO IN UT2004? SIGN US UP!

MEN OF VALOR DOA

4Aspyr Media announced that they
have cancelled the Vietnam-era
ﬁrst-person shooter, Men of Valor.
According to a company statement,
“The decision to remove the title
from Aspyr’s calendar was a result
of several different factors and much
deliberation.” One of the factors may
have been the increase in cost for the
online-multiplayer management system
hosted by GameSpy, reported here in
Game News (Mar/05, p13).—MO
Men of Valor
Price It’s dead, Jim!
Available Never!
Aspyr Media
www.aspyr.com

FREE FRAGGIN’ IS GOOD FRAGGIN’

4Have Unreal Tournament 2004 and can’t get enough Halo?

4Nexuiz is a free 3D deathmatch game

Project Torland has released a full-scale total-conversion mod
aimed at cramming as much content from the original Halo
as possible into the UT2004 engine. Play as the Covenant or
the Flood while driving Warthogs and Ghosts, each with new
conﬁgurations.—MO

based on Darkplaces, an
advanced Quake 1 engine.
The game features curved
surfaces, bump mapping,
real-time shadows,
and 64-player support
with over 30 characters
to choose from. The
development team’s goal is
to bring deathmatch back
to the basics, which
they see as wellbalanced weapons
and fast-paced
action.—MO

Flood, thy
name is me!

Project Torland
Price Free

Nexuiz
Price Free

Available Now
Project Torland
http://torlan.forerunners.org

Available When it’s ready
Nexuiz
www.nexuiz.com

Pretty good
looking for a free,
basic game, eh?

TIPS & TRICKS: COMMAND & CONQUER: GENERALS ZERO HOUR
The Command & Conquer: Generals (
Jul/04, p58) expansion pack, Zero Hour, has you ﬁghting the world’s most elite
commanders for battleﬁeld domination. Here are a couple of tips to keep you from getting owned.—MO
BEWARE THE TUNNEL RUSH A Tunnel Rush is when a player
builds tunnels right away for an early sneak attack. You won’t
be able to see an enemy’s tunnel until they are coming out of
your ﬂoorboards. Be especially careful when playing against
Prince Kassad—he has this ability instantly. Dragon Tanks and
Scout Drones are effective counters, but building your own
tunnels works, too.

PICK A POTENT GENERAL Team up with Tsing Shi Tao, The
China Nuke General, and Anvil Fai, The China Infantry General—
they make highly effective use of the resources available to
them. Alexis Alexandra, The USA Super Weapon General, and
Dr. Thrax, The GLA Toxin General, have weak defenses and the
worst offenses.
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S

ometimes Mac OS X’s Software Update doesn’t display the appropriate
updates, or it fails to properly apply updates that have been successfully
downloaded (in the latter scenario, you may get a permissions error referring to
the /tmp/501/TemporaryItems/com.apple.SoftwareUpdate directory). Here are
a few things you can try if you encounter one of these problems.
REPAIR PERMISSIONS Try using Apple’s Disk Utility (located in /Applications/
Utilities) to repair permissions. This often works all by itself.
DON’T MOVE APPS If you moved an Apple app from its original location inside
the Applications folder, Software Update may not be able to locate it. Leave
Apple-installed applications where they are originally installed.
DELETE RECEIPTS In some cases, the issue can be resolved by deleting one
or more ﬁles in the Library folder. Try deleting the receipts that correspond to
the application or Mac OS X version you are attempting to update (ﬁles such as
iPhotoUpdate403.pkg or MacOSXUpdate10.3.8.pkg). The receipts are located
in /Library/Receipts and appear with a .pkg extension.
SWING THE BAT TOOL Use BatChmod (on the Disc, or download from http://
macchampion.com/arbysoft) to modify permissions for the /tmp/501 directory:
In the Finder, press Command-F. In the ﬁrst search ﬁeld, type 501 (or
whatever number is identiﬁed in the message). Press the plus sign to add a
second search criterion, and then select Visibility in the ﬁrst menu and Visible
And Invisible Items in the second menu. Click Search.
2 In the Search Results window, click and drag the 501 folder
ON THE
onto the BatChmod icon. In BatChmod, select Apply Ownership
DISC
And Privileges, and click Apply.
BatChmod
1.34
TRY AGAIN Wait a few minutes. Sometimes this just works.

14
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ibson unveiled
the Gibson
Digital Guitar (www
.gibsondigital.com), a
Les Paul–style guitar
that can pick up string
motion, send it to a
digital converter, and
then transmit the
signal from the guitar
to a breakout box via
Ethernet. Brian Moore
Guitars announced
the iGuitar.USB (www
.brianmooreguitars
.com), a guitar that
connects to your
Mac via USB to
directly interface with
GarageBand, Logic
Pro, or Pro Tools.
(Could a digital

Put your personal
touch on your tunes—
literally.

air guitar be
next?) Fender’s GDEC ($359.99, www.fender
.com) is a practice amp for guitarists;
it has a MIDI synthesizer, 17 amp types,
29 effects, and 10 reverbs.
Haken Audio’s Continuum
Fingerboard (pictured; $5,290 full size,
$3,390 half size, www.hakenaudio
.com) is a FireWire MIDI controller with
a keyboard-like playing surface that
allows you to use ﬁnger movements to
dynamically control the sound. Think of
The Musicpole (www.themusicpole
.com) as a keyboard wrapped around
a pole. You play this MIDI controller by
stroking and spinning the pole in your
hands (get your mind out of the gutter!)
while wearing special thumb pads.
Steinberg unveiled Virtual Bassist
($249.99, www.steinberg.de). It has a
collection of samples from 25 different
music styles and features GrooveMatch,
which syncs the bass line to an existing
drum line. Steinberg also has Groove
Agent 2 ($249.99), with 27 new drum
styles and nine new drum kits. East
West/Quantum Leap’s Symphonic
Orchestra ($995, www.soundsonline
.com) is a 24-bit choir-sample library
with a utility that lets you type words you
want the choir to sing.—Michelle Victoria

IMAGE COURTESY OF HAKEN AUDIO

SICKLY SOFTWARE UPDATE

What’sNew

BUG OF THE MONTH

MUSICAL INSTRUMENTS

apster (www.napster.com) is taking on Apple’s iTunes
Music Store and iPod by offering a $14.95 subscriptionbased online music service. Napster claims it’s a better
value, which can be true—as long as you don’t want to use an
iPods make this
iPod or Mac and don’t want to actually own anything. Here’s
kitty scowl.
the lowdown.
iPod ignored. Before we get to Napster’s pricing, know this:
You can’t use the iPod, iPod mini, or iPod shufﬂe with Napster. Here’s something else:
Napster isn’t Mac compatible. If this instantly eliminates Napster as a choice for you,
skip the rest of this article. Or keep reading—you might need rhetorical fodder for the
next time you’re at a gathering and some blowhole spouts off about subscriptionbased services versus the iTunes Music Store.
Forever linked. Napster’s subscription service lets you download an unlimited
number of songs, which is a good way to try an album with little consequence. But every
month, Napster reauthorizes your music, and if you cancel your service, your music
won’t play. If you don’t care about owning your music, then this might be no big whoop.
CD conundrum. No iPod or Mac support? How about burning Napster songs to a
CD, then importing them into iTunes on your Mac? It’s possible, but you have to pay
an extra fee on top of the $14.95 per month—the subscription service is for playing
music on your MP3 player or PC only. The fee (which happens to be 99 cents per song,
but discounts are available) gives you a version of the song that you can burn onto a
CD. That’s one advantage: You can try before you buy, and then buy only the songs
you want.—Roman Loyola

>>>>>>>>

NAPSTER TAKES
ON iTUNES
N
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SHAREWARE PICK OF THE MONTH
iClip

Y

DISC

http://inventive.us $19.95

iClip 3.5.2

our Command, C, and V keys are probably worn to the nubbins from years of copying and pasting. iClip minimizes the repetitive
nature of this practice by letting you store clippings. It even remembers your most recent clippings.—Andrew Tokuda

3 Name your Clipping Set.

2 For more permanent storage of common
clippings, create a new Clipping Set by
selecting New Clipping Set from iClip’s
Edit menu.

5 Need a faster way to
copy and store data?
Select your data in
whatever application
you’re in, then click the
copy icon (the arrow that
points to your bin).

iPOD CASE OF THE MONTH

PHOTOGRAPH BY MARK MADEO

Y

ou might call it a Muppet pelt or a punk-rock Tribble (we did
both), but you’ll certainly call HotRomz’ Tactile iPod Cases
($16.95 for iPod mini, $19.95 for iPod; www.hotromz.com)
unique. These handmade fur-balls are colorful, fuzzy, and ﬂashy
cases similar to Apple’s own iPod Socks. In Gilligan’s Island–
speak, the Tactile iPod is Ginger, and the iPod Sock is Mary Ann.
Pictured here is the Pink Devil, a celebratory coterie of pink
shag and rainbow-hued fuzzy bits. Other Tactile cases include
the Little Green Monster, a hairy
green case; the Hedonist, made
of blue mohair and metallic silver
thread; and Birds of a Feather,
graced with red, white, and pink
faux feathers. All of the Tactile
cases are hand washable and can
be air dried.
If sock-like cases aren’t your
thing, HotRomz also makes iPod
Tattoos ($3.99) that overlay your
iPod.—Michelle Victoria
SUBMIT YOUR CASE Whether your iPod case is a custom-made oneoff or a mass-produced product, you can submit it for Case-of-the-Month
consideration—just send it to iPod Case of the Month, MacAddict, 150
North Hill Dr., Ste. 40, Brisbane, CA 94005. Please note that we cannot
return cases.

4 Store common text, such as
email signatures, by clicking on
an empty bin, then typing away.

To paste the
clipping data into
an application like
TextEdit, click on the
paste icon (the arrow
that points away from
your bin).

BookReviews

>>>>>>>>>>>>>>>>>>>

APPLESCRIPT: A Comprehensive Guide to Scripting
and Automation on Mac OS X
APPLESCRIPT: The Missing Manual

W

hen it comes to AppleScript, it’s helpful to have a couple
of reference books handy. That’s why we like both
AppleScript: The Missing Manual ($24.95, www.oreilly
.com) and AppleScript: A Comprehensive Guide to Scripting and
Automation on Mac OS X ($59.99, www.friendsofed.com).
AppleScript: The Missing Manual was written by teenager
Adam Goldstein, who also worked on Mac OS X: The Missing
Manual and Mac OS X Power Hound. Goldstein’s new book is
a great way to introduce yourself to AppleScript, and it also
serves as a good quick reference.
But if you want to be an AppleScript power coder, you’ll
need to dive deep into the technicalities. That’s where Hanaan
Rosenthal’s Comprehensive Guide comes in. Useful to both
beginners and experts, this 900-page paean to AppleScript
includes tons of sample scripts.—Roman Loyola
May 2005
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Each time you copy data, it’s stored
automatically in iClip’s Clipboard
Recorder.
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Apple’s ﬁve iApps make
great companions for your digital
lifestyle—but like all roommates, they
can sometimes get on your nerves.
Our experts show you how to deal with
some of their quirks.

ON THE

DISC

Find most of the
software mentioned in
this article on the Disc.
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iTunes iMovie HD
iPhoto5 iDVD 5 GarageBand 2

When have Mac addicts ever enjoyed such great ways to combine
fun and practicality? From editing movies to making music without
having to play a note, the iLife creativity suite helps you do things you
didn’t know you could—and enjoy yourself while doing them. ¶But
let’s face it, as great as these apps are, they don’t always work like they’re
supposed to. And even when they do, they can’t do everything you want
them to. Frustrating, ain’t it? ¶We’ve gathered a group of iLife experts to
answer some of your most common “How can I ﬁx…?” and “Why can’t
I do…?” questions. In addition, they share their favorite tips and tell
you the ﬁrst steps you should take to resuscitate an apparently sick
or dying app. Read on—your iLife’s about to get a lot better.
by Shelly Brisbin, Brad Miser, Andrew Tokuda,
and Johnathon Williams
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I use the Export To HTML feature to post image
galleries to my Web site, but its output options are
limited. Is there a way to adjust the appearance and
layout of photo pages short of editing the ﬁnished HTML?

Another problem, another plug-in. BetterHTMLExport (on
the Disc, or download from www.droolingcat.com/software/
betterhtmlexport) offers the same basic functionality as
iPhoto’s built-in Web-page export, but it throws in a truckload
of additional controls and options. Post full-size images, ﬁnetune your HTML code, create and save your own custom page
templates—the list goes on. Once installed, BetterHTMLExport
appears as a tab labeled Better Web Page in the Export dialog.
BetterHTMLExport is
shareware (registration
costs $20), and versions
for both iPhoto 4 and 5
are available.
With BetterHTMLExport,
you can expand iPhoto’s
Web-page-design
options.
I don’t have a .Mac account, but I still want to post
my pictures online. Can I use any other photo-sharing
services with iPhoto?

You sure can. Several plug-ins extend iPhoto’s export
ability for exactly this purpose. Our favorite is FlickrExport (on
the Disc, or download from www.speirs.org/ﬂickrexport), a
freeware utility that uploads selected photos directly to your
Flickr account. It’s compatible with both iPhoto 4 and iPhoto 5.
Once installed, FlickrExport appears as an additional tab
in iPhoto’s Export dialog (Share > Export). You can resize, set
titles, and assign Flickr content tags before uploading. There are
other free plug-ins that serve the same purpose:
PhotoToTypePad (on the Disc, or download from www
.daikini.com/products/photototypepad) lets you upload
ﬁnished photo galleries to your TypePad account.
Photon (on the Disc, or download from www.daikini.com/
photon) lets you export photos directly to your Movable Type,
TypePad, Blojsom, or WordPress blog.
iPhotoToGallery (http://zwily.com/iphoto) lets you upload
photos to any Gallery-powered photo page.

•
•
•

I tried to improve one of my photos but ended up
ruining it. Is there some way I can start over?

When you modify a photo, iPhoto automatically archives
the original in a separate folder called—creatively enough—
Originals. In both iPhoto 4 and 5, you can get the original back
by highlighting the photo and choosing Photos > Revert To
Original.
We like the insurance, but some iPhoto users complain about
the extra ﬁles on their hard drives. To get rid of them, use iPhoto
Diet (on the Disc, or download from http://pages.cpsc.ucalgary
.ca/~fuhrer/personal/freestuff/iphotodiet), which scans your
library and deletes originals and other duplicates.
But be warned: Once your
Originals are gone, they’re
gone forever—unless they’re
still in your camera or on a
backup CD. (iPhoto 5 users
should see “Johnathon’s
Top iPhoto Tip,” p19, for
additional information
about RAW support.)
iPhoto Diet removes
duplicate images from your
hard disk—permanently.
My pictures look fuzzy in iPhoto, but they’re nice and
sharp in other applications such as Photoshop Elements.
Why is this?

FlickrExport is one of several iPhoto plug-ins that
let you use photo-sharing services other than .Mac.
18
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Your pictures look slightly blurry because of the way iPhoto
renders them. (/Applications/Preview does the same thing.)
To see a photo in its full, sharpened glory, open it in iPhoto’s
Edit pane and click any one of the adjustment sliders. You don’t
need to move the slider—just clicking it is enough.

My iPhoto library is bursting at the seams. Is there a
way to move it to a different disk?

The process of moving your library isn’t intuitive, but it is
easy. Quit iPhoto and drag your library folder to its new location.
Then relaunch iPhoto; the app will ask you to either ﬁnd your
missing library or create a new one. Click Find Library, select the
folder’s new location, and you’re done.
I want to upgrade from iPhoto 4 to 5, but I’m worried
about the safety of my humongous photo collection. What
should I know before I take the plunge?

Any upgrade is always a risk—but things get a bit more
worrisome when your entire precious photo collection is at
stake. For a worry-free upgrade, ﬁrst make a complete backup
of your photo library. Then rebuild your library by holding down
Option-Shift as iPhoto launches.
When that’s complete, install iPhoto 5, but don’t launch it.
First, run Software Update and install the iPhoto update from
Apple. (If you don’t see an update, then your iLife disc must
have included the latest version.) When the update is installed,
you’re ready to go.
There’s no going
back when you
upgrade your
iPhoto Library,
so be sure to
back it up ﬁrst.
My wife and I each have extensive photo collections
on separate Macs, but now we’d like to keep all of our
pictures on a single machine. Is there a way to easily and
safely consolidate our collections?

The fastest and most reliable way is to open iPhoto on the
Mac you want to move your pictures from and export your entire
library as full-size originals to an external hard drive. Then plug
the drive into the Mac where the consolidated collection will
live and use iPhoto to import all of the photos. You will lose
the album and roll information, but all of your pictures will be
preserved.
If you don’t have an external hard drive, you can use the same
technique to transfer photos between two FireWire-capable
Macs. Export the ﬁrst Mac’s photos to a folder on its desktop,
connect the two machines with a FireWire cable, and reboot

Johnathon’s

Top iPhoto Tip
Back up your photos. Yeah, we know, you were expecting
something more profound, but this is the most practical advice
we can give. Most of the time, iPhoto works so well that you
forget how fragile your photo data is. In the meantime, your
priceless photo collection is growing by the gigabyte.
Backing up is always a bit of a hassle, but it’s far better than
the alternative. Trust us, you don’t want to have to explain
to your spouse where your kid’s baby pictures went.

the ﬁrst Mac while holding the T key—that will make it start up
in FireWire Target Disk Mode, effectively transforming it into an
external hard drive as far as the other Mac is concerned.
A more time-consuming method, but one which would
preserve your album and roll info, is to burn all of the ﬁrst Mac’s
albums onto a CD-R/W or DVD-R from within iPhoto. Then, insert
the disc into your target Mac, go to iPhoto, and drag each album
from the CD to your library. If you use this method, be sure both
Macs are running the same version of iPhoto.
Apple’s making a big deal about iPhoto’s new RAW
support. What’s it good for?

iPhoto 5’s RAW support is nice for storing, organizing, and
previewing RAW images, but it’s pretty useless for editing them.
The problem is that when you add a RAW image to your library,
iPhoto immediately generates a JPEG for you to work with and
places the RAW image in the Originals folder. This keeps iPhoto
nice and snappy (RAW images are processor hogs), and it makes
these images available in a format that’s easy to share, but it
defeats the entire purpose of RAW, which is to preserve all of the
image data recorded by your camera.
To edit a RAW image in its native format, export it to your
hard drive using the Original setting. (Opening a RAW image in
an external editor from within iPhoto will only open the JPEG.)
Then you can use your favorite RAW-ready editor (Photoshop or
Photoshop Elements, for example) to take care of business.
If you’re planning on using iPhoto Diet to delete Originals,
remember that this will delete all of your RAW images, leaving
only the JPEGs that were generated on import. Be careful.
—Johnathon Williams

iPhoto CPR iPhoto crashing on launch? Running too slow? Try these steps to get it back in the pink:
RESTART YOUR MAC Sometimes this is all it takes.
REBUILD YOUR LIBRARY The most common source of trouble is an error in iPhoto’s data ﬁles. Hold down Option-Shift
while launching iPhoto, click Yes when asked if you want to rebuild your library, and iPhoto will copy your data into a new
library, removing errors in the process. Note: If you have a lot of photos, this process can take an hour or more. If iPhoto isn’t
its old reliable, snappy self when you’re done, repeat the process—it may take a few passes to correct some errors.
BUILD A NEW LIBRARY If the rebuild fails, then it’s time to start over. First, get iPhoto Extractor (on the Disc, or download
from http://homepage.mac.com/butlers/iPhotoExtractor). This neat little bit of freeware will separate your photos from the junk
in iPhoto’s library structure and put them in a Pictures folder. When Extractor is ﬁnished, move your iPhoto Library folder out of
Pictures > iPhoto, launch iPhoto, and click Create Library to make a new, undamaged library. Finally, import the Pictures folder
into your new library. You’ll lose your album and roll information, but you’ll have your photos—and a better-behaved iPhoto.
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I recently sold an old Mac that had one of the ﬁve
authorizations for the songs I’ve bought from the iTunes
Music Store. How do I get more authorizations for the
new Mac I plan to buy?

The only way to deauthorize a Mac you no longer own is to
contact Apple Support, using the form at www.apple.com/
support/itunes/authorization.html. Apple promises you’ll have
an answer within 72 hours.
I’ve been collecting music for a while now, and I
bought an external hard disk to hold it all. What’s the
best way to move my library?

Whether you want to move your library to an external drive
or to a new Mac, take the time to do it right. First, create a
folder for your music at the new location. Connect the external
hard drive (or new Mac) to your current system via FireWire,
then go to iTunes > Preferences. In the Advanced pane, click
Change and locate the folder you just created. Click the Copy
Files To iTunes Music Folder When Adding To Library check
box, then click OK. When you close Preferences, the library
information will update. Finally, choose Consolidate Library
from the Advanced menu
to copy your music ﬁles.
Making a new music folder
and designating it as your
ofﬁcial iTunes Music folder
is the ﬁrst step in properly
moving your iTunes library.
My hard drive recently crashed and took a lot of my
not-backed-up iTunes Music Store songs with it. Is there
any way I can get them back without having to buy them
all over again?

iTunes CPR
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Apple doesn’t offer a way to retrieve purchased music—but
you may be able to, just the same. First, be sure your hard drive
is really and truly dead; a disk-recovery app such as Micromat’s
TechTool Pro 4 ($97.97, www.micromat.com), ProSoft’s Data
Rescue ($89, www.prosofteng.com), or Alsoft’s DiskWarrior
($79.95, www.alsoft.com) may resuscitate it—and all three
together will probably cost less than your lost music. A repair
service like DriveSavers (www.drivesavers.com) may also be
able to recover your precious tunes. Such services are expensive,
though—it might be cheaper to just buy the music again.
If your lost songs are still on an iPod, download a shareware
app such as iPod Access ($10, www.ipodaccess.com), and copy
ﬁles from the ’Pod to your Mac. In iPod Access, search by kind
for Protected AAC Audio Files, or just copy everything.

Shelly’s

Top iTunes Tip
To easily back up music purchased from the iTunes Music
Store, create a smart playlist that looks for ﬁles of the
Protected AAC Audio File kind. Burn that playlist to a data
CD or DVD. To incrementally back up items as you add to
the iTunes library (including purchased music), create a
smart playlist that ﬁnds ﬁles added in the past x days.

I have audio books, recorded class notes, and
podcasts in MP3 and standard AAC formats that I want
to convert to bookmarkable AAC ﬁles so I can save my
place. Is that possible?

Sure. First, you need to convert the MP3s to standard AAC.
Do this by opening each ﬁle in iTunes and choosing AAC from
Import Preferences. Control-click the ﬁle you want to convert
and choose Convert To AAC. Now you have a standard AAC ﬁle
with the .m4a extension. To make the ﬁle bookmarkable, you
need to change that extension to .m4b. The easiest way to do
that is with Make Bookmarkable (on the Disc, or download from
www.malcolmadams.com/itunes), a free AppleScript from the
excellent Doug’s AppleScripts for iTunes collection. Install the
script as directed, then reopen iTunes and select the ﬁle you
want to bookmark. From the new Script menu, choose Make
Bookmarkable.—Shelly Brisbin

Problems you encounter when starting up iTunes usually
have to do with library ﬁles, those all-important repositories of
info about your music and playlists. Try these steps ﬁrst:

/Music/iTunes folder. Drag the iTunes 4 Music Library ﬁle to
the desktop. Reopen iTunes, which will now show an empty
library. Choose File > Import, navigate to /Music/iTunes, and
import the iTunes Music Library.xml ﬁle. Your library—minus
any song ﬁles iTunes couldn’t match with listings—will open.

UNLOCK YOUR LIBRARY FILE One day, you may come
face-to-face with an error message saying that your iTunes
library is locked or that you don’t have write permissions
for the ﬁle. To ﬁx the problem, quit iTunes and open your

AVOID FREEZES If you have a power-sucking iSight
camera connected to your Mac, connecting or syncing an
iPod via FireWire may freeze your Mac. To avoid the problem,
simply disconnect the iSight before you connect your iPod.
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iMovie HD
I recently shot a home movie indoors, and some of the
scenes are really dark. The Brightness effect in iMovie
HD didn’t help much—is there anything else I can do in
iMovie HD to improve the brightness?

First, be sure your monitor is calibrated correctly using
the Calibrate command in System Preferences > Display. This
will give you a better sense of how dark the footage really is.
Next, try a third-party plug-in. GeeThree’s Slick Transitions and
Effects Volume 6 ($70, www.geethree.com, or check out the
Slick Sampler on the Disc) includes a color correction effect, as
does Jerry Lawrence’s Effects Pack 1 (www.cis.rit.edu/~jerry/
Software/iMovie). Install these and experiment. Finally, view
your movie on a TV monitor before ﬁnalizing your project—
iMovie playback isn’t always a reliable indicator of ﬁnal results.
I have MPEG video ﬁles that were created on a
Windows machine, and I can’t get them to open in iMovie
HD, even though the application supports MPEG. Is there
a way to import Windows video into iMovie HD?

iMovie HD can import MPEG-4 movie ﬁles, the kind that many
still cameras create. It does not directly support other MPEG
ﬂavors, however, including MPEG-1, MPEG-2, or MPEG transport
streams. You’ll need to convert them with MPEG Streamclip
(free, www.alfanet.it/squared5/mpegstreamclip.html) and
the QuickTime 6 MPEG-2 Playback Component (included with
Final Cut HD and DVD Studio Pro, or $20 from Apple) in order
to use them in iMovie. Open your ﬁle in MPEG Streamclip and
then export it as a DV ﬁle. If the ﬁle is longer than 9 minutes,
28 seconds, the movie will
be divided into smaller ﬁles.
When this (lengthy) process is
complete, you can drag the DV
ﬁles into iMovie as clips.
Use MPEG Streamclip to open an
MPEG that iMovie HD can’t read
and export it as one iMovie can.
I’d like to use Magic iMovie to save some time. How do
I get the most beneﬁt from it?

Magic iMovie automates the movie-making process by
turning your footage into an iMovie project as you import it.

Shelly’s

Top iMovie HD Tip

TRASH PREFERENCES Quit iMovie and delete
iMovie preferences ﬁles from /user name/Library/
Preferences. If you’ve used previous versions, you’ll ﬁnd
ﬁles like com.apple.imovie.plist. Trash ’em and relaunch.
RESOLVE CONFLICTS OS X’s FileVault has been
known to give iMovie ﬁts. Try turning it off in the Security
pane in System Preferences. Alternatively, you could
store your iMovie ﬁles outside your home directory—the
home directory is where FileVault does its thing.
FIX OR REMOVE PLUG-INS Try disabling the
third-party plug-ins stored in /user name/Library/iMovie/
Plug-Ins. Remove that folder and launch iMovie. If all is
well, add your plug-ins back one at a time to isolate the
problem. You can also disable or remove Apple plug-ins
and iMovie support ﬁles. Select the iMovieHD application
and press Command-I. Click the Plug-Ins disclosure
triangle and uncheck one or more plug-ins.

It provides a title clip, makes separate video clips and scene
transitions, and moves clips to the timeline. You can then edit
the results in iMovie HD, unless you choose to have your Magic
iMovie imported straight into iDVD. In that case, there’s no
opportunity to tweak the project, making the advice that follows
even more important.
Because Magic iMovie imports all of your footage in the
order it was taken, the most painless Magic iMovies are those
without a lot of boring ﬁller, badly shot material, or too many
abrupt transitions. That makes Magic iMovie ideal for events
that proceed in a set order and don’t require much camera
movement or editing, such as a school play or sporting event.
To get the most out of Magic iMovie’s automated operation,
plan your production very carefully—putting together a shot list
will help. You can pause the recording while nothing is going on
to avoid extraneous footage, but be aware that Magic iMovie
will automatically create transitions at those breaks.
—Shelly Brisbin
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Unlike previous versions, iMovie HD uses non-destructive
editing: When you trim or split a clip, the cut footage is
hidden but not deleted. If you copy the clip into a new
project, all of the unwanted footage comes along with it.
So don’t use copy and paste—instead, select the
edited clip and choose Share from the File menu. In
the QuickTime tab, click the Share Selected Clips Only
checkbox and choose Full Quality. Now you can save the
clip as a ﬁle and bring it into another iMovie project, take
it to iDVD, or archive it on tape.

iMovie HD CPR
Repairing permissions with Disk Utility (/Applications/
Utilities) can solve many iMovie problems. Here are
a few iMovie-speciﬁc tweaks that can help as well:
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My Mac doesn’t have a SuperDrive. Can I use iDVD with
a non-Apple DVD drive, such as an external DVD drive?

As of version 5, iDVD is no longer tied to the SuperDrive—
you can run the app on any Mac that meets iDVD’s system
requirements and burn DVDs using a third-party drive. You will,
however, have to perform a custom install if you don’t have a
SuperDrive (the standard iLife installation looks for one). When
you launch the program, you’ll see a warning that you won’t be
able to burn a disc. Ignore the warning and create your project.
When you’re done, save it normally, and then choose File >
Save As Disc Image. You’ll get a disc image ﬁle with the .img
extension; now you can use other applications that support
third-party DVD burners to burn a DVD with that ﬁle. You can also
use Mac OS X’s Disk Utility to burn the disc image to DVD.
Apple’s themes are nice enough, but I don’t want my
movies to look like everyone else’s. Can I create custom
themes and reuse them in other projects?

You can create a custom theme by modifying an existing one.
Choose Project > Show Customize Panel, and pick a theme. Go
to the Settings pane and drag in a new background image, add
your own music, change text properties, and so on. Click Save
As Favorite, name your theme, and check
Shared For All Users if you want everyone
who uses your Mac to be able to use your
theme. Uncheck Replace Existing if you
want to keep the original theme. To use your
new themes, open the Theme pane and
choose Favorites from the pop-up menu.
You can customize an existing theme and
save it so your project will express your
unique personality.
When I burn a DVD, the soundtrack becomes
unsynced from the video. What can I do?

First, make sure your video camera captures 16-bit sound;
12-bit sound can cause the problem. Second, use Software
Update to be sure you have the latest versions of the iLife
applications and QuickTime. Third, make sure the hard disk
on which the iDVD project is stored has plenty of free space
(at least 5GB, preferably more). Fourth, quit all applications
except iDVD while you burn a disc (it’s also a good idea to
make sure other users are logged out).
If these general guidelines don’t help, you’ll have to change
the project itself. If you mixed different versions of the iLife
applications (such as iMovie 4 with iDVD 5), recreate the
movies in iMovie HD and replace the old versions in your iDVD
5 project. If your DVD has long movies, use iMovie HD to add
chapter markers, or break the movies into shorter versions.
For a really drastic solution, you can try extracting the
movie’s audio in iMovie HD. Open the Timeline, choose Edit >
22
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Brad’s

Top iDVD Tip
You can add iPhoto, iMovie, and iTunes ﬁles to the DVDROM part of an iDVD project without exporting them
from their native applications. In iDVD, choose Advanced
> Edit DVD-ROM Contents to open the DVD Contents
window. In the iDVD Drawer, click the Media button to
open the Media Browser. Choose the source of your ﬁles
(such as iPhoto), and the ﬁles will appear. Drag ﬁles from
the iDVD Media Browser into the DVD-ROM Contents
window to add them to the DVD-ROM part of the project.

Select All, and then choose Advanced > Extract Audio. Place the
extracted audio in one of the sound tracks, and then mute the
main sound track by deselecting its check box.
Is there a way to delete unused iDVD 5 themes to save
some disk space?

Yup. Quit iDVD. Open the Applications folder, then Controlclick on the iDVD icon and select Show Package Contents.
Open the Contents folder and then the Resources folder. View
that folder in list view and sort by kind; all the themes will be
grouped. Now trash the themes you don’t want. (You can always
reinstall them using the iLife ’05 installer.)
If you group the items in
iDVD’s Resources folder by
kind, you can easily ﬁnd the
themes you want to delete.
I want to include high-quality still images and other
DVD-ROM content on a DVD. Can I use iDVD 5 to link that
content through a text or image link, the way commercial
movie DVDs with DVD-ROM content do?

Unfortunately, you can’t link the DVD-ROM contents of an
iDVD project directly to a menu on the disc. There are other
ways to point viewers to your content, though. For example,
create a short movie, image, or slideshow that directs viewers
to the DVD-ROM content, and then place that on the viewable
part of the disc. You could also create an image ﬁle containing
instructions on how to access those ﬁles and then create a menu
with this image as the background. Place a button leading to
this menu on the main menu of the disc. Workarounds like these
won’t get your viewers to the ﬁles as easily as a link would, but at
least you can let them know they’re there.—Brad Miser

iDVD CPR

When iDVD’s not behaving, try these:
GET CURRENT Make sure you have the latest
versions of iDVD and QuickTime installed.
MAKE REPAIRS Run Disk Utility and repair all disks
and permissions.
FLY SOLO Quit all other applications and log out of
other user accounts before launching iDVD.
ADOPT AN ALIAS Create a new user account and run
iDVD while logged in under the new account.

GarageBand 2
GarageBand can record more than two tracks
simultaneously. How can I do that with just a single Mac
audio input?

You can’t—sorry! You’ll have to spend some money to
purchase a USB or FireWire audio interface. After that,
though, it’s easy. In most cases, because of Mac OS X’s
Core Audio technology, it’s as simple as plugging your
audio interface into your Mac. GarageBand will recognize
the interface, and
you’ll suddenly ﬁnd a
multichannel recording
option in your Real
Instrument track.
Add a multichannel audio
interface, and GarageBand
will present you with
channel choices galore.
I’ve got a bunch of audio ﬁles I’d like to use as Apple
Loops. How can I convert them?

The easy way is to drag a ﬁle into a GarageBand project.
Then highlight it; select Edit > Add To Loop Library; choose the
appropriate key, genre, and descriptors; and click Create.
You might notice that the option to classify the new Apple
Loop as a Loop or One-Shot is grayed out. This is because an
imported ﬁle is unalterable, meaning changing the tempo or key
won’t affect the pitch or timing of the imported audio ﬁle (unless
you’re clever; see “Andrew’s Top GarageBand Tip,” p24).
I’ve got a big external hard drive I’d like to use to store
my loops. How do I move them over?

You have to install GarageBand on the same drive as Mac OS
X, but it’s easy to ofﬂoad your Apple Loops to an external drive
after that. First, quit GarageBand. Go to your /Library/Audio/
Apple Loops/Apple/Apple Loops For GarageBand folder, which
holds a little over a gigabyte of audio ﬁles. Drag that folder to
your external hard drive.
Now go get the loops you created yourself—they’re in your
/user name/Library/Audio/SingleFiles folder. Copy that to your
external drive as well. Delete the original folders.
You’ll also ﬁnd a folder called Apple Loops Index in each of
those Audio directories. Delete the contents of each. Now, when

you launch GarageBand, you’ll get a message telling you that
no Apple Loops were found. Click OK. Click the eyeball icon,
and a Loop Browser appears at the bottom of the GarageBand
interface. Drag your new folders to anywhere in the Loop
Browser. GarageBand will ask if you want to copy the loops
to the Apple Loops folder or just use them from the current
location. Choose Current Location, and you’re ready to rock (or
rap, or whatever).
When you delete a Loops index,
you can have GarageBand create
a new one—for the
Loops you’ve moved to
an external drive, for
example.
I’d like to use GarageBand 2’s multitrack recording
feature. How do I record my guitar and vocals at the
same time?

There are two ways. One way uses a mixer plugged into
your Mac’s audio input, and the other employs a USB or
FireWire audio interface. If you have a mixer, plug your guitar
(let’s assume it’s electric) into channel one and plug a
microphone (for your voice) into channel two. Pan the
guitar hard left (turn the pan knob all the way to the
left) and pan the microphone hard right. Create
two Real Instrument tracks, setting the ﬁrst
tracks’s Input to Channel 1 (mono) and
the second track’s Input to Channel 2
(mono). Make sure the Monitor is on
so you can hear yourself. Turn on
the Record Enable buttons for
second.
both tracks (when they’re
You can
on, they’re red). When
apply effects
you record, the guitar
to either track as
will record on the
needed. For audio
ﬁrst track and
interfaces, the process is
your voice
the same, but you don’t need
on the
to do any panning. The Input
selection will vary depending on the
interface you’re using, but you simply
route the guitar channel to ﬁrst track and
the microphone to the second track.
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How do I import MIDI? How do I export MIDI?

MIDI ﬁles contain musical data sans actual sounds.
To play a MIDI ﬁle in GarageBand, drag the ﬁle into an empty
GarageBand window—literally empty, with no tracks, Loop
Browser, or track editor open. Just make sure the ﬁle has a
.mid extension. If you have a complex MIDI sequence that uses
a lot of instruments, use the Lock Tracks feature to ofﬂoad
CPU-intensive Software Instrument tracks to your hard drive
(external, if possible).
If you want to export MIDI from GarageBand, though, you’re
out of luck. GarageBand won’t do it.
I don’t want to buy a MIDI keyboard, but I hate using
that little onscreen keyboard in GarageBand 2. Is there
a way I can use my Mac keyboard instead?
May 2005
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Yes indeed. GarageBand has a feature called Musical Typing.
Select Window > Musical Typing, and you’ll get a window that
maps your keyboard to a range of notes. You’ll probably wind up
hating it as much as the onscreen keyboard, but go ahead and
try it out.
You can use your
regular Mac
keyboard to play
your Software
Instruments—but
after a few notes,
you may not
want to.
Can I use VST effects or instruments in GarageBand?

VST is a popular digital-audio plug-in format—except in
Apple’s eyes, apparently. None of Apple’s audio apps support
VST, simply because the company’s Audio Units architecture
(according to Apple) is far superior and works safely with OS
X’s Core Audio. There is a possible workaround—though your
results may vary. You can try FXpansion’s VST To AudioUnit
Adapter ($99, www.fxpansion.com), which makes VST plugins available in apps that normally support only Audio Units.
It’s handy when it works, but you’ll probably want to urge VST
developers to create Audio Units versions of their plug-ins.

Andrew’s

Top GarageBand Tip
You can import an audio ﬁle and add it to your Loop Library,
but you can’t affect its pitch and speed—unless you fool
GarageBand into thinking it’s a recorded Real Instrument.
First, create a new project in the key of the audio ﬁle.
Using the peaks in the waveform, the timeline grid, and the
metronome, adjust the project tempo to match the tempo of
the imported ﬁle. Set the cycle region to repeat the portion
of the audio you want to turn into a loop (a measure or two),
and make sure it plays without any hiccups. Adjust the
placement of the clip and the tempo until it sounds smooth.
Crop this segment by using Edit > Split at the beginning
and end of the cycle. Now create a Real Instrument track
and record silence for one beat to create a purple clip.
Here’s the trick: Drag your orange clip onto the Real
Instrument track right after the purple clip, select both
clips, and choose Edit > Join. Click Create to make a
single purple clip. Chop off the beat of silence at the start.
You can now add it to your Loop Library as a loop that
adjusts to tempo and key changes just like “normal” loops.
Turn imported
audio into an Apple
Loop by modifying
the tempo (top),
dropping it next to
a Real Instrument
track (center), and
then joining the two
(bottom).

Can I use Soundfonts with GarageBand?

Soundfonts are like GarageBand’s Software Instruments, and
they’re widely available on the Internet—in fact, many of them
are free. (Check out Kenneth Rundt’s list of links at www
.saunalahti.ﬁ/kru99/links-to-SF-sites.htm.) When you download
Soundfonts, they should have a .sf2 extension. Place the ﬁles
in your /user name/Library/Audio/Sounds/Banks folder. Then,
in Garage Band, create a new Software Instrument track. Select
the track, click on the Track Info button (the “i” button), and
click on the arrow to bring up the instrument details. Select
DLSMusicDevice from the pop-up menu next to Generator. Click
on the pencil icon to the right of that. Now ﬁnd and select your

Soundfonts from the Sound Bank pop-up menu. You can then
save them as Software Instruments for easy retrieval later.
Compatibility can be hit-or-miss, but remember: Soundfonts are
free.—Andrew Tokuda

GarageBand CPR
Though GarageBand may be considered a consumer
or hobbyist app compared to Apple heavyweights
Logic Express and Logic Pro, it’s just as taxing on your
Mac. The three main ingredients in good GarageBand
performance are as follows:
PROCESSOR SPEED Software Instruments and
audio effects are processor hogs. A high-speed G4 is
good. A G5 is better. A dual G5 is best.
RAM Install as much RAM as you can. More RAM
means better Software Instrument performance and less
disk reading and writing.
HARD DRIVE SPEED Get a fast second hard drive
so GarageBand can handle more audio tracks with less
chance of error messages. It also helps Real Instrument
performance.
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Freely downloadable
Soundfonts means more free
Software Instruments—after
jumping through some
GarageBand hoops.
How do we know our authors are iLife experts? Well, Shelly
Brisbin writes books like The MacAddict Guide to Living the iLife;
Brad Miser wrote Mac OS X and iLife; Andrew Tokuda makes music
(check out www.digitaldroo.com); and Johnathon Williams writes
regularly for a bunch of people (including us). They’ve got 60-odd years
of Mac experience among them—but we’re not letting them retire yet.
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UNTWIST

THESE ALTERNATIVE
KEYBOARDS CAN MAKE
TYPING MORE COMFORTABLE
—AND LESS HARMFUL.
by Jake Widman

I

t’s been said that the standard computer keyboard must have been
designed for people whose arms come out of the middle of their chests.
The rest of us have to contort our wrists and hands into unnatural
positions to type. We have to rotate our hands so the palms face down
(pronation), angle our wrists so our hands are parallel (ulnar deviation), and
flex our wrists upward (extension). Over time, this twisting can result in real
damage such as repetitive strain injuries (RSI) or carpal tunnel syndrome.
Fortunately, there are so-called ergonomic keyboards that promise to
unbend your limbs and let you enjoy your Mac in comfort. We took a bunch
of them out for a spin to see what it’s like to type different. To really tell
how much of a difference these keyboards can make, though, you’d have
to use each one exclusively for months—something we didn’t have time for.
(We’ve got a magazine to publish.) So what follows is a collection of first
impressions—test-drives, if you will—rather than full-on reviews.
If you decide to go with one of these alterboards, be ready to spend some
time retraining your brain and fingers—and bear in mind that the more you
stand to benefit (that is, the more you type already), the harder it may be to
retrain yourself. Also, these are keyboards aimed at making typing easier,
which may end up making other computer tasks more difficult. For example,
many of the designs relocate the arrow keys or number pad, which could
mess up your gaming or spreadsheet techniques. You might want to keep
your old keyboard around for Nanosaur 2 and quarterly budget projections.

YOUR WRIST
May 2005
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ADESSO INTELLIMEDIA PRO

DATADESK SMARTBOARD

PRICE: $59.99

PRICE: $119

CONTACT: 800-467-1195, www.adesso.com

CONTACT: 888-446-3222, www.datadesktech.com

The biggest problem with the Intellimedia Pro was setting it
up. The keyboard came with a CD that installed some kind of
controlling software—but the installer didn’t say what it was or
where it went. The Read Me ﬁle on the CD offered the helpful
advice, “After the install complete, the user can go /Application
folder and run the KbdPower to do the USB keyboard key
redeﬁne.” Doing the USB redeﬁne sounded promising, so we
went and found the KbdPower application, which let us assign
the special Mail key to Microsoft Entourage (or anything we
wanted) and the Web key to Firefox (ditto). Unfortunately, the
keys still didn’t work. Next, we went to the Adesso product page
to look for drivers and found one—but after downloading it, it
turned out to be the driver for OS 9. Hello, what year is this?
Adesso tech support kindly emailed us a link to an updated
driver on their Web site. (Fortunately it was a direct link,
because as of this writing, the only driver offered on the
product page is still the OS 9 version.) Once we got that driver
downloaded and installed, all the special keys ﬁnally worked,
including Calculator and Sherlock2.
As a keyboard, the Intellimedia Pro is ﬁne. The keys are divided
into two parts that are angled away from each other, reducing
ulnar deviation. The sections are essentially ﬂat, though, so it
does nothing for pronation. The keys have a good tactile feel,
though we prefer the ﬁrmer feel of the less-expensive Microsoft
Natural Elite Keyboard (p30). Given this keyboard’s $59.99 price
tag and shaky Mac support, it’s hard to get enthusiastic about it.

At ﬁrst glance, the Smartboard looks like all the other split
keyboards. There are two big differences, however: One, the
keys are stacked directly above one another rather than offset
as on a normal keyboard; two, the top keys are larger than the
bottom ones. The idea is that those two changes make the key
layout more closely match the way your ﬁngers naturally fan
out from the palm. That makes sense in theory, but in practice
it doesn’t really seem to make much difference—only months of

Adesso’s Intellimedia Pro adds some
navigation buttons and splits the
keys enough to straighten out
your wrists a bit.

Datadesk bases
its Smartboard’s key
arrangement on the way your
ﬁngers spread out from your palm.

use would reveal whether it’s really better (and really worth the
$119 price tag) to move your ﬁngers straight down than slightly
to the side.
The other aspect of the Smartboard that sets it apart is its
noisiness. This keyboard uses mechanical key switches like
those in the beloved old Apple Extended Keyboard and similar
to those used in the IBM keyboards that Apple mimicked.
The thing is, that plastic clacking isn’t a part of most people’s
computing environments anymore. The return of the clacking is
likely to be distracting—if not to you, then to your coworkers.
The construction also gives the Smartboard’s keys more
resistance than the others in this group and Apple’s current
standard keyboards. If you like a ﬁrm keyboard with auditory
feedback, you’ll probably like the Smartboard—but be
prepared to miss a lot of characters while you’re getting
used to it.

THE MAP IS NOT THE KEYBOARD
If you want to use a PC keyboard with your Mac—whether you want to use one of these
ergonomic keyboards or because you’re a new mini owner with a generic keyboard—you’ll
need to move some of the key assignments around to get them in proper Mac order. Most PC
keyboards put the Alt key between the spacebar and a Windows key; by default, the Alt and
Windows keys become Mac’s Option and Command keys, respectively. That’s ﬁne, but their
positions are reversed.
To put them in their proper places, you’ll need a keyboard remapping utility. Two choices are
uControl (free, on the Disc or download from http://sourceforge.net/projects/ucontrol) and
DoubleCommand (free, on the Disc or download from http://doublecommand.sourceforge
.net). Both put a preference pane in System Preferences that gives you direct access to
some of the more commonly needed tasks (such as swapping Option and Command keys).
DoubleCommand also enables further customization if you enter numeric codes into a textbased preferences ﬁle.
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Keyboard remappers, such as the free uControl,
can give a peecee keyboard a familiar Mac face.

KEY OVATION GOLDTOUCH USB
ADJUSTABLE ERGONOMIC KEYBOARD
PRICE: $119.95
CONTACT: 866-277-9994, www.keyovation.com

The Goldtouch keyboard (like the Kinesis Maxim, p30)
both splits apart to reduce ulnar deviation and raises in
the middle, or tents, to reduce pronation. You set it up by
releasing a locking handle, which allows the two halves
of the keyboard to move around a ball-and-socket joint.
You spread it apart, tilt it up, and lock it into position by
securing the handle. The two halves of the keyboard can
be placed at 30 degrees to the horizontal—about twice as
steep as the Maxim can achieve, and closer to a wristneutral position.
The big problem with the Goldtouch is that with the
keyboard tented, nothing is supporting the center—it’s
like an A with no crossbar. The result is that while you’re
typing, the keyboard bounces up and down a tiny bit—not
enough to mess up your typing, but enough to trigger a
vague sense of alarm. Plus, since much of the keyboard is
elevated, there’s no desk beneath to rest your wrists on.
You’d be best off investing in the optional gel-ﬁlled wrist

Once you release
the locking handle, the
Goldtouch keyboard splits
and raises more than any other
keyboard in this group—just make
sure to bring some wrist rests.

rests that Key Ovation sells for $14.95.
The Goldtouch is a Windows-oriented keyboard with
key-remapping issues, like others in this group; in this
case, there’s a Control-Alt pair that you can turn into
Option-Command, but there’s nothing you can easily
change into a Control key. Key Ovation says that they plan
to produce a Mac-oriented version of the keyboard by the
end of 2005. Wait.

KINESIS ADVANTAGE
PRO
PRICE: $159
CONTACT: 800-454-6374,
www.kinesis-ergo.com

With its silver face and recessed
key wells, the Advantage Pro
looks like a prop from Star Trek—
you just want to look up from it
and intone, “Engage!”—but this
bizarre-looking specimen just
feels right straight out of the box.
You’re normally not supposed to
type with the heels of your hands
resting on the keyboard because
it increases wrist extension, but
with this design, your ﬁngertips
remain lower than your palms
even with your hands at rest.
MOST
(Kinesis includes thin cushions
WRISTto stick on the keyboard to make
FRIEND
using it even more comfortable.)
LY
That’s not to say it doesn’t
take some practice to get up
to speed. Some of the keys
are in new places, and ﬁnger
movements are a little different
(shorter, which is a good thing). An independent—and small—
study at Ohio State University found that it only took an hour
for subjects to get back up to 86 percent of their normal typing
speed on the Advantage. And some of the new key placements
feel like real improvements—putting the Backspace key under
the left thumb and the Return/Enter key under the right thumb
is truly convenient; we missed that when we went back to more
conventional keyboards.

The Advantage Pro
may look like something
from the bridge of the
Enterprise, but it’s
surprisingly easy to get
used to (and like) its
recessed key wells.

Other new key placements are more questionable, like
putting the arrow keys on a row beneath the standard bottom
letter row. If you use the arrow keys a lot already, you’re used
to them being separate from the letters; those who don’t
use them much have to stop and look for them anyway—why
not just put them in the middle of the keyboard rather than
someplace where it’s easy to accidentally hit them? But all in
all, we’d happily remap our ﬁngers for this keyboard.
May 2005
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KINESIS MAXIM
PRICE: $359
CONTACT: 800-454-6374,
www.kinesis-ergo.com

The Maxim aggressively takes
on every fault of the standard
keyboard. First, it splits down the
middle and spreads apart (locking
into one of ﬁve positions) to reduce
ulnar deviation. With the keyboard
on our desk, we liked the widest
setting; using a keyboard tray with
our elbows rested on the arms
of our chair, it felt better to move
After you spread it
the keyboard in a stop or two. The
apart, raise it up, and dial the
Maxim also tents in the middle to
wrist rests into place, the Maxim
one of three positions (including
provides a stable typing platform.
ﬂat), which helps reduce pronation.
After setting the spread and tilt
the way you like it, you adjust the
shortens the keyboard and moves the mouse closer to your
detachable wrist rests until the whole contraption is stable.
right hand. Instead, several keys near the center behave like a
This setup looks implausible, as if there’s no way the
numeric keypad when you press the Function key. The standard
keyboard could stand up to serious typing. But even when
top-row 7, 8, and 9 keys serve as the 7, 8, and 9 of the numeric
widely spread and fully tented, it feels perfectly solid, and your
keypad, with the rest of the keypad numbers and operands
hands fall into a natural, comfortable position.
arrayed around and below.
The Maxim doesn’t have a separate numeric keypad, which

MICROSOFT NATURAL KEYBOARD ELITE
PRICE: $44.95
CONTACT: 888-218-5617, www.microsoft.com

Every so often, the folks in Redmond get something right. This
keyboard is one of those times. When viewed from above, the

This ’board
is inexpensive
and takes care of
the basics without
many frills—and it’s from
Microsoft?! (See the Windows keys?)

DO THESE KEYBOARDS REALLY WORK?
The manufacturers of these alternative keyboards like to toss around
expressions like “ergonomic” and “pain relief.” But is there any real
evidence that these keyboards do any good?
As a matter of fact, there is. A 1999 study tracked 80 computer users
with musculoskeletal disorders and compared four different keyboards—
one standard and three ergonomic. After six months, the researchers
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Natural Elite is practically indistinguishable from the Adesso
Intellimedia Pro: The keys are at almost exactly the same
angle, and the keyboard’s almost exactly the same size.
Like the Adesso, it’s separated into right and left sets of
keys—not as widely as the Kinesis Maxim or the Key Ovation
Goldtouch, but enough to make a comfortable difference. But
this keyboard has something the Adesso doesn’t: a slope in
the middle that gives a moderate tenting effect—again, not as
much as on the ones that actually come apart, but enough to
relieve discomfort from pronation. In addition to all that, the
keys have a nice, ﬁrm responsiveness and a modest “clack”
that we liked.
As you’d expect, the Natural Elite has the usual
disadvantages of a peecee-oriented keyboard. It requires a
PS/2-to-USB adapter—but it’s included in the box, so that’s
no big deal. But it also has a PC-oriented key arrangement
with a Control–Windows key–Alt cluster that maps to ControlCommand-Option on the Mac by default. You need to either
retrain your ﬁngers or use a remapper to swap the Option and
Command keys. But really, for a keyboard that we’ve seen for
$39.99 at a local computer superstore, this one offers a lot of
comfort for not much empty-wallet syndrome.

found that while there was no provable clinical improvement, pain
lessened and hand function increased with alternative keyboards.
Another 1999 study measured joint movements during typical typing
tasks. The study concluded that alternative keyboard designs could
reduce tendon travel by as much as 11 percent. And in 2001, a different
group of researchers published results showing that while alternative
keyboards may not improve overall typing comfort, they probably do
improve the comfort level of your shoulders and wrists.

SIT RIGHT TO KEEP FIT
Your keyboard is only one part of your workspace ecology. You can’t expect an
ergonomic keyboard alone to prevent all the potential problems that can result from
using your Mac—if your keyboard’s at the wrong height, for example, it’ll still put stress
on your shoulders. Here are some commonly accepted guidelines for setting up a bodyfriendly workspace.
1. Center your keyboard in front of you.
2. Use a keyboard tray, and position it so that your keyboard is just above your lap.
3. Keep your elbows in a slightly open position—90 degrees or more.
4. If your keyboard is lower than your desk, tilt it slightly down in back.
5. Type with a light touch.
6. Keep your arms and elbows relaxed and close to your body.
7. Keep your wrists straight while typing—don’t rest them on the keyboard or tray.
8. Center your monitor in front of you.
9. Sit at arm’s length from your monitor.
10. Place your monitor so that its top is 2 to 3 inches above eye level.
11. Tilt your monitor upward slightly.
12. Take frequent breaks.

SAFETYPE

TYPEMATRIX EZ-REACH

PRICE: $295.00 (plus $19.99 for USB adapter)
CONTACT: 858-204-0520, www.safetype.com

PRICE: $99.00 ($75.00 if buying 2 or more)

Take your keyboard, cut it in half, and stand the two halves on
their ends, sticking up vertically. Now you’ve got something
vaguely like the SafeType keyboard. The idea behind the
Safetype is this: If you stand with your arms at your sides and
bend your elbows to put your hands straight out in front of you,
you’ll notice that your palms are facing each other across a foot
and a half or so of space. Wouldn’t it be nice to type that way?
It is, in a way—it’s certainly easier on the wrists. But there’s
nothing to rest your hands or arms on. If the SafeType is on a
keyboard tray and down at the right level for your shoulders to
relax while your forearms stick out perfectly straight, you’re
golden. Otherwise, you have to hold your arms up in the air
while typing, which gets tiring awfully fast.
Furthermore, our brain-ﬁnger communication didn’t adapt
to the new orientation easily. Apparently, that’s not a rare
problem: The SafeType comes with a pair of rearview mirrors
that let you see what your ﬁngers are doing. Wacky, but true.
No doubt about it, the SafeType requires more of a
commitment than any of the other keyboards. Fortunately,
the company offers a 30-day money back guarantee on
new keyboards and invites customers to contact them for
suggestions in getting acclimated to the new way of typing.
Yes, they really do expect you to type like
that—but if your wrists bother you, maybe
you should stop scofﬁng and give the
SafeType a try. Objects in mirrors
are just where
they appear.

Features Editor Jake Widman’s momma warned him to beware of
ulnar deviates. She was right.

CONTACT: 866-439-7322, www.typematrix.com

If your main complaint about
standard keyboards is that they
make your ﬁngers stretch too far,
the EZ-Reach may be the answer. New key
locations may or may not help.

The EZ-Reach is small—not much bigger than a PowerBook
keyboard pried out of its case. It’s thin, too—just over half an
inch thick. Ergonomically speaking, the idea is that condensing
the keys into a small area and placing some of them in more
convenient positions (the Enter and Backspace keys run down
the middle of the keyboard, for example) will reduce the amount
of overall hand movement required. Once you get in the habit of
reaching over with your index ﬁnger or thumb to hit Enter, it’s a
much smaller stretch than it is for your pinky to reach Enter on a
regular keyboard.
The downside is that the keys are so close together that
it’s easy to press the wrong one (the keys themselves are
slightly smaller than a PowerBook’s keys)—pressing the
spacebar instead of N is trivial, but pressing Return instead
of an apostrophe can get annoying. Furthermore, while the
thinness of the keyboard helps reduce wrist extension, its
small horizontal size means it hardly does anything for ulnar
deviation. And while you can use a keyboard remapper to
change the Control and Alt keys into Option and Command,
there’s no key available to turn into the Mac’s Control key. If
you have small hands or already prefer typing on a laptop over
typing on a regular keyboard, you might like the EZ-Reach.
May 2005
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Tanks for Your Memories
M

ost digital cameras store images on slices of
thumbnail- or matchbox-size circuitry called
media cards or memory cards. When you choose a
digital camera, you’re also choosing the type of card
that you’re going to use—most cameras support only
one, or at best two, types. On these pages, you’ll
ﬁnd life-size snapshots of the most popular formats
available today, along with info on subformats,
capacity, cost, and more. (Note that our picture

capacity numbers are only estimates—there are
many factors that determine how many pictures will
ﬁt on a card of a given capacity. Also, the prices
listed are from Amazon.com in late February—due
to the volatility of memory prices, they may have
changed by now.) If you lust after a particular
camera, make sure it supports a card big enough to
handle all the photos you’re likely to take in a day—
and don’t forget to factor in the cost of that card.

BY FREDRIC PAUL

CompactFlash
SanDisk (www.sandisk.com)
introduced CompactFlash (CF) in
1994, and it’s still the most widely
used digicam storage format.
Over the years, advancing technology
has packed in impressive storage space.
ALTERNATE FLAVAS: A wide variety of speeds is
available—buy the fastest you can afford.
HOLD EVERYTHING: Up to 8GB (about 5,840 3-megapixel
images). Cards above 2GB require cameras compatible
with the FAT32 ﬁle system.
SIZE MATTERS: Type I: 1.78 by 1.4 by 0.13 inches; Type II:
1.78 by 1.4 by 0.197 inches.
WHO’S ON BOARD: Agfa, Aiptek, Argus, Canon, Concord,
Epson, Fujiﬁlm, HP, Kodak, Konica, Kyocera, Matsushita,
Minolta, Minox, Nikon, Olympus, Panasonic, Pentax,
Polaroid, Ricoh, Samsung, Sanyo, Sigma, Sony, UMAX,
Vivitar, Yashica.
PRICE TAG: From $40 for a 512MB CF II card to $1,400 for
an 8GB CF Pro card.
COOLNESS FACTOR: My card is bigger than yours.
BOTTOM LINE: Still your best choice unless you need a
small point-and-shoot camera.

MicroDrive
MicroDrives pack a tiny hard
drive into a package compatible
with CompactFlash Type II devices.
Developed by IBM in 1998, MicroDrives
are now built by Hitachi, Sony, and
Seagate.
ALTERNATE FLAVAS: None.
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Memory Stick
Introduced by Sony in 1998, Memory
Sticks are used in all kinds of Sony
devices, from cameras to digital music
players to TV sets. A few other companies make
memory sticks, but only one—Konica—uses them in
its cameras.
ALTERNATE FLAVAS: Memory Stick Pro has more storage
space and faster read/write speeds. Memory Stick Duo is a
miniature version for cell phones and other small devices.
Adapters let you use the Duo in a standard Memory Stick slot.
HOLD EVERYTHING: Up to 2GB for Memory Stick Pro (about
1,450 3-megapixel pictures).
SIZE MATTERS: Memory Stick and Memory Stick Pro: 0.82 by
1.95 by 0.0975 inches; Memory Stick Duo: 0.78 by 1.22 by
0.06 inches.
WHO’S ON BOARD: Sony, Konica.
PRICE TAG: From $47 for a 256MB Memory Stick to $700 for
Sony’s 2GB Memory Stick Pro.
COOLNESS FACTOR: Lexar makes a version that lights up
when it’s in use.
BOTTOM LINE: Great choice if you’re an all-Sony household.
Otherwise, you’re probably better off with a more
standard medium.

HOLD EVERYTHING: Up to 5GB (about 3,650 3-megapixel images).
SIZE MATTERS: 1.78 by 1.4 by 0.197 inches.
WHO’S ON BOARD: Any camera that can accommodate a CF II

card.
PRICE TAG: From $130 for a 2GB MicroDrive to $165 for a 4GB

MicroDrive.
COOLNESS FACTOR: It’s an actual hard drive, dude!
BOTTOM LINE: Now that CompactFlash cards can hold up to 8GB,

the value of a MicroDrive is harder to fathom.

xD-Picture Cards
Developed by Fuji and Olympus in 2002, the
small size of eXtreme Digital (xD) Picture Cards has
quickly made them popular in digital cameras as well as other
devices. Adapters let you use xD-Picture Cards in CompactFlash
readers and (so their vendors claim) cameras, but xD cards can’t
match the capacity of their larger competitors.
ALTERNATE FLAVAS: None.
HOLD EVERYTHING: Up to 1GB (about 730 3-megapixel pictures).

SD and MMC Cards
Developed in 1997 by SanDisk and Siemens
from the older MultiMedia Card (MMC)
standard, the Secure Digital (SD) card
has emerged as the primary mainstream
challenger to CompactFlash. SD cards
include an erasure-prevention switch to
help prevent accidental data loss.
ALTERNATE FLAVAS: SD adds security for
copyrighted data and transfers data four times
faster than MMC. Most SD devices also accepts MMC
cards, but MMC devices may not support SD cards.
miniSD cards are even smaller and often come with

SIZE MATTERS: 0.78 by 0.975 by 0.066 inches.
WHO’S ON BOARD: Canon, Fujiﬁlm, Olympus.
PRICE TAG: From $27.45 for a 128MB xD card to $64 for a 512MB

xD card.
COOLNESS FACTOR: Small is beautiful.
BOTTOM LINE: xD-Picture Cards are typically a bit more

expensive and have a much smaller capacity than other
digital camera storage options, but they’re a great choice
when small size is the most important factor—think cellphone cameras.

adapters for use in SD devices.
HOLD EVERYTHING: SD cards hold up to 1GB (about 730 3-

megapixel images); SanDisk will release a 1GB miniSD card
later this year.
SIZE MATTERS: SD: 1.26 by 0.94 by 0.083 inches; miniSD: 0.846
by 0.787 by 0.084 inches; MMC: 0.94 by 1.2 by 0.046 inches.
WHO’S ON BOARD: Casio, Kodak, Konica, Kyocera, Minolta,
Panasonic, Sharp, Toshiba.
PRICE TAG: $37 for a 512MB SD card; $66 for a 512MB miniSD
card with adapter; $51 for a 512MB MMC card.
COOLNESS FACTOR: Smaller than CompactFlash, but just as dull.
BOTTOM LINE: SD and MMC are more compact than CompactFlash,
but they can’t match the capacity of the newest CF cards. Still,
they’re the media of choice in many small consumer cameras.

The X Factor

Old Busted Joints
If you like to search the bargain bins, you may still ﬁnd digital
cameras that use these storage methods. No matter how cheap they
are, don’t buy them—you’ll regret it later when you want more speed
or storage space.
PC CARDS The same kind that slide into in your PowerBook, these
cards can hold many gigabytes, but they’re so big that they’re used
mainly in professional studio cameras.
3-INCH CD Some Sony cameras burn mini CD-Rs to store pictures. The
CDs make it easy to transfer images to your Mac (unless you have a
slot-loading drive, in which case don’t even try), but they’re relatively
slow—and unless you use CD-RW media, you’ll run through a lot of discs.
SMARTMEDIA Thin and fragile, Toshiba’s SmartMedia cards hold only up
to 128MB. That capacity hasn’t increased since the year 2000, and fewer
and fewer cameras support the format.
FLOPPY DISK Early cameras like
Sony’s MVC-FD200 Digital Camera
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It’s important how fast your camera can write data to a
memory card and transfer data to and from your Mac—
especially with big cards, high-megapixel images,
and full-motion video. However, if companies publish
speed specs at all, they do so using a bewildering
variety of measurements and formats—and the ﬁne
print is always sure to disclaim any real-world validity.
Many vendors use the letter x as a convention to
denote transfer speed, with each x valued at about 150
KBps. So a 4x card would transfer data at 600 KBps,
while an 80x card would do so at 12MBps. (Yes, they
really do vary that widely.) But just because a card says
40x on the label, don’t count on it being 10 times faster
than a card labeled 4x. There are many other critical
factors involved, including the camera the card is in.
So, while it doesn’t hurt to look for a higher x factor,
take these numbers with a shaker full of salt. About
the most you can be sure of is that one manufacturer’s
100x CompactFlash card is going to be at least
somewhat faster, in the same circumstances, than the
same company’s 2x CF card.
Fredric Paul, editor in chief of TechWeb.com, stores
his memory cards in a shoebox under his bed, along
with his collection of pre-steroids baseball cards.
May 2005

33

RATIN¬S
You’ll be
blown away.

You’ll be
impressed.

You’ll be
satisfied.

You’ll be
disappointed.

You’ll be
pissed off.
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better living through smarter shopping

S

pring is in the air—it’s time to leave the comfy conﬁnes of home and rediscover your social life. You
can use your new PowerBook to meet friends at the local coffee house and share the pictures you took
with your Olympus Evolt E-300—and you can tell your friends how you saved a few photos from permanent
deletion with ProSoft’s Picture Rescue. Call up a few more buddies on your Treo 650 phone/PDA combo,
and meet at your place for an impromptu spring shindig. And what’s a shindig without music? Put it in the
mix with Hercules’ DJ Console (pictured). Next month, we’ll review the Sonos Digital Music System, Better
Energy Systems’ Solio solar-powered iPod charger, LaCie’s 321 LCD display, and a lot more.
38
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12-inch PowerBook G4 notebook
15-inch PowerBook G4 notebook
17-inch PowerBook G4 notebook
AirPlay iPod FM transmitter
Business Inkjet 1200d inkjet printer
Call of Duty: United Offensive first-person shooter
Callisto mk II speakers
Carrara 4 Pro 3D software
DJ Console audio mixer
Evolt E-300 camera
H-D70 FlipUp camera-LCD sunshade
iDive video-management software
iWork ’05 productivity suite
MTX: Mototrax dirt-bike racing game
Picture Rescue media-card utility
Primatte Chromakey 2.0 Photoshop masking plug-in
The Mouse BT Bluetooth mouse
TrayDock hard-drive enclosure
Treo 650 phone and PDA hybrid
VerticalMouse 2 ergonomic mouse

PLUS:

PHOTOGRAPH BY MARK MADEO

TheHotList
51 The best of the best from recent reviews.

Compatible with
Mac OS X or later.
Compatible with
Mac OS 9 or earlier.

We’d spend our
own hard-earned
money on this
product.
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iWork ’05

PROMISING WORD PROCESSOR AND PRESENTATION APPS

D

on’t let iWork’s less-than-inspiring
name deceive you, as both of the
applications under its roof—Keynote
2 and the all-new Pages—are at times
brilliant conduits to creativity. Both have
solid, well-designed tool sets and clean,
well-organized interfaces, and both
address compatibility issues (to varying
degrees of success). After creating
projects with each app, however, it
became clear that Keynote and Pages
are in different stages of development.
While Keynote is now in full bloom, the
little ingénue Pages has some growing
up to do.
The iWork apps do have things in
common. Each has a handy-dandy Media
browser, which pulls up your iTunes,
iPhoto, and iMovie collections. From the
Media browser, you can drag and drop
media directly into your documents.
Both apps also feature an Inspector
window—an all-purpose tool shed that
serves as the hub of formatting info.
(Note: You can now view more than
one Inspector window at a time.) And
just as you can build tables and charts
directly into these apps, so can you crop
photos—the new masking tool lets you
crop any photo to better ﬁt your page
layout.
Unfortunately, the two apps also share
something not so cool: a Find & Replace

bug that puts your replacement word or
phrase wherever your cursor is located
before it seeks out the ﬁrst instance of
the word you’re trying to ﬁnd. Also, if you
don’t remember where the search began
and continue to press the Replace and
Find buttons, you end up inputting the
replacement word or phrase twice twice
(like that). So much for quality control.
Hopefully, by the time you read this,
Apple will have released an update that
ﬁxes these annoying problems.

Keynote 2

When Keynote debuted in 2003,
it had beauty—now it has brains. You
can animate individual characters, lines
of text, or object builds with precise
timing (down to fractions of a second)
on individual slides. We appreciated the
ability to preview effects before applying
them, and we liked having the choice to
either trigger effects automatically or by
clicking our mouse. You can also add a
soundtrack with the option to loop, or
attach an audio ﬁle to a single slide.
Version 2 also offers better text
handling. The Text Inspector is now
divided into two tabs: Text and Bullets
& Numbering. You can add bullets, set
margins around paragraphs, and change
the spacing between characters, lines,
and paragraphs. You can also type text

directly into shapes and create free text
boxes (sans bullets); a Fonts browser
allows you to quickly access any font on
your system.
In addition to exporting and importing
presentations to and from PowerPoint,
you can import data from Excel or
AppleWorks for use in one of eight chart
types. The improved table tool makes
easy work of creating headers and
resizing rows and columns.
Makeover. Meanwhile, Keynote
has slapped on a little makeup. You
now have a choice of 20 themes, most
of which are nice in a tasteful-butunoriginal, Pottery Barn sort of way—
we’re grateful that there’s an option to
design your own custom master slides
and themes. Using new transitions
(now ﬁve 3D and 18 2D effects in all),
we burned, popped, and otherwise
mutilated ours in style.
There are now three different types of
slideshow: normal, self-playing (great
for kiosk demos), or hyperlinks-only
(for interactive presentations). In the
Hyperlink section of the Inspector,
you can add links to the Web or email,
or create buttons for slide navigation
(previous/next). Plus, you can place
a snapshot of a Web page in your
presentation that will automatically
update as you present (as long as you’re
connected to the Internet).
If you have two displays, you can now
type notes as you create your slides;
when it comes to presentation time, you
can view the notes as you go without
showing them to your audience. You can
also keep tabs on the elapsed time or
time remaining, and show the current
slide, the next slide, or both.

Pages

Keynote 2 lets you place and resize 12 shapes with options for transparency, text, color, and ﬁll.
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The placeholder text within
each Pages template seems remarkably
representative of Pages itself. The text
is taken from Cicero’s work De Finibus
Bonorum et Malorum, which translates to
The Extremes of Good and Evil. Likewise,
Pages is about opposites—a sum of both
brilliant and surprisingly lame parts.
Let’s get it out there: Pages is no
Microsoft Word. It does, however,
combine fundamental—even quite
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Pages is neither a full-featured word processor nor a
pro design application—but it works when you need
something in between.

decent—word-processing tools with
design basics to make an interesting and
rather useful application.
Like Keynote, you begin by choosing
from a variety of templates, each of
which contains several predeﬁned
page designs (and as in Keynote, you
can customize galore). Pages offers a
total of 41 stylish templates: one blank,
six newsletter, three journal (we loved
these), six invitation, six stationery,
three resume, six education (including
lab notes, a syllabus, and a quiz form),
and six marketing (including a menu).
Pages offers live feedback with rulers
and alignment guides for when you
adjust text and objects. You can display
ruler units as percentages and change
ruler units of measurement if you prefer
picas to points. And you can choose to
view or not to view invisible characters.
Any object (shapes, graphics, media)
you import can either be ﬁxed (text ﬂows
around it) or inline (moves with text).
You can also layer, resize, and move
objects, or change object properties
with relative freedom, although doing so
often feels clumsy.
You can view paragraph, list, and
character styles in the tidy Styles Drawer.
Modifying and creating new paragraph
styles is simple via the Text Inspector.
Other good formatting options include an
auto-updating table of contents, footnote
styles, and customizable headers and
COMPANY: Apple
CONTACT: 800-795-1000 or
408-996-1010, www.apple.com
PRICE: $79

footers. Essential page-setup features,
hyphenation options, and ligature
preferences are at the ready but at their
most basic.
Now for the sticky bits. Compatibility
is a great thing—when it actually works.
It was exciting news to hear we could
export our Pages documents to Word,
RTF, Plain Text, HTML, and PDF formats,
but our spirits dampened when we
read the disclaimer in the manual that
elements would move or be lost in
translation—and real disappointment
set in when we actually tried exporting
for ourselves. Line spacing, special

effects, graphics, and more translated
inconsistently. We had luck with PDF
ﬁles in general, and some documents
made the transition to Word without
much alteration, but exporting to HTML
and RTF proved fairly useless. Also,
don’t count on successfully exporting
movies or audio from Pages. Use
Keynote instead.
Disappointment gave way to
annoyance when it came to deleting
unwanted pages from a project. In
Keynote, the clever outline window at
the left of the canvas allows you to snip,
move, and otherwise manipulate pages
of your presentation at will. In Pages, if
you wish to delete a page, you have to
systematically select each object in your
layout (making sure it’s unlocked) and
delete it. This is a hassle, especially if
you are deleting or signiﬁcantly revising
a complex document. Until Apple comes
out with a ﬁx, we’ll probably go with the
clunky “undo” system, saving versions
as we go along.
The bottom line. iWork may one day
become a powerful productivity suite
to replace AppleWorks (Apple’s wordprocessing, spreadsheet, database, and
design conglomerate) and rival Microsoft
Ofﬁce—but that’s a ways off. In the
meantime, we’re pleased as punch with
Keynote … and looking forward to an
update to Pages.—Jenifer Morgan

Our export from Pages to Microsoft Word (right) turned out decently, but the layout
completely transformed when we exported it to HTML (left).

REQUIREMENTS: 500MHz G3 PowerPC,
G4 PowerBook, Mac OS 10.3.6 or later, 128MB
RAM, 8MB of video memory, 1GB disk space,
QuickTime 6.5 or later, DVD drive

GOOD NEWS: Innovative transitions, animations, and
effects. Clean interface. Handy tools. Inspires creativity.
BAD NEWS: Find & Replace bug. Occasionally clunky.
Noticeable ceiling on features.
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At long last, upgrades
to the PowerBook line.

12-Inch, 15-Inch, and 17-Inch
PowerBook G4s
SPEED-BUMPED, FEATURE-ENHANCED NOTEBOOKS

PHOTOGRAPHS BY SAMANTHA BERG

I

t’s been a while since we’ve seen a
revision of Apple’s PowerBooks, and
we ﬁnally got a speed jump—just not
the one we really wanted. To be fair,
word on the street is that the G5 CPU
is tricky to keep cool in the conﬁnes
of a notebook—give Apple credit for
taking the time to (quietly) do it right. So
although the new PowerBook G4s have
reached a new speed echelon, it’s a
lower echelon than we had hoped.
There’s more new hardware inside
the PowerBooks than just the faster G4
processors. Apple now includes 512MB
of RAM with the stock model of each
PowerBook (high ﬁves all around!).
The hard drives are faster—5,400-rpm
instead of 4,200-rpm drives. And not
only are the 8X DVD±RW SuperDrives
speedier, but they also let you say
buh-bye to those annoying DVD-format
restrictions (although you can’t burn
dual-layer DVDs).
The PowerBooks’ track pads have
also received a speed upgrade—sorta.
You can now scroll by placing two ﬁngers
on the pad and dragging them in the
direction you want to scroll, including
diagonally. For example, if you want to
scroll down when reading a Web page,
you just put two ﬁngers on the pad
and drag them down. It takes practice,
especially when you want to scroll only a
few lines, but it is a faster way to scroll.
If you don’t like the new two-ﬁnger
scroll, you can turn it off in the Keyboard
& Mouse System Preferences.
The other key new feature in the
PowerBooks is one we were afraid to
test: Apple’s Sudden Motion Sensor.
The Sensor is designed to park the
hard-drive heads in the event of a fall
38
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or sudden movement, preventing them
from banging against the disk platters.
Call us wusses, but we couldn’t bring
ourselves to purposely drop a brandnew PowerBook to test this feature; we
could do more than just damage the
hard drive. (The truth: No MacAddict
editor felt like having his salary docked to
buy a replacement PowerBook.—Ed.)
These PowerBooks still get plenty
toasty after several minutes of use—and
studies have shown that notebook heat
can reduce a male’s fertility. That may be
a good or bad thing. You decide.
Conﬁgurations. Of the ﬁve new
PowerBook conﬁgurations, we looked at
three: a 12-inch, a 15-inch, and a 17-inch
PowerBook, each with a SuperDrive. The
two we left out? The Combo Drive–
equipped 12-inch and 15-inch models.
Both of the 12-inch PowerBook
models have a 1.5GHz PowerPC G4
processor, 12.1-inch TFT display,
64MB nVidia GeForce FX Go5200 video
subsystem, Bluetooth, 10/100Base-T
Ethernet, FireWire 400, V.92 modem,

analog-audio in/out, and mini-DVI out.
The SuperDrive model has a 80GB hard
drive, while the Combo Drive version has
a 60GB drive. Unfortunately, the 12-inch
PowerBooks are the only ones in the line
that don’t have illuminated keyboards.
The main difference between
the SuperDrive-equipped 15-inch
PowerBook we reviewed and the Combo
Drive version is the processor: You get
a 1.67GHz PowerPC G4 processor with
the SuperDrive model and a 1.5GHz
PowerPC G4 with the Combo Drive.
The common specs: a 15.2-inch TFT
widescreen display, 64MB ATI Mobility
Radeon 9700 video subsystem, 80GB
hard drive, Bluetooth, Gigabit Ethernet,
FireWire 400 and 800, V.92 modem,
analog-audio in/out, DVI and S-Video
out, and an illuminated keyboard.
There’s only one 17-inch PowerBook;
it has a 1.67GHz PowerPC G4, 17-inch
widescreen TFT display, 128MB ATI
Mobility Radeon 9700 video subsystem,
100GB hard drive, and SuperDrive.
Everything else about the 17-inch

SUBTLE DIFFERENCES

To gauge the performance of the PowerBooks, we ran several real-world tests—far
too many to include here. We tested the PowerBooks with their stock SuperDrive
conﬁgurations, which include 512MB of RAM. We performed the timed tests with
System Preferences > Energy Saver > Optimize Energy Settings set to Highest
Performance and the power adapter plugged in. We performed our DVD playback
test with battery power and the Optimize Energy Settings set to DVD Playback.
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Complex character animations in Carrara 4 are
easier due to an underlying virtual skeleton
that links together body parts.

Carrara 4 Pro
FRIENDLIER 3D SOFTWARE

T

he latest version of Eovia’s 3Dmodeling, rendering, and animation
application Carrara isn’t radically
different from previous versions, but the
app does have a smattering of additions
and tweaks that address Carrara’s prior
rendering and animation weaknesses.
Added goodies include modeling
tools that add a subtle but critical
new capability: object manipulators.
Click on any object in a scene, and
colored selection handles for the x-,
y-, and z-axes appear, allowing you to
constrain and precisely control scaling,
movement, and rotation along a speciﬁc
axis, making it much easier to do any
kind of 3D task. Another important
addition is that the keyboard’s arrow
keys (when pressed along with the
Command key) can now nudge an
object around; holding down the Shift
key allows you to nudge in much ﬁner
increments.
Carrara 4 also adds nice changes to
the terrain and sky generators, with
larger image meshes supported in the
terrain modules (up to 8,192 by 8,192
pixels, which can yield some seriously
big, detailed landscapes) and a slick

multi-layered terrain-texture module
that lets you create advanced rendered
effects such as snow (which changes in
density based on altitude and slope) or
pockets of water at certain elevations.
It’s not quite as capable as Daz’s
Bryce ($89.95, www.daz3d.com), but
it’s still cool. The additions to the sky
module signiﬁcantly improve the look of
rendered fog, haze, and clouds, and add
to the realism of the atmospherics.
Improved IK. Eovia has tweaked
Carrara’s inverse kinematics (IK) so that
creating convincing walking creatures
is much more straightforward. Morph
targets make the complex work of
animating facial expressions more
manageable—your characters will smile
more easily, which will make you smile.
Eovia has also added the ability to
import sound ﬁles and place them in the
timeline—crucial for syncing movement
to sound effects, a critical part of the
animation process.
Ultimately, rendering is the true test
of any 3D software, and Carrara 4 has
lovely additions, including real 3D motion
blur and blurry reﬂections, two visual
elements that often mean the difference

COMPANY: Eovia
REQUIREMENTS: 266MHz G3, Mac
CONTACT: 650-938-0515,
OS 10.1 or later, 128MB RAM, 300MB
www.eovia.com
disk space
PRICE: $579 (download), $599 (boxed)
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between a ﬂat animation and one that
conveys realism. Turning on these
options increases overall rendering time,
but—thankfully—the rendering engine
in Carrara 4 feels snappier than the one
in the previous version (there’s no such
thing as a renderer that’s fast enough).
A new network-rendering feature
limits you to ﬁve computers (Macs
or PCs; both Mac OS X and Windows
versions of the software are included),
all of which must be present under the
same IP subnet mask—so forget about
true network rendering using remote
machines. Network rendering is also
available as a $199 add-on for the
less-capable Carrara 4 Standard ($279
download, $299 boxed).
Previous versions of Carrara took
over our Mac’s entire screen, and this
continues to be an issue in Carrara 4.
Hopefully, this interface rudeness will
change in the next revision.

New natural-terrain options let you layer snow,
grass, and rock together in complex ways with
minimal effort.

The bottom line. In the realm of midpriced integrated modeling, rendering,
and animation software, Carrara 4 Pro
continues to offer a decently balanced
compromise between power and
usefulness. It appeals to designers
looking to punch through their ﬂat 2D
world into 3D.—David Biedny

GOOD NEWS: Long-overdue object manipulators and
nudge keys. Improved IK and timeline editing.
BAD NEWS: Interface takes over screen. Network
rendering limited to five computers.
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placement found in
other SLR cameras.
The camera
performed smoothly
and produced images with good
dynamic range, detail in both shadows
and highlights, and accurate color—
though we’ve seen sharper images in
higher-end SLRs. Shot-to-shot time
was as fast as we could press
the shutter release, and
focusing was quick and
accurate even under
low-light conditions.
Each time the
E-300 is switched
on, it’s ready to
shoot in about two
seconds—not as
fast as the Nikon
D70 (
Jul/04, p50), but
acceptably perky—even
though the camera ﬁrst
cleans dust particles off the
sensor (Olympus says that the
dust collects in a special repository in
the camera, and that it could be several
years before the repository needs to be
emptied—if ever).
The camera’s built-in ﬂash does an
excellent job on automatic and has a
manual option that lets you adjust its
intensity. The E-300 has an ISO range of
100 to 1,600, though images get fairly
noisy past 400. Other nice features
include shutter speeds from 8 minutes
to 1/4000 of a second; good resolution
choices (1, 2, 5, or 8 megapixels); RAW,
TIFF, JPEG, and RAW+JPEG modes; noise
reduction (for long exposures); and
video out (NTSC and PAL). You can shoot
sequences at 2.5 fps, but you can only
shoot four pictures in a row—though you
can keep shooting single frames while
the buffer clears, after which you can
rapid-ﬁre another four.
The bottom line. The E-300 isn’t a pro
SLR camera because it can’t withstand
grinding, physical punishment. But it is
perfectly capable of giving professionallooking results at a nice price. As long as
you treat it right, the E-300 will repay you
in kind.—Arthur Bleich

Evolt E-300

INTERMEDIATE SLR CAMERA

W

hen does an SLR not look like an
SLR? When it’s the Olympus Evolt
E-300, a streamlined, eight-megapixel
digital SLR that buries the optics
required for through-the-lens viewing
inside the camera, thus trimming size
and weight. The E-300 weighs just two
pounds, and that’s with its Zuiko f/3.5–
5.6 digital 14–45mm lens (equivalent
to 28–90mm in 35mm terms), allaluminum body, rechargeable battery,
and CompactFlash memory card (not
included).
For an affordable SLR, the E-300
has a good blend of simplicity and
sophistication. Beginners can use
basic scene settings on the mode dial—
portrait, landscape, close-up, action, or
night scene—or twirl the dial to Scene
to bring up the full 14-scene repertoire
on the LCD. Advanced photogs will go
directly to aperture or shutter priority,
program mode, or full manual mode.
When you’re shooting, the E-300’s
LCD displays information about the
COMPANY: Olympus
CONTACT: 888-553-444,
www.olympusamerica.com
PRICE: $999 with lens

shots you’re taking—you can’t preview
an image on the LCD with digital
SLRs. Exposure values, ﬂash status,
resolution, ISO, white balance, shots
remaining, and battery power are
displayed in big, bright letters, numbers,
and icons—an improvement over the
minuscule, hard-to-read LCD info
displayed by other cameras.
Is it on? The E-300’s buttons and
dials are positioned for easy access. The
review button is especially convenient,
located just to the left of your right
thumb. Not so intuitive is the on-off
switch lever, which seems to be oriented
the wrong way—it’s under the mode
dial, and instead of pulling it toward
you to turn on the camera, you have to
fumble past the camera strap to push it
away. Another qualm: When framing a
shot through the viewﬁnder, we found it
awkward to shift our eyes to the lighted
status display that runs down the
right side of the viewﬁnder. We prefer
the under-the-image status-display

REQUIREMENTS: USB-equipped
Mac, Mac OS 8.6 to 9.2 or 10.1 or later

GOOD NEWS: Light weight. Top-notch images. Includes highquality zoom lens. Long-lasting battery.
BAD NEWS: Limited sequence mode. Awkward viewfinder
status display. Manual could be more detailed.

May 2005

41

PHOTOGRAPH BY MARK MADEO

Despite its lack of a
hump, this is an SLR
camera. Really.
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Business Inkjet 1200d
CONVENTIONAL PRINTER

t seems that photo printers are all
the rage, but there’s still a place for
business color inkjet printers such
as HP’s Business Inkjet 1200d: in an
ofﬁce, where charts, presentations,
spreadsheets, and text take priority over
road-trip photos (which, actually, the
1200d handles pretty darn well, as we’ll
discuss in a minute).
We looked at the $199 USB 2.0–
equipped 1200d, which holds 150
pages and is suitable for a small ofﬁce.
HP offers four different models of the
1200, and that means delving into
HP’s nomenclature mumbo-jumbo. The
1200dn ($249) has built-in 10/100BaseTX Fast Ethernet so you can hook it
up to your ofﬁce network. The $299
1200dtn is a 1200dn with a second,
250-page paper tray for a total capacity
of 400 pages. And for $349, there’s the
1200dtwn, which is a 1200dtn with WiFi (802.11b and 802.11g).
Setting up the 1200d took us less
than 30 minutes—and we weren’t in
a big rush. It uses four individual ink
cartridges: black, cyan, magenta, and
yellow; there’s no light magenta, red,
matte black, or any of the additional inks
you often see in inkjet photo printers.
The print heads are separate from the
ink cartridges, and they are installed
in a separate carriage. The nice thing
about having all the ink cartridges and
print heads separate is that you can
replace only what you need to replace.
Replacement ink cartridges and print
heads are $33.99 each.
While the 1200d can print on plain

Find out how much ink you have left using
the included HP Inkjet Toolkit utility.
COMPANY: Hewlett-Packard
CONTACT: 800-752-0900,
www.hp.com
PRICE: $199
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paper, special kinds of inkjet paper are
available to get the best results. HP’s
Premium Inkjet Paper (200 sheets, 8.5
by 11 inches) is $20.99; HP’s glossy
Premium Photo Paper (15 sheets, 8.5 by
11 inches) costs $9.99; and a pack of
HP’s matte Brochure and Flyer Paper (50
sheets, 8.5 by 11 inches) is $9.99.
Speed and image quality. The 1200d
is rated at 9 pages per minute (ppm) for
black in normal quality mode; we got

Inkjet Paper, you get crisp and clean
lines; on plain paper, you get not-soclean lines. The color accuracy in our
PowerPoint presentation was excellent;
we didn’t see any color shifts, but
we did notice minor banding in color
gradients.
Printing an 8-by-10-inch photo (you
can’t do borderless prints) in Photoshop
took about eight minutes, which is
mighty darn slow when compared to

Remember when inkjet
printers used only four ink colors? The 1200d does.

6.2 ppm when printing a 50-page Word
document—our times are from click
(when you click Print) to clunk (when the
print is done), so they include whatever
image processing needs to be done on
your Mac. When printing a 15-page,
full-color PowerPoint presentation, the
1200d averaged 1.5 ppm, notably pokier
than its rated 4 ppm—and that was when
we were printing from a dual 2GHz Power
Mac G5. A two-page Excel spreadsheet
took 45 seconds. We were quite pleased
with the 1200d’s speed for business
documents; no, it’s not as fast as a
monochrome or color laser, but it’s also
not nearly as expensive.
The 1200d’s image quality is good
for an inkjet printer. On HP’s Premium

REQUIREMENTS: USB-equipped
Mac, Mac OS 9.x or 10.1 or later

a speed-demon inkjet such as the
Canon i9900 Photo Printer (
Nov/04, p46). The 1200d reproduced
images containing metallics, dyed
cloth, and bright colors well, but more
natural tones, such as skin and earth
tones, lacked consistency and warmth.
Remember, the 1200d isn’t designed
for photo output; if your photo-printing
demands ever start to grow, consider
having a dedicated photo printer sit next
to your 1200d.
The bottom line. If you’re mostly
printing charts, text, and slide
presentations, and you’re printing less
than 150 pages per week, you’ll be
happy with the 1200d. It just works—
and works well.—Roman Loyola

GOOD NEWS: Easy to use. Fast. Built-in duplexing.
BAD NEWS: Slow photo-printing speeds. Low paper
capacity for an office with high printing demands.

PHOTOGRAPH BY MARK MADEO
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ELEGANT PHONE AND PDA

T

he Palm OS–based Treo has always
been the best PDA-and-cell-phone
combination on the market, and the
latest version, the Treo 650, features
reﬁnements that make it even better
than the Treo 600: a lovely 320-by320-pixel TFT screen and convenient
(but slow) Bluetooth that lets you sync
wirelessly to your Mac using iSync.
Other improvements include a
removable battery, the addition of call
and end buttons (making the Treo feel
more phone-like), and the ability to
take pictures of people and then add
their mugs to your address book—a
great tool to ensure you weren’t just
beer-gogglingly addled the night before.
Although the camera is still only VGA
quality, palmOne has improved its
COMPANY: palmOne
CONTACT: 800-881-7256,
www.palmone.com
PRICE: $599 (without service activation)

American Novel.
low-light performance and
As you’d probably
added video capture and 2X
guess, the keys are
digital zoom.
a bit tight, and typing
Place an IM. The
can get tiresome—
included email client,
you’ll quickly learn to
VersaMail, was a breeze
live with typos. Also,
to set up—all we had to
there’s only 23MB of
do was tell it we had
user-available memory,
a .Mac account, and
which doesn’t leave
the app took care of
much room for videos,
all the settings. One
pictures, music, or
bummer is the lack of
games. There is an SD
an instant-messaging
card slot, but is it really
client—you’ll have
that much to ask for a few
to download the $25
more built-in megs?
VeriChat app, which
Why can’t all
The bottom line. We’re
lets you chat on every
PDA/phone combos be as
willing to forgive the Treo 650’s
major IM service.
nice as this one?
imperfections because it’s still
Although the Treo
the most elegant fusion of cell phone
650 includes a QWERTY keyboard, it’s
and PDA available.—Cathy Lu
still not conducive to writing your Great

REQUIREMENTS:
USB-equipped Mac, Mac
OS 10.2 or later

GOOD NEWS: Beautiful high-resolution screen. Bluetooth.
Feels like a phone.
BAD NEWS: Key spacing a bit tight. Paltry built-in memory.

Primatte Chromakey 2.0
TIMESAVING PHOTOSHOP PLUG-IN

D

igital Anarchy’s Primatte
Chromakey 2.0 is a clever Adobe
Photoshop plug-in that slashes masking
time (removing unneeded portions of
an image). Chromakey takes any image
shot against a solid backdrop (blue and
green are typically used, but any solid
color works) and replaces the backdrop
with any digital image you choose.
Before you use Chromakey, you must
set up your image layers with your
subject in the foreground and your
new background in a layer beneath
that. Chromakey then creates a mask
in your subject’s image that removes
the colored background and replaces it
with a transparent area. You can then
clean up the mask by holding down your
mouse button and scrubbing the areas
that need to be cleaned.
COMPANY: Digital Anarchy
CONTACT: 415-586-8434,
www.digitalanarchy.com
PRICE: $299
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Chromakey makes your green-screen images
easier to mask.

This is just the simplest type of mask
Chromakey can do. The ability to pull out
color through the transparent area of a
photo (such as glass or lace) or clean up
wispy hair is truly inspiring. These are
still time-intensive tasks in Chromakey,

REQUIREMENTS: Mac OS 9.2.2
or X or later, Adobe Photoshop 5.5
or later, Adobe Photoshop Elements
2.0 or later

but they’re quicker than manual
masking.
Spill cleaner. When light
bounces off the background
onto your subject, green or blue
tones invade your image—this is
called bluespill. Chromakey lets
you see your subject against any color
so the blue or green spill areas become
more apparent; you can then eliminate
those trouble areas using Chromakey’s
Spill Sponge. Pan and zoom features let
you get in close and check selections.
The bottom line. Chromakey may be
expensive for serious amateurs, but it’s
money well spent for pros. We’ll spend
the time we saved using Chromakey
watching our new DVD set of The Wire,
trying to ﬁnd out how Poot and Bubbles
got their nicknames.—Steven Parke

GOOD NEWS: A great timersaver. Masks are fun again!
Easy to use.
BAD NEWS: Pricey for non-professionals.
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Treo 650
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ELECTRIFY
Your GarageBand

™

• Over 4,000 Apple Loops
• HipHop, House, Rock, Metal,
Reggae, Jazz, Latin, Funk, Soul, …
• 222 Software Instruments with a
Customized User Interface
• Keyboards, Guitars, Bass, Brass,
Drums, Percussion, …
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Callisto mk II
BRAWNY YET PRECISE SPEAKERS
erious audiophiles gripe that massproduced computer speakers suck,
compromising sound quality in favor
of cabinet designs that conserve desk
space and match your computer. The
folks at Jupiter Audio, on the other hand,
care deeply about sound quality. With
their Callisto mk II speakers, superior
sound comes ﬁrst—desk space be
damned.
The big, boxy mk II speakers certainly
draw attention away from whatever
you have on your Mac screen. Each mk
II cabinet is made of medium-density
ﬁberboard with an oak or black-oak
ﬁnish and measures 11.63 inches tall,
6.25 inches wide, and 8.75 inches deep.
The Aurasound 3-inch woofer and Seas
shielded dome tweeter are exposed on
the face of each speaker, calling even
more attention to the mk IIs.
COMPANY: Jupiter Audio
CONTACT: 630-649-4329,
www.jupiter-audio.com
PRICE: $799

Master and slave. With the
mk II system, one speaker
acts as a master unit that
connects to your Mac or iPod
using a miniplug-to-stereo
RCA cable. The other speaker
acts as a slave and connects
to the master via a standard
They don’t match your Mac,
speaker cable, like those used but damn, they sound good.
in home stereo and theater
call for thumping bass. The tweeters
setups. (There is no subwoofer.)
can produce sweet clarity, so you don’t
Once we set up the speakers and
miss anything in the high end, either. We
heard the Mac startup sound conﬁrm
didn’t hear any sound difference when
that they were working, we launched
we used an iPod with the mk II.
iTunes and played a variety of songs.
The bottom line. With a hefty $799
From rock to rap to rondos, the mk II
price, the mk II set may be too expensive
produced a warm, full-bodied sound that
for casual users. But if you take your
made us feel good about our eclectic
sound seriously, you’ll love ’em—even if
tastes in music. We bet that you won’t
they don’t look particularly high-tech.
miss the subwoofer—the mk IIs have a
—Roman Loyola
range wide enough to handle songs that

REQUIREMENTS: Mac with
audio-out port, Y-adapter cable,
speaker cable

GOOD NEWS: Awesome, full-bodied sound.
BAD NEWS: Wood cabinets may not appeal to those who want
to match components to their Macs. Expensive.

DJ Console
TOTABLE AUDIO MIXER

H

ercules’ DJ Console replaces your
turntable and mixer with a small
USB-powered box that has a mixer and
turntable-like wheels similar to those
found on CD DJ decks. The Console is a
good idea—but it has a few limitations.
The Console has loads of inputs and
outputs, including MIDI, 5.1 audio, and
S/PDIF. It also has front-panel RCA linein ports, plus a 0.25-inch phono-plug
mic-in port and 0.25-inch headphone
jack, each with individual level controls.
The Console’s controls are similar
to those found on a CD turntable. For
manual beat matching, the Console
features easy-to-use Pitch Bend buttons.
Mixing vets will love the FX buttons
that allow the Console to emulate some
COMPANY: Hercules
CONTACT: 514-279-9960,
http://us.hercules.com
PRICE: $299
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Tough enough
for the DJ on the go.

sweet voltage-controlled effects,
identical to those found on the Allen &
Heath Xone professional-grade mixers
(www.allen-heath.com).
Power Traktor. The Console comes with
a custom version of Traktor DJ Studio, the
industry leader in DJ software—and it’s
a kick to use. Traktor ﬁnds all playable

REQUIREMENTS: 1GHz G4, Mac OS
10.2.6 or later, 256MB RAM, 1GB disk
space, Internet connection

media on your Mac, loads them into its
library, and allows you to select
songs via the Console’s
handy joystick and songselect buttons.
When it comes to
scratching, the latency of
the jog wheel—even when
minimized in Preferences—is so
far behind what is actually playing
that it makes scratching impractical.
Plus, the Console doesn’t have a crossfader that allows a hard cut from channel
to channel, which is essential for
scratching. We also found the buttons
to be extra sensitive; we often triggered
the Play/Pause button twice when we
only pressed it once.
The bottom line. You won’t scratch up
a DJ QBert–like storm with the Console,
but you’ll do well when you’re in the
mix.—Noah Tsutsui

GOOD NEWS: Small and durable. A myriad of inputs
and outputs. USB powered. Traktor software
is awesome.
BAD NEWS: Limited scratching capabilities.

PHOTOGRAPHS BY MARK MADEO
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iDive

INVALUABLE VIDEO-MANAGEMENT SOFTWARE

T

COMPANY: Aquafadas Software
CONTACT: www.aquafadas.com
PRICE: $69.95

REQUIREMENTS: Mac OS 10.3 or later, 256MB
RAM, 5MB disk space (plus 20MB to 120MB disk space
per hour of digital video)

GOOD NEWS: Easy to use. Drag-and-drop compatibility with
Final Cut Pro and iMovie.
BAD NEWS: Minor interface quirks. Can only log video
digitized through iDive.
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We liked
the wired
version a tad better.

The Mouse BT
ATTRACTIVE WIRELESS
MOUSE

W

e loved MacMice’s The Mouse
(
Mar/04, p61), and
now there’s a wireless version—The
Mouse BT. The BT stands for Bluetooth,
so you’ll need either built-in Bluetooth
or a Bluetooth adapter, which isn’t
included—MacMice recommends DLink’s DBT-120 Wireless USB Bluetooth
Adapter ($45, www.dlink.com). You can
use Mac OS X’s drivers or MacMice’s
MouseCommand to tweak your mouse
settings, but neither can tell you the
status of the mouse’s battery. Better
have those spares ready.
Some of us here at MacAddict
enjoyed using The Mouse BT; others
didn’t like the feel—it’s a lot like Apple’s
wireless mouse, only with two buttons
instead of one. The scroll wheel is
delightfully smooth, but if you like scrollwheel notches, know that the BT doesn’t
have ’em.
The bottom line. The simple fact that
The Mouse BT has two buttons and a
scroll wheel is reason enough to opt
for this mouse over Apple’s wireless
Bluetooth mouse ($59, www.apple
.com). And it looks nice, too.
—Roman Loyola
COMPANY: MacMice
CONTACT:
615-822-9270,
www.macmice.com

PRICE: $69.99
REQUIREMENTS:
Bluetooth-equipped Mac,
Mac OS 10.2.8 or later

GOOD NEWS: Attractive. Smooth scroll wheel.
BAD NEWS: Doesn’t
provide battery-level
information.

PHOTOGRAPH BY MARK MADEO

One major caveat: You can’t import
previously digitized videos into iDive.
That sucks, but an Aquafadas rep says
the company’s working on an upgrade
that will make it possible.
Find it fast. There are two ways to
view your video catalog in iDive. The
icon view uses a frame from your video
to represent your clip, while the tabular
view lists a thumbnail and associated
metadata, such as length, timecode,
format, and aspect ratio. If you click on
a video in your thumbnail list, you can
preview the frames of your video in the
pane below the list.
iDive’s annotation tools are great for
sifting through
your videos. Each
video has Title,
Date, and Notes
ﬁelds, and you
can create lists of
people, places,
and events to
associate with
your videos
(though we
encountered a
glitch where we
couldn’t change
the name of a
person unless we
relaunched the
app; Aquafadas
says it’s aware
Finally, software that does what Final Cut Pro and iMovie don’t do:
of the problem).
manage your video clips.
To ﬁnd a clip, you
just enter a keyword into the search box
the tape with the clip you want, and then
and press the Return key. iDive then lists
digitize the entire video in your editing
the associated videos.
application.
The bottom line. iDive ﬁlls a gaping
Blessed with lots of storage, or only
have a few tapes? You can digitize your
hole in video production with your Mac.
videos at full quality and then export
Now that we know what our stacks
them to Final Cut Pro or iMovie by
of mysterious MiniDV tapes actually
simply dragging the clip from iDive into
contain, they no longer scare us.
your editing app—it works seamlessly.
—Roman Loyola
he trickiest part about editing video
in Final Cut Pro or iMovie—organizing
your taped footage for a project—just got
a whole lot easier. iDive manages your
footage by using frame samples and
customizable annotations so you know
what’s in each and every shot in your
tape collection.
iDive works by keeping a list of the
videos you’ve digitized through iDive.
If you have a ton of tapes to index (and
not a lot of hard drive space), you can
perform a sampled-video capture,
in which iDive records frames at an
interval you set (every 1, 2, 5, 10, or 20
seconds). You can use the catalog to ﬁnd
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TrayDock

HANDY HARD-DRIVE
ENCLOSURE

N

MTX: Mototrax

FUN BUT PHONY DIRT-BIKE RACING GAME

A

TIP

a turn, or pull back a wheelie. Even when
s wannabe dirt-bike riders, we
we assigned turning to the joystick or dcouldn’t wait to get our hands
pad on various gamepads, it felt like an
on Aspyr’s MTX: Mototrax. Will its
on-or-off deal with no gradation.
combination of tight-arena supercross
Another break from reality is the
racing, wide-open outdoor motocross
game’s marquee feature: big-air
racing, and trick riding prepare you for a
jumps—speciﬁcally, how you control
career on the circuit? Nope. Mototrax’s
them. Mototrax uses a suspensionforte is providing thrills, not realism.
compression system (there’s an
MTX: Mototrax starts you off with
on-screen compression-level indicator)
a private riding lesson from pro racer
that lets you control how high and far
Travis Pastrana—a good way to learn
you jump by properly compressing
the game’s mechanics and physics. He
and releasing the springs—it actually
teaches you how to handle your bike,
requires precision,
takes you on a
unlike the throttle and
practice race, and
RIDE THE CLUTCH
turning controls.
then sends you on
Forget what your driver’s-ed
Our 1.25GHz
your way. On the
teacher said. For the fastest starts
in MTX: Mototrax, hold down both
PowerBook with
racing circuit, there
the accelerator and clutch, and
64MB of VRAM gave
are eight motocross
when the start gate drops, pop
us smooth gameplay
and eight supercross
the clutch. Tapping the clutch also
once we turned
tracks in venues
helps you negotiate the corners.
off anti-aliasing
ranging from Arizona
and lowered the
to Australia, which
resolution to 640 by 480. Our 1.8GHz
you attack in four classes (the 125cc
G5 with a fat 256MB Radeon 9800 video
qualiﬁer, plus 250cc East, West, and
card gave us perfect ﬂuidity with all the
Master classes); you have to win each
eye candy enabled.
series before getting to your ultimate
The bottom line. If you’re into
goal: the X Games.
two-wheeled motor sports, then MTX:
Digital controls. You can control your
Mototrax is the only game in town—and
bike with either a USB gamepad or your
its low-cost/high-fun ratio helps its
keyboard. We found it easier to use the
rating.—Niko Coucouvanis
keyboard to goose the throttle, lean into
COMPANY: Aspyr
CONTACT: 888-212-7797 or 512-708-8100,
www.aspyr.com
PRICE: $19.99
GOOD NEWS: Loads of fun. Not too tough.
BAD NEWS: Not very realistic. Gamepad support is weak.

REQUIREMENTS: 1GHz G4, Mac OS 10.2.8 or
later, 256MB RAM, 32MB ATI Radeon 7500 or nVidia
GeForce2 MX video card or better, 1.4GB disk space

One enclosure.
Multiple slide-’em-in drives.
(WiebeTech offers a three-footer for
$19.95). After you connect the TrayDock
to your Mac, you can hot swap drives;
you can buy extra trays (for $49.95
each), ﬁt them with drives, and slide
them in and out of the TrayDock without
shutting down your Mac. WiebeTech
also sells the TrayDock with drives
installed (check out www.wiebetech
.com/products/traydock.php).
The bottom line. The TrayDock may
be more expensive than some external
drives, but once you start a-slippin’ and
a-slidin’ multiple trays, it’s well worth the
cash.—Roman Loyola
COMPANY: WiebeTech
CONTACT: 866-744-8722, www.wiebetech.com
PRICE: $169.95 (without hard drive)
REQUIREMENTS: Mac OS 9.1 or X or later, 32MB RAM
GOOD NEWS: Sturdy. Removable. Tray is hotswappable.
BAD NEWS: Case surface
not scratch resistant.
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MTX: Mototrax
is super-fun
supercross.

eed more storage space, but don’t
want to pay for extra enclosures,
drive controllers, or FireWire 800
circuitry for multiple external drives?
Then check out WiebeTech’s TrayDock, a
sophisticated, sturdy metal case made
to house ATA or Serial ATA hard drives on
easy-to-install removable trays.
It’s simple to install a drive mechanism
into a tray—just ﬂip open a metal switch,
slide out the tray, and attach the drive.
When you slide the tray back in, you can
lock it for protection against thievery. We
loved the look of the case, but we were
bummed to ﬁnd minor scratches on its
surface after some handling.
The TrayDock has a USB 2.0 port and
a pair of FireWire 800 ports, though
you’ll need to buy a FireWire 800–to–
FireWire 400 cable if your Mac supports
only FireWire 400
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Picture Rescue

EMERGENCY PHOTO-RECOVERY UTILITY
nder the right conditions, Prosoft’s
Picture Rescue can help you recover
some of your photos from your camera’s
ﬂash memory card after they’ve been
lost during a freak hardware meltdown or
an act of sheer knuckleheaded-ness.
Picture Rescue is darn simple to
use. Its main window consists of three
controls: a pull-down menu for media
selection, an Erase button, and a Start
button to initiate a scan. Connect your
digital camera (or media card via card
reader) to your Mac, and Picture Rescue
automatically detects the cards. Next,
choose a card and click Start. In mere
minutes, thumbnails of your recoverable
images appear in the Image Recovery
Window. Select the photos you want and
save them to your hard disk. Done.
COMPANY: Prosoft Engineering
CONTACT: 925-426-6100,
www.prosofteng.com
PRICE: $59.99

Results vary.
There are, however,
times when you can’t
recover a picture.
For example, if you
take twenty photos,
erase your card, and
then take another
ten pics, Picture
Rescue won’t ﬁnd the Deleted a pic you didn’t mean to? Picture Rescue to the rescue!
shots that have been
The bottom line. Like a lot of
overwritten. If you format your cards on
emergency utilities, you’ll consider
your digital camera after each session,
Picture Rescue a godsend if and when
Picture Rescue may not ﬁnd anything
you successfully use it. It’s a bit pricey at
at all. For example, Olympus and Fuji
$60, but if you’re able to recover at least
cameras completely erase all data
a few precious photos, it’ll be money
during a format, so there’s no chance of
well spent.—Gil Loyola
recovering photos. We conﬁrmed this on
our trusty old Olympus C-211.

REQUIREMENTS:
Mac OS 10.2.3 or later

GOOD NEWS: Easy to use.
BAD NEWS: May not help in some cases. Pricey.

AirPlay

H-D70 FlipUp

FUNCTIONAL FM TRANSMITTER

INEFFECTIVE SUNSHADE

W

A

e’ve found yet another FM transmitter for the iPod that
we like: XtremeMac’s AirPlay. We also liked Sonnet
Technologies’ PodFreq (
Aug/04, p58) and Monster
Cable’s iCarPlay (
Mar/05, p48). It’s nice to know that
there are real choices out there, especially since many other FM
transmitters don’t work well.
AirPlay plugs into the earphone jack of your iPod. Find an
empty station on your radio, set the AirPlay to the same station,
and you’re good to go. AirPlay draws its power from your ’Pod,
which means your
battery life shorten—
It’s small.
It’s cheap. It but not by much.
The bottom line.
works. ’Nuff
AirPlay doesn’t let you
said.
save station settings.
But hey, it’s cheap and
works just ﬁne.
—Roman Loyola
COMPANY: XtremeMac
CONTACT: 954-385-9877,
www.xtrememac.com

PRICE: $39.95
REQUIREMENTS: Third- or fourth-generation
iPod, iPod photo, or iPod mini

GOOD NEWS: Easy to use. Small.
BAD NEWS: No way to set station presets.
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U

lthough Hoodman
makes some great
products, the H-D70
FlipUp—a sun visor and
LCD protector for Nikon’s
D70 digital SLR—isn’t one
of them. Also available
for Canon’s EOS Digital
Rebel, 20D, and 10D; Fuji’s
S2; and Nikon’s D2Hx
and D100; the FlipUp is
Looks great. Too bad it doesn’t work well.
intended to shade the D70’s
LCD from sunlight, making it easier to read outdoors. In reality,
the shading effect is minimal. The FlipUp protects the delicate
LCD well, but so does the plastic shield provided by Nikon.
The bottom line. Stick with one of Hoodman’s fully enclosed
LCD hoods and magniﬁers—they work great. The FlipUp,
unfortunately, doesn’t.—Rik Myslewski
COMPANY: Hoodman
CONTACT: 800-818-3946 or
310-222-8608, www.hoodmanusa.com
GOOD NEWS: Solidly built. Protects LCD.
BAD NEWS: Doesn’t block much light.

PRICE: $29.95
REQUIREMENTS: Nikon D70

theHotList
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REVIEWS

SHOPP
IN¬?
HERE’S
WH
RECOM AT WE
MEND

THE BEST OF THE BEST FROM RECENT REVIEWS

SOFTWARE

ONTH
NEW THIS M

Blizzard
World of
Warcraft

AUDIO
Ableton Live 4

$499.00

Jan/05, p43

Bias SoundSoap Pro

$599.00

Jan/05, p42

This top real-time sequencer now has improved MIDI powers.
Got noise in your video? Here’s the app to clean it up.

Native Instruments Reaktor 4

$559.00

Jun/04, p56

If you can imagine a sound, you can create it with this synth.

Aspyr Call of Duty

$49.99

Sep/04, p52

This shooter has tons of action, detailed locales, and fun.

Blizzard World of Warcraft

$49.99

Apr/05, p40

This rich online role-playing game is more addictive than nicotine.

Feral Interactive XIII

$55.00

Oct/04, p52

MacSoft Halo: Combat Evolved

$49.99

Mar/04, p38

It’s as awesome as your Xbox buddies say it is.

MacSoft Unreal Tournament 2004

$39.99

Jun/04, p48

The best ﬁrst-person shooter adds new vehicles and weapons.

GAMES

This mission-based shooter has an old-style comic book feel.

GRAPHICS & LAYOUT
Adobe InDesign CS

$699.00

Feb/04, p46

More features and easier navigation make layout a snap.

Adobe Photoshop CS

$649.00

Feb/04, p44

Just when you thought Photoshop couldn’t get better, it did.
Adobe’s affordable image editor gets a signiﬁ cant upgrade.

Adobe Photoshop Elements 3.0

Reviews Editor Roman
Loyola calls this massively
multiplayer online role-playing
game “one of the best games
we’ve played—ever.”

$89.99

Mar/05, p36

Corel Painter IX

$429.00

Feb/05, p38

This natural-media champ is now faster and more capable.

Macromedia Dreamweaver MX 2004

$399.00

Jan/04, p48

Our favorite Web-design tool adds improved CSS support.

Nik Multimedia Color Efex Pro 2.0

$299.95

Jan/05, p41

You’ll be amazed by this plug-in’s ﬁlters and darkroom effects.

Strata 3D CX

$695.00

Dec/04, p43

Whether you’re a 3D newbie or expert, this app’s for you.

Bare Bones Software BBEdit 8.0

$199.00

Jan/05, p36

By far the most powerful text editor money can buy.

FileMaker Pro 7

$299.00

Jul/04, p46

Microsoft Ofﬁ ce 2004

$399.00

Aug/04, p42

Adobe After Effects 6.5

$699.00

Sep/04, p46

This upgrade is strong enough to be called version 7.

Discreet Combustion 3

$995.00

Sep/04, p47

If you’re serious about video compositing, get this software.

$75.00

Feb/05, p39

Join the VJ ranks with this MIDI-capable video-mixing software.

Apple AirPort Express

$129.00

Oct/04, p48

This portable wireless router will stream your iTunes music.

Canary Wireless HS10

$59.95

Apr/05, p44

This device ﬁ nds hotspots and reports on network status.

Canon Optura Xi

$999.00

Aug/04, p38

High-end features distinguish this mid-priced camcorder.

MCE Technologies QuickStream DV

$729.00

Aug/04, p57

This rugged DV-encoding drive includes a hot-shoe mount.

Native Instruments Guitar Rig

$499.00

Nov/04, p40

Killer software plus a sturdy stomp box will wow any guitarist.

Sony DCR-HC20

$499.99

Aug/04, p36

This compact, inexpensive camcorder has great image quality.

Tivoli Audio iPal

$129.99

Nov/04, p50

You won’t believe the sound of this compact radio and speaker.

Canon PowerShot A85

$299.99

Mar/05, p40

This 4-megapixel point-and-shoot beauty takes great pictures.

Nikon D70 Digital SLR

$1,299.00

Jul/04, p50

It’s as close to perfect as any digital SLR camera we’ve seen.

PRODUCTIVITY & UTILITIES
A complete rewrite vaults this database into the big leagues.
Enhancements to every app add up to a worthy upgrade.

VIDEO & ANIMATION

Vidvox Grid2

Warchalker extraordinaire Noah
Tsutsui calls this Wi-Fi ﬁnder “a
great device both for ﬁnding
hotspots … and testing a home or
ofﬁce connection.”

HARDWARE

Canary
Wireless HS10

ACCESSORIES

AUDIO & VIDEO

DIGITAL CAMERAS

PRINTERS

ILY SlimDVDup
Roman Loyola says that this
standalone device makes CD
and DVD duplication
“almost effortless.”

Canon i560

$89.99

Sep/04, p28

Ninety bucks can buy an exceptionally capable photo printer.

Canon i860

$119.99

Sep/04, p29

This printer’s Photo Black cartridge makes color photos pop.

Canon i900D

$199.99

Sep/04, p31

Gorgeous prints, CD printing, color-LCD editing—all good stuff.
This ﬂ atbed handles both reﬂ ective and ﬁ lm scans with ease.

SCANNERS
Epson Perfection 2580

$149.00

Oct/04, p37

Epson Perfection 4180

$199.00

Oct/04, p39

Superior image quality earns this scanner our recommendation.

Microtek ScanMaker i320

$119.00

Oct/04, p35

Killer photo-rescue software comes with this affordable unit.

STORAGE
ILY SlimDVDup

$699.00

Apr/05, p45

Quickly duplicate CDs and DVDs without tying up your Mac.

LaCie Big Disk Extreme 500GB

$429.00

Aug/04, p55

Cutting-edge technology provides cutting-edge performance.
Cram 8.5GB of data onto DVDs with this speedy burner.

LaCie d2 DVD±RW Double Layer

$189.00

Feb/05, p48

OWC Mercury Pro DVD-/+RW

$129.99

Aug/04, p60

This speedy drive includes everything you need to start burning.

$1,299.95

Aug/04, p59

This internal 4-drive RAID makes a Power Mac G5 scream.

WiebeTech G5Jam 1TB
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because inquiring minds have the right to be inspired

CRAZY COLUMNS
Why, when I open a new Finder window
in column view, do the columns insist
on stretching out twice as long as
the longest title in the list? Mac OS X
should be smarter.
Column view is a great addition to the
Mac OS, but those columns can be
ornery. To reset the width to exactly
the width of your longest item, Optiondouble-click on the little vertical doubleline widget between columns at the
bottom of the window.

HOTMAIL
I was wondering how to use Hotmail,
Yahoo, or both with Mail. Can you help?
You can use Apple’s
ON THE
DISC Mail application with
these and other WebHTTPMail Plugin 1.42,
Mail Forward 2.4
based email services,
but it requires installing a plug-in called
HTTPMail Plugin (free, www.automagicsoftware.com). This plug-in lets you
conﬁgure a new account in Mail with the
HTTPMail protocol used by Hotmail and
Yahoo. You can also try an application
called Mail Forward ($15, www.sspisoftware.com) that lets you forward your
Hotmail or Yahoo mail to Apple’s Mail.

Use Mail to access your Hotmail or Yahoo
account.

A simple Option-double-click here can
remedy column-view woes.

STITCH IN NINE
Can I digitize images for use on a
commercial embroidery machine on
my Mac?
Sad to say, the Mac has pretty much
been squeezed out of this market.
There’s one viable option, but it’s a
little dated and a bit expensive: Textile
Technologies’ PowerStitch ($350,
www.textiletech.com). This pricey

It’s old and expensive, but PowerStitch is
still pretty cool.

I need a
cocktail!

DISOBEDIENT DESKTOP
The icons on my desktop never stay
organized correctly. How can I ﬁx this?
Sounds like your .DS_Store ﬁle, which
maintains locations of icons in the
Finder, might be corrupt. An app called
Cocktail ($14.95, www.macosxcocktail
.com) can help. Or you may simply have
52
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too many
icons on your
desktop; you
may need to move or delete some to
make your desktop behave itself.

PDF SKELETON KEY
How can I print or edit passwordprotected PDFs?
That depends on what exactly the
password is protecting. If the PDF
is locked so tight that you need a

app doesn’t work natively in OS X,
but it does ﬁne in OS 9 or the Classic
environment. And yes, it generates
industry-standard tajima ﬁles.

AMSCRAY!
I downloaded a software demo that
has since expired—now my Mac keeps
telling me it’s expired and prompts
me to click OK. I have gotten rid of
everything I can ﬁnd, but it won’t go
away. What gives?
To uninstall most software, simply
trashing the app and its folder is enough.
There are exceptions, however, including
system-level utilities such as the items
in System Preferences. To remove one
of these, Control-click the item’s icon
in the System Preferences window and
select Remove from the pop-up menu
that appears. Some more heinous
installations will set their applications
or helper applications to launch
automatically when you turn on your Mac
or log in. To check for these weasels, go
to System Preferences > Accounts and
look in the Startup Items pane. Highlight
any suspicious-looking items and click
the minus icon at the bottom.

Have you checked your Startup
Items lately?

password to even open it, then sorry,
no dice. If it’s simply locked against
editing or printing, you can use PDFKey
Pro (www.pdfkey.tk) to create an
identical, unlocked copy of your PDF.
This utility costs only €9.99 (about $12
at press time).

X-RATED APPS?
Can I limit what applications my kids
use on my Mac OS X computer?
Yes, as long as each has his or her own
individual login account. Then you just
set privileges in the Limitations pane of
System Preferences > Accounts.

DIFFICULTY
RATINGS

No whining—
anyone
can do this!

BENCHMARKER
Is there any software for Mac OS
X that I can use to benchmark the
performance of my computers?
Are you some kind of geek who needs
to ﬁnd out exactly which computer is
faster at every possible function? Well,
join the club! Get your geek on with
Xbench (http://xbench.com), a free
Mac OS X benchmarking utility that
has become a de facto standard for
testing Macs. There is even a Web site
(http://ladd.dyndns.org/xbench) where
you can post your results so that you
can compare your speed demon to other
folks’ speed demons. See if you can
beat our three-year-old PowerBook’s
score—a whopping 42!

EJECT!
Is there a way to open an optical drive
tray from the command line?
Sure is! The secret is the drutil command.
First, get a list of possible drives, both
internal and external, by typing drutil
list. If you have only one drive, type
drutil tray open to open its tray—oh,
and drutil tray close to (you guessed
it) close it again. If you have more
than one drive, you’ll need to add the
ID number from the list (drutil tray
open -1 or drutil tray open -2, for
example).

Open your CD tray from the command line.

It’ll take some
effort, but you
can do it.

UNIX UNIVERSITY
BE A BETTER BREAKER
What are Unix line breaks in a plain text ﬁle?
There are three different
Plain text ﬁles are unformatted ASCIIstyles for representing line
character ﬁles. This means they are
breaks: Unix, DOS, and Mac. Unix
stripped of all font, weight, and other
uses the LF (line-feed) character, DOS
formatting. Unix uses plain text ﬁles to
uses the CR (carriage-return) and LF
contain conﬁguration info that makes
characters, and the Mac just uses the CR
lots of important things happen. The only
character. Even the most straightforward
formatting these ﬁles use or understand
text editors, such as Apple’s TextEdit
is a command to separate one line from
(/Applications/TextEdit) and Bare Bones
another—think of it as a carriage return
Software’s TextWrangler (free, www
on a typewriter. Plain-text ASCII ﬁles
.barebones.com), can interpret any of
use a base of 127 different characters
these correctly, but it’s important to use
to represent everything, including how
Unix line breaks in your Mac OS X and
lines should break.
Unix conﬁguration text ﬁles. To make
sure your ﬁles use the Unix line breaks,
use a smart text editor such
ON THE
as TextWrangler, which lets
DISC
you specify which breaks to
TextWrangler 2.0
use in your ﬁle.
Do your text ﬁles break correctly?

DUPLEXING
Is there a way to organize my documents so
they can print on both sides of the page?
Your printer may not be able to physically
print on both sides of the paper in one
pass, but a simple technique can let you
do double-sided printing with a little
manual help. In the Print dialog, go to the
Copies & Pages pop-up menu and select
Paper Handling. Then check the box next
to Reverse Page Order and choose Even
Numbered Pages. Go ahead and press
Print to print these pages. After they’ve
printed, take the pages out of the printer
and put them back in the paper-input
ON THE

change any icon on
your system—even
CandyBar 2.0.1
the wily Trash icon.
Bonus: Iconfactory provides loads of
free icons that you can download from
its Web site.

DISC

tray, oriented so that the printer will print
on the blank side—the correct orientation
varies by printer. Bring up the Print dialog
again, select Odd Numbered Pages
(depending on how your printer spits out
pages, you may have to uncheck Reverse
Page Order), and print away.

SCROLL DIFFERENT
Can I use two-ﬁnger scrolling on my
PowerBook or iBook?
The newest PowerBooks sport a
scrolling trackpad, which allows you
to use a two-ﬁnger drag for scrolling.
Pretty slick, but what about those of us
with older ’Books? Good news: Most
aluminum PowerBooks and recent
iBooks have similar abilities buried in
their systems. Go to www-users.kawo2
.rwth-aachen.de/~razzfazz to get the
hack as well as a script you can run to
determine if your ’Book is capable.
Buz is a graphic designer living in
Florida. He has been a devoted Mac
user for over 10 years and has worked for
both Apple and Power Computing.

Set some limits for your users.

ICON DO IT!
I would love to customize all of my system
icons; is there an easy way to do this?
Try The IconFactory’s CandyBar ($12.95,
www.iconfactory.com), which lets you
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This stuff’s
for the pros.

Submit

CandyBar makes it simple to
replace any icon on your Mac.

technical questions
or helpful tips directly
via email (askus@macaddict.com) or c/o
MacAddict, 150 North Hill Dr., Ste. 40,
Brisbane, CA 94005.
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max out your Mac mini

Max Out Your Mac mini
by Niko Coucouvanis
WHAT YOU NEED
Mac mini
Nerves of steel

S

o you scraped up the couch coins and bought yourself
a Mac mini. Then, wouldn’t you know it, before you
even outgrow the 40GB hard drive, dear old Auntie Em
clocks out, leaving you a pile of cash—not enough for a
new Power Mac G5, but enough to upgrade the bejeezus out of
your Mac mini. You’re reading the right magazine, friend—that
is, if you’re either brave or foolhardy enough to crack open your
mini knowing full well that if you break anything, Apple’s gonna
charge you to ﬁx it.
If that’s OK with you, follow along as we pop the hood
and max out a mini’s RAM to 1GB, hop up the hard drive to a
honkin’ 100GB, and replace the combo drive with a full-on

Free your Mac mini’s inner monster.

SuperDrive—doubling the mini’s price in the bargain. If you
think the component upgrades are ridiculous, the icing on this
bundt cake (or is it a petit four?) is pure insanity: Against our
(lawyer’s) better judgment, we show you how to eek a bit more
speed out of the thing by poking the motherboard’s backside
with a hot stick—overclocking it!

Stage 1: Just Add RAM

WHAT YOU NEED

The mini’s stock 256MB of RAM is barely enough to run Mac OS X, much less any memoryhungry apps. We can remedy that with a 1GB DIMM ($219.99, www.crucial.com).
There’s nothing to it—once we bust into the case. Don’t forget to discharge
any static ﬁrst by unplugging all your peripherals from the mini; then,
before you unplug the power supply, touch the mini’s metal frame.

1

Crack Open the Case

OK, hacker, time to put your putty knife where your
mouth is. The target gap is extremely thin—if the blade
isn’t sharp, give it a little attitude adjustment with some
sandpaper. Grind the blade at about a 15-degree angle to the
ﬂat sandpaper, but don’t overdo it.
Lay the mini upside down and wedge the putty knife into
the gap between the plastic bottom and the metal frame—go
down about half an inch. You can’t see them yet, but little
plastic latches on the inner piece hook into a groove inside
the sidewall of the outer piece. Push the blade straight in,
and push out slightly on the putty knife’s handle to pry up the
inner piece. You should hear the latches pop as the pieces
start to separate. If the gap doesn’t stretch the length of the

A good, slim
putty knife slips
right into the
gap—if your
blade is too fat,
grind it down
with some
sandpaper.
54

May 2005

Putty knife with 1.5-inch
flexible blade ($1.98, Ace
Hardware)
Medium-grit sandpaper
Plastic pry stick or picnic knife
RAM: 1GB DDR PC2700 184pin DIMM ($219.99, www
.crucial.com)

mini’s side, hold the
gap with your thumb
while pulling the blade
out slightly (just far enough to clear the latches), and slide
the knife over to address the remaining latches. When you
free all the latches on one side, keep the gap open with a
ﬁnger or two while you give the same putty-knife treatment to
the other (facing) bottom edge. When you’ve freed the latches
along both sides and have a decent gap all the way around
the mini, hold the bottom piece (which is currently facing up
since the mini is still upside down) with its ports facing you,
and carefully angle the inner piece up out toward yourself. Set
the top section aside for now.
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2

Replace the RAM
Rip
the
If a RAM
jobResources
is all the upgrading you can stomach, relax—you’re

3

Close It Up—and Run Away Scared

almost there. If your mini has Bluetooth, you’ll have to move
the antenna; carefully pry it out of its slot, and rest it on top of the
optical drive. Try to bend the connecting wire as little as possible. Now
release the slot-locking tabs at each end of the RAM slot and remove the
existing DIMM. When inserting the new DIMM, make sure it’s PC2700
or greater (our mini came with a PC3200 DIMM) and try not to touch the
metal connector pins on the business end, nor any of the metal bits on
the module itself. Press the DIMM straight down into the slot until you
feel it snap into place. Congratulations! You just performed the easiest,
most effective upgrade ever. The only downside is that you now have a
leftover DIMM that you just removed
from the mini—we sold ours on eBay
Bust that Bluetooth
for beer money (a 256MB stick fetches
antenna out of the way, and
about $20).
your RAM is home free.

Bluetooth
Antenna

No peer pressure here, but if you’re thinking about calling it
a day after upgrading your mini’s RAM, you should probably
know that swapping in a bigger or faster hard drive and more
capable optical drive is child’s play at this point. C’mon, chicken.
No takers? Fine (bawk, bawk, bawk!). If you’ve got a Bluetooth
antenna, snap it back into place, slap the cover back on your
mini, and snap the cover shut; now plug
everything back in, ﬁre the mini up, and
Like limbs on a school
revel in the righteous speed boost you get
bus, keep your latches
from such a simple upgrade.
inside the case.

Stage 2: Upgrade Your Drives
Want more storage capacity? How does 100GB sound? Need
more speed? A 7,200-rpm drive will help. Want to burn DVDs?
Add a SuperDrive. Before you dig in, though, know that the
mini’s hard disk and optical drive both ride along in a removable
subframe that has a few little booby traps: The mini’s power-

1

button wires are inexplicably taped to the subframe, and if
you have AirPort and Bluetooth preinstalled, you’ll have two
antennae to remove from the subframe. If you don’t have
preinstalled wireless,
skip ahead to step 3.
WHAT YOU NEED

Free the AirPort Antenna

The AirPort antenna wire runs the length of the mini’s backside, right behind the optical
drive. Use a ﬁngernail or hard plastic stick (we used a plastic picnic knife) to push the
release latch as shown in the photo below (top right). Before pulling the antenna up too far,
follow the wire back until you ﬁnd where it’s taped to the frame. Carefully remove the tape and
pull the antenna and its connecting wire up and out of the way. Note that it’s still connected to
the board beneath the frame, so handle with care.

Jewelers #0 Phillips
and Jewelers #2 Phillips
screwdrivers
Plastic pry stick or picnic knife
SuperDrive: Pioneer
DVR-K04 Dual-Layer SlotLoading Drive ($159.99, www
.macsales.com)
Hard Drive: 100GB Seagate
Momentus 5,400-rpm Ultra
ATA/100 ($239.99, www
.macsales.com; $199, www
.newegg.com) or 60GB Hitachi
Travelstar 7,200-rpm Ultra
ATA/100 ($175.97, www
.macsales.com; $155, www
.newegg.com)
Remove the AirPort antenna from the
subframe, but leave it connected to
the board underneath.
May 2005
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max out your Mac mini

2

Bypass the Bluetooth

3

Swap In a SuperDrive

4

Protect the Power

5

Free the Frame

Find the Bluetooth antenna on the corner opposite
the AirPort antenna (above the RAM). There’s no
latch; just carefully pry the antenna up out of its slot in the
plastic rail. Before pulling it up too far, follow the wire back
until you ﬁnd where it’s taped to the subframe. Remove the
tape, and carefully pull the Bluetooth antenna and its wire up
and out of the way. Like the AirPort antenna, the Bluetooth
antenna remains connected to the board under the subframe,
so just move it out of
the way; don’t remove
Leave the Bluetooth antenna
it completely.
connected to the lower board.

Six screws secure the optical drive; two each on the left and
right sides and two more securing its data and power ports
to the interconnect board. Remove all six screws as indicated in the
photo and put them somewhere safe; don’t be ashamed to label
them. Using your plastic stick, carefully pry the drive away from the
interconnect board; when you get them separated, slide the drive
out the front of the frame, away from the interconnect board.
Now just slide in the replacement drive and carefully plug it into
the connector on the interconnect board. Replace the screws. If
you’re into the idea of upgrading the hard drive and upping the
clock speed, read on. Otherwise, reverse the prior directions to
replace the frame, reattach the antennae (if you’ve got ’em), and
slap the lid back on your mini. If you ﬁre
up your mini and it doesn’t recognize
The six screws you need to
the new SuperDrive, use PatchBurn
remove are hiding on the
(free, www.patchburn.de) to install the
sides of the drive where
appropriate device drivers.
the circles indicate.

The mini’s power button isn’t connected
to the subframe, but the wire connecting
that all-important button to the motherboard is.
If you pull out the frame without freeing that wire,
you’re likely to wreck the delicate motherboard
connector and probably the power button as
well—and you’d be rightly cheesed off at us.
Carefully remove the
tape that’s securing
Make sure to remove this
the power-button wire
tape, but leave the power
to the frame.
plug in place—for now.

Find and remove the subframe’s
three securing screws (left) and set
them somewhere safe. Label them if you’re
forgetful or paranoid. Before lifting out the
subframe, gather the Bluetooth and AirPort
antennae and notice how their connecting
wires snake through the slot at the edge
of the subframe. Carefully guide both
antennae through the slot as you lift the
subframe straight up and out.
Mind the antennae as
you lift out the frame.
56
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6

Hijack the Hard Drive

7

Watch Those Wires!

To get at the mini’s hard drive, ﬂip the subframe over and lay it
optical-drive-side down. Four screws secure the hard drive—two
each on the right and left sides—but ﬁrst, you’ll need to get that fan out
of the way. Remove the fan’s three screws and stash them, then ﬂip the
fan up out of the way and remove both drive-mounting screws on that
side. Two things about the screws on this side: You may need an angled
or very short screwdriver to get them; and
whatever you do, don’t remove the tape from
Flip up the fan to reveal
the little hole in the frame—it’s crucial to the
the hidden drivemini’s cooling.
mounting screw.

Before removing the other two screws, carefully untape the wires that are secured to the
drive’s circuit board—they feed the fan and speaker—and carefully unplug them from the
interconnect board. Pull the plug, not the wires! Pry with the
plastic stick if you need to. Now remove the hard drive’s other two
mounting screws. Take your trusty plastic stick and carefully pry
the drive off the interconnect board. Note that the connector is part
of the board, not part of the drive: Make sure to pry from the drive
side. When you free the drive from the connector, slide the drive
out away from the connector and slide in the new one. Be careful
plugging the new drive in—the pins bend easily if misaligned.
Return the screws, replace the fan and speaker wires (don’t forget
to plug them in), and you’re done.

We know it’s difﬁcult, but
pull the plug, not the wires.

D’oh! My Data!
If you don’t want to start fresh with your mini’s new hard drive, make sure to back up the
contents of your original drive before removing it. Use Disk Utility (/Applications/Utilities)
to create a disk image of the mini’s drive and save the image to an external FireWire drive.
When you get the mini’s new drive installed, boot off the
mini’s software install CD, launch Disk Utility from the
Back up and restore your
menu bar (Installer > Disk Utility), and use the Restore
old system if you don’t want
function to rebuild your old system on the new drive.
to start from scratch.

Stage 3: Overclock the Lil’ Sucker
The ﬁnal step of this mini-maxing is by far the skankiest.
You haven’t yet done anything explicitly warranty
voiding—but that’s about to change. Now it’s time to send
away the children and pacemaker-wearers; we’re gonna
rip out the mini’s motherboard and perform microresistor
surgery to push a 1.25GHz mini up to a no-nonsense
1.5GHz speed—a net gain of 250MHz. Or we’ll just kill it.
Grit your teeth now, this might sting a bit.

1

If you’ve never done any
soldering, now’s not the
time to learn. If you slip up
even the teeniest, tiniest
amount when performing
this stage, you run the very real risk of
fatally frying your lovely new mini—and
don’t come crying to us if you do.

WHAT YOU NEED
Jewelers #0 Phillips
screwdriver
Plastic pry stick or picnic knife
Low-heat soldering iron
Eagle eyes
Your head examined

Move the Mezzanine

If your mini has preinstalled Bluetooth and AirPort, remove the two screws
on the mezzanine board as indicated in the photo, and pull the board
straight up to remove it. Make sure your Bluetooth and AirPort antennae remain
attached.
Now remove the lone screw holding down the motherboard. As you can see in the
photo, it’s near the RAM and mezzanine connectors. What you
can’t see in the photo is that this screw is nearly (but not quite)
Remove three
identical to the screws you took out of the subframe—keep an
screws to free up
eye on this one after you remove it.
the motherboard.

There are two
screws here!
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max out your Mac mini

2

Bust Out the ’Board

3

You May Solder When Ready

Now it’s time to unplug that power-button lead we untaped from the frame
while displacing the drives. Find it hiding behind the processor heat sink in
the back corner near the power button. As always, pull on the plug, not the wires;
use your plastic pry stick if you need help. The mini’s status LED is also plugged
into the motherboard, up in the front-right corner. Once you unplug the LED, notice
the LED assembly is mounted on the mini’s
bottom piece. Gently bend the LED assembly
a wee bit out and away from the motherboard
to make a little clearance room, then angle
the board up and out, away from the rear-side
ports. Lay the
board on your antiAs tough as it is to avoid
static operating
breaking these wee plugs,
table (no metal
it’s even tougher to ﬁx
tables, please)
them. We reiterate: Pull
and go scrub up
the plug, not the wire.
for surgery.
Carefully!

OK, tough guy, time to show some mettle—actually lead, rosin-core solder. Locate the
resistors labeled R362, R358, R355, and R351 (they’re behind the processor, more or
less); plug in your soldering iron; and say three Hail Marys for each MHz you’re trying to gain.
Look at the weensy little resistors; now study the PLL (phase-locked loop) multiplier chart
below (“Chill PLL”)—notice that for some speeds, namely 1.5GHz, you simply remove all
of the resistors—relatively easy. And if things go horribly wrong and you have to
return a resistor to its original place, here’s a little secret: The resistors
are of such low ohmage, you can just drop a solder booger in place
of the resistor (and if you don’t know what ohmage is, you have no
business performing this hack). If your glob of solder is touching
both pads, then you just made a resistor—if you’re lucky.
Once you get the speed conﬁguration you want,
reassemble the mini, cross your ﬁngers, and ﬁre it up. If
your solder fu is strong, the mini will roar to life, and you’ll
be able to see your new, faster clock speed in Apple Menu
> About This Mac. If the solder gods are angry, your mini
will just sit there like a recalcitrant lump-o-’lectronics.
Before you begin weeping inconsolably, double-check your
solder work—if it’s dirty, clean it up to make sure you haven’t
inadvertently left part of the PLL circuit closed with solder; if
it’s clean, reconﬁgure your resistors for a lower clock speed and
try one more time.

We’re using this
crapola soldering iron
because our solder
fu is strong. If yours
isn’t, turn back now,
or get yourself a good,
sharp-tipped, low-heat
soldering iron.

Chill PLL
Use this handy table to conﬁgure your resistors. We chose the path of least resistance,
removing all of the resistors for a speed of 1.5GHz.

SPEED

R362

R358

R355

R351

1.25GHz

•

•
•

•

x

x

x

•

x

1.42GHz

x

1.5GHz

x

1.58GHz

x

• = resistor in place

x

•
x

x

x = no resistor

Niko “Hacksaw” Coucouvanis is pleased as pudding that this upgrade worked, but kinda peeved that he spent more on upgrade parts than on
the mini itself.
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Convert PC Video Files to QuickTime
by Johnathon Williams
WHAT YOU NEED
Mac OS 10.3 or later
Forty-Two DVDVX Plus ($14.99, www.kaisakura.com)
QuickTime Pro ($29.99, www.apple.com/quicktime)

W
1

Install Converter and Support Files

3

Clean Up with QuickTime Pro

Our workhorse for conversions is Forty-Two DVDVX
Plus—grab it off the Disc or download it from www
.kaisakura.com and drag it to your Applications folder. On first
launch, Forty-Two DVDVX Plus presents its Setup Assistant. Click
Continue until you get to the Software And Components Check
window, which prompts you to install five additional packages.
Four are codecs (software for coding and decoding different
types of video), and one is a stand-alone movie player. You’ll
need them all.
Now click the Install
Remaining button. You’ll be
asked to approve some of
the installations as they’re
downloaded. When you click
the final Continue button
in the Setup Assistant, yet
another installer window will
Installing Forty-Two DVDVX Plus
open. This one is for DivX,
is only half the battle. For more
another popular codec—
converting power, install the
install it as well.
helper packages, too.

Our converted file is now a QuickTime-compatible AVI
encoded with DivX. Purists, however, won’t rest until
they’ve got a native QuickTime movie with a matching .mov
extension. To make it so, open the converted file in QuickTime
Pro and select File > Export. From the Export drop-down menu,
select Movie To QuickTime Movie. Click Options to select codecs
for video and audio. MPEG-4 offers terrific quality and good
compression, but you may choose whatever codec you like.
You’ll probably need to experiment with these settings to find
the best balance between quality and file size.

If you can’t beat ’em, convert ’em. Turn those PC video formats
into files that play nice with QuickTime.

2

Choose an Encode Setting

Drag the icon of the file you want to convert from your
desktop into the square pane at the top left of Forty-Two
DVDVX Plus’s main window. The bottom pane contains a list of
video presets. The one that we’re interested in is QDVD, which
produces a QuickTime-compatible AVI file. Click it.
The QDVD preset works best on files with large video
resolutions (400 pixels wide or more); conversely, it tends to
resample small-size movies to the preset’s default width of 640
pixels, which can leave them pixelated and quite ugly.
To preserve your original resolution, click File > Advanced
Options. In the drawer that
appears, click the Custom Width
check box and enter your video’s
width. Then, click the check
box next to 2-Pass Encoding.
Finally, click Start to begin the
conversion. Even with these
precautions, the resolution may
It’s a good idea to specify a
still change. If that happens, see
custom width for movies less
step 3 to restore it.
than 400 pixels wide.

Converting, like translating, is an art, not a science. If your video
comes out grainy, adjust your encoder settings in QuickTime.
May 2005
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Johnathon Williams is composing a set of lyrical ballads
about the transcendental beauty of QuickTime. Really.

MV, AVI, ASF—the alphabet soup of Mac-incompatible
video formats can be a vile stew. Doubly so when a
video clip that you really, really want to see is only
available in one of these foreign formats.
Here, we show you how to convert these file types to more
QuickTime-friendly formats. This method isn’t infallible—the
output can be a bit unpredictable, and files in
ON THE
the latest Windows Media Player format can
DISC completely choke the process—but it’s almost
Forty-Two DVDVX Plus 2.4
always worth a shot.

60
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put Linux on your iPod

Put Linux on Your iPod
by Alex Handy
WHAT YOU NEED
First-, second-, or
third-generation iPod
Mac running OS 10.3 or later
iPodLinux (free, http://ipodlinuxinstl
.sourceforge.net)

ON THE

DISC
iPodLinux 0.3

Despite what nature shows
say, penguins love Apples—
especially in conﬁned spaces.

uccessfully installing and running the Linux operating
system is considered a badge of honor among the
peecee nerderati. You can do them one better,
however, by using iPodLinux to install Linux on an
iPod. Instant geek cred! After that, you’ll be able to use Linux

S

to turn your ’Pod into an ad-hoc voice recorder. Download the
iPodLinux installer from http://ipodlinuxinstl.sourceforge.net
or grab it off this month’s Disc—but note that iPodLinux doesn’t
currently work on the latest iPods (shufﬂe, mini, photo, and
clickwheel models). Now let’s geek out!

1

2

Back It Up, Jack

Installing Linux on your iPod is easy-cheesy, but you’d
be wise to back everything up—just in case. First, plug
in your iPod; if it doesn’t automatically mount on the desktop,
launch iTunes and open iTunes > Preferences. In the iPod section,
click the box labeled Enable Disk Use. Now launch Disk Utility
(/Applications/Disk Utility), select your iPod, and click the New
Image icon or select Images > New > Image From Disk. Save the
disk image ﬁle somewhere safe on your Mac. You could skip
this step—but if things go downhill in the next two steps, you’ll
probably regret it after your iPod eats all of your music and won’t
do anything other than ﬂash the question-mark folder at you.

Gentlemen, Start Your Linux

With your iPod plugged into your Mac, double-click the
iPodLinux installer. Agree to the terms of use and click
the Install button. When the installation ﬁnishes, drag the iPod
icon from your desktop to the Trash to eject the iPod. Unplug the
data cable, and hold down both the select and menu buttons for
ﬁve seconds to restart your iPod.
On reboot, your iPod will display the usual Apple logo and
then brieﬂy show Tux, Linux’s penguin mascot, before settling
into the regular old Apple iPod interface. To boot into Linux,
restart the iPod, but hold the back-arrow button as the iPod
boots. This drops you into Podzilla, the iPodLinux interface.

Create a disk
image for
backup—just
in case.

Unlike installing Linux
on a desktop machine,
installing Linux on an iPod
is push-button easy.

Podzilla functions almost exactly like the regular iPod
menu system, more or less. Under Music, you can
browse tunes by album, artist, or song, but not by playlist—
iPodLinux doesn’t yet support iTunes playlists. No biggie—just
boot into Apple’s interface to listen to music. iPodLinux does,
however, support the OGG music format, which Apple does not.
The real reason to use iPodLinux is to record audio ﬁles (WAV
only) without a microphone converter. Connect your iPod to your
Mac in disk mode, then create a new folder named Recordings
at the iPod’s root level. Eject and disconnect the iPod, boot it
into Linux, and navigate to Extras > Record. At the bottom of the
screen, you’ll see that the default recording quality is a crappy
8KHz, but iPodLinux lets you crank that up to a healthy 96KHz.
To record, plug a microphone into the iPod’s headphone jack. No
mic? Your left iPod earbud doubles as a mic in a pinch.
Unfortunately, iPodLinux’s WAV playback is extremely crash

prone, so you should download recordings from the iPod
(/Recordings) to your Mac and listen via iTunes or QuickTime
Player. There’s a lot more you can do with iPodLinux, such as
play FLAC sound ﬁles and connect to the iPod via telnet for
command-line fun. Check out www.ipodlinux.org for all the
details on this evolving operating system.

3
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Tool Around in Podzilla
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Like any Linux ﬁrst-timer, you’re now wondering,
“What was the point of this exercise?”
Alex Handy is a crusty old Mac geek who is now made entirely of tin.
He blogs at www.gism.net/blog.
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Use Skype to Chat While Gaming
by Chris Barylick
WHAT YOU NEED
Mac OS 10.3 or later
Broadband Internet connection
Built-in or external microphone (headset recommended)
Skype 1.0 (free, www.skype.com)

I

2

Set Up Your Skype and Chat

ILLUSTRATION BY CHRISTINA EMPEDOCLES

1

Level Out Your Sound

Adding voice chat to games brings intrateam communication—and
interteam trash talking—to fun new levels.

Skype is a free VoIP (Voice over IP) app that allows users to converse in real time over the
Internet—Mac, PC, whatever, as long as the computer is running Skype. Beyond that, you
just need your Mac’s built-in mic and speakers, although a headset helps keep things to yourself.
Since Skype runs alone as a background app, you can use it to chat in any multiplayer game.
Grab Skype off this month’s Disc (or download it from www.skype.com), double-click the
Skype_1.0.0.0.dmg file to mount the image, and then drag Skype to your Applications folder.
Before you start your chat-a-thon, plug in your mic (or headset), open System Preferences,
Tweak your input level to squelch
and go to the Sound pane. Click the Input tab and click on the audio source you’re using. Test
squeal or gain some gain.
your mic level by speaking into the mic while watching the onscreen Input Level indicator.
Adjust the Input Volume slider (if necessary) until the peak level is around the middle of the scale. If your gaming setup includes big
speakers, you may need to spend time tweaking your input level to find the sweet spot between inaudibly low and blowout high.

Before chatting, you’ll need to create a Skype account in order to contact other Skype
users. Launch Skype and follow the prompts to set up a new account; enter a user name,
password, and email address. Once you’re done, click the Add button to start adding your pals’
Skype user names to your Contacts list—obviously, this step only works if your pals have already
installed Skype and told you their user names. This would be a good time to make a test call to
one of your friends to make sure everything’s kosher with the connection; plus, it’s easier to finetune your input level if you’ve got a helpful ear on the other end. To initiate a call, just doubleclick a name in your Contacts list.

3

Sorry, chief—the best Skype user
names are already taken.

Get Your Game On

When you’re done with the test call, click Hang Up. To initiate a conference call for up
to five simultaneous users, click Conference or select Call > Start Conference Call from
the menu bar to summon the Start Conference window. Select a contact you want to invite to
the session, click Add To Conference, and then do the same for three more contacts. When
your Conference Participants list is full (you plus four others for a total of five), click the Start
Conference button; your Mac will make a ringing noise as the recipients accept the calls. Go
ahead and start yakking to make sure the connection is good. Once the conversation is in full
swing, leave Skype running and open your multiplayer game of choice, log into a game server, See, conference calls don’t have to be
and marvel as the conversation continues unabated.
boring and stupid.
May 2005
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C hris Barylick’s Chicken Dance of Victory is widely known
and feared, especially in bastions of good taste.

n-game chat is great for coordinating team strategy and
taunting opponents. The problem is that it’s generally more
trouble than it’s worth—fraught with connection problems and
a general tendency to slow down gameplay for one reason or
another. What you need is a stand-alone voice-chat application to
run innocuously in the background while you
ON THE
your game on. Skype is that application—
DISC get
and here’s how to set it up to add a little human
Skype 1.0
interaction to your online gaming.
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1-800-951-9632

Customer Service:
718-338-3028
Local & International: 718-338-1800
24 Hour Fax Hotline:
718-338-3029
Email: info@bwayphoto.com

We specialize
in Overnight Delivery.
Place Your Order by 7:00 PM EST
and Receive Your Order by
the Next Business Day!

Hours: Mon-Thurs: 9:00am-9:00pm • Fri: 9::00am-4pm • Sun: 9am-7pm • Sat: CLOSED

• 21 Day Satisfaction
• Next Day Air Available
• Worldwide Shipping
• No Surcharge on Credit Cards
• Government & School PO’s Accepted

For an Additional
$29.95

Visit our website at: www.broadwayphoto.com
DIGITAL CAMERAS

NEW!

NIKON Coolpix 8800

NIKON Coolpix 8400

649

CANON GL-2

NIKON D2H

• 8.0 MegaPixels
• 10 Opt/4x Dig Zoom
$
99

• 8.0 MegaPixels
• 10x Opt/4x Dig Zoom
$
99

DIGITAL VIDEO

519Coolpix 5600 ...........$224.99

1649

146999

NEW!
NEW!
NEW!
NEW!

• 6.1 MegaPixels
• 1.8” LCD Screen
$
99

• 10x Opical Zoom
$
99

• 8.0 MegaPixels
• 5x Opt/3x Dig Zoom
$
99

C-765 ....$279.99 D-425 .....$129.99
D-545Z ..$169.99 D-595Z...$229.99
D-630Z ..$249.99 IR-300 ....$289.99

C-5060 ...$399.99 C-5500 ...$269.99
C-60 .......$249.99 C-70Z .....$409.99
C-7000 ...$419.99 C-7070 ...$539.99

NEW! OLYMPUS C770
• 4.0 MegaPixels

NIKON D70

309

649

D100 ..................................$879.99
NEW! D70 Kit ......................$849.99

OLYMPUS Evolt E-300 NEW! PENTAX *IST-DS
• 5.0 Million Pixels
• 1x Opt./1x Dig Zoom
$
99

• 6.1 MegaPixels CCD
• 2.0” LCD Screen
$
99

E-1 ........................................$799.99
NEW! Stylus 500...................$289.99
NEW! Sty Verve Dig (R/S/W). ..$229.99
NEW! Sty Verve Dig S. ...........$279.99

*IST-D ................................$849.99
MX4 .......$219.99 OPT X ...$289.99

699

SONY DSC-F828

• 1.8” LCD Screen
• 4x Dig./7x Opt. Zoom
$
99

609

DSC-S40..............................CALL
DSC-S60..............................CALL
DSC-S90..............................CALL
DSC-F88 ..........................$249.99

SONY DSC-T3

NEW!

• 5.1 MegaPixels
• 2x Digital Zoom
• 2.5” LCD Screen
$
99

SONY Mavica CD-500

409

CD-350 ...............................$289.99
FD-200................................$249.99

CANON DIGITAL REBEL KIT
• 6.3 Megapixel CCD
• 1x Opt./1x Digital Zoom
$
99

279

CASIO EX-Z55

289

SD300.......$289.99
SD500.......$409.99
S60 ...........$319.99
S1-IS ........$269.99

1699

MINOLTA Dimage A200 NEW! MINOLTA Dimage Z5
• 5.0 MegaPixels
• 12x Optical Zoom
$
99

E50 .......$249.99
X50 .......$239.99

CANON EOS 20D
• 8.2 MegaPixels
• 1.8” LCD Screen
$
99

NEW!

NEW!
NEW!
NEW!
NEW!
NEW!

XL-2.................$3299.99
ZR-100 ..............$289.99
ZR-200 ............. $319.99
ZR-300 ..............$359.99
ZR-400 ..............$389.99

JVC GZ-MC200

• 2.12 MegaPixels
• 10x Optical Zoom
• 200x Digital Zoom
• 1.8” Color LCD
$
99

NEW! GZ-MC100.........$619.99
NEW! GZ-MC500.............CALL
GR-DX77 .....................$319.99
JY-HD10U ..................$1949.99
GY-DV300..................$1549.99
GY-DV5000................$3699.99

339

249

Z2 .........$259.99 Z3.......... $299.99
Z10 .......$189.99 Z20........ $249.99
NEW! Maxxum 7 Digital .....$1099.99

• 5.0 MegaPixels
• 12x Optical Zoom
$
99

409

FX-2..........$249.99
FX-7..........$329.99
FZ-5..........$359.99
LC-1..........$699.99

• DLP
• 1600 Max Ansi Lumenss

839

$

99

EPSON Powerlite S1+
• 3x .5” LCD
• Digital Zoom
$
99

849

LP-120 .......................$1399.99
LP-70+ .......................$1299.99

Powerlite 730-C .........$1979.99
Powerlite 61-P............$1159.99
Powerlite 81-P ...........$1529.99

CANON FS4000

NIKON LS50

SCANNERS
• 5888 x 4000 pixels
• 4000 DPI Optical
Resolution
• USB

46999

$

NEW!

• HIgh Quality
CCD Sensor
• 4000 DPI Optical
Resolution
$
99

489

BENQ PB7210

• 2200 Max Ansi Lumenss
• DLP

94999

$

164999

GR-D250 ...........$279.99
GR-D270 ...........$289.99
GR-D295 ..........$319.99
GR-DF430 ............CALL
GR-DF450 ............CALL
GR-DF550 ............CALL
GR-X5 ...................CALL

NEW!

61999

SONY DCR-PC350

PANASONIC PV-GS250

PANASONIC AG-DVX100A

•
•
•
•

3.0 MegaPixels
10x Optical Zoom
2.5” LCD Screen
BLUETOOTH

• 3.1 MegaPixels
• 2.5” LCD Screen

NEW!

64999

$

819

NEW! PV-GS16 ...........$339.99
NEW! PV-GS19 ...........$299.99
NEW! PV-GS31 ...........$329.99
NEW! PV-GS35 ...........$389.99
Special! PV-GS55 ........$349.99
NEW! PV-GS65 ...........$449.99
NEW! PV-GS150 .........$499.99
NEW! PV-GS400 .........$879.99
SV-AV50A ....................$249.99

NEW! DCR-PC55 ........$589.99
DCR-PC109 .................$509.99
NEW! DCR-PC1000 ....$929.99

•
•
•
•

3-CCD Imaging
Super VHS
12x Optical Zoom
IEEE-1394

229999

$

99

AG-DV2500 ...............$1279.99
AG-DVC200 ...............$2649.99
AG-DVC7 .....................$749.99
Special! AG-DVC30 ...$1349.99
NEW! AG-DVC60 ......$1749.99
NEW! AJ-HDX100 ...........CALL
NEW! VDR-M54...........$449.99
NEW! VDR-M55...........$529.99
Special! VD-RM70 .......$504.99
NEW! VDR-M75...........$569.99
NEW! VDR-M95...........$669.99

TELEVISIONS
JVC LT-32X585

NEW!

PANASONIC TH-42PA20
• 42”
NEW!
• HDTV

TH-42PX25 ................$3599.99
TC-26LX20 ................$1699.99
TH-50PX25U .............$4699.99

NIKON Super Coolscan LS-5000

EPSON Stylus 2200P

EPSON Stylus 1280

NEW!

10x Optical Zoom
120x Digital Zoom
3.5” LCD
1.0 MegaPixels

NEW! DHR-1000 .......$2979.99

PD-42WX84 ...............$3349.99
LT-26WX84 ................$1599.99
HD-52Z575 ................$2399.99

86999

SONY DCR-DVD301

Special! DSR-PDX10.$1499.99
Special! DSR-PD170 .$2399.99
NEW! DCR-TRV280 ....$264.99
NEW! DCR-TRV480 ....$304.99
NEW! HDR-Z1 ...........$4049.99

PB 6100 .......................$849.99
PB 7230 .....................$1699.99
PB 8220 .....................$1549.99

$

DCR-HC21 ........$339.99
DCR-HC32 ........$399.99
DCR-HC42 ........$459.99
DCR-HC90 ........$709.99

NEW! DCR-DVD7........$549.99
NEW! DCR-DVD92......$489.99
DCR-DVD101 ..............$469.99
NEW! DCR-DVD103....$529.99
DCR-DVD201 ..............$579.99
NEW! DCR-DVD203....$569.99
NEW! DCR-DVD403....$689.99

$

• 4,000 dpi Optical Res.
• 2x-linear CCD
• Multiple film format

NEW!

$

• 32”
• HDTV
• W-XGA LCD
$
99

150999

NEW!
NEW!
NEW!
NEW!
•
•
•
•

274999

VIDEO PROJECTORS
IN FOCUS X2

• 12x Optical Zoom
• 150x Digital Zoom
• 2.5” LCD

$

NEW!
FX-5 ....$249.99
FZ-4 ....$329.99
FZ-15 ..$349.99
LC-80 ..$264.99

69999

SONY DCR-HC1000

200x Digital Zoom
10x Opt. Zoom
3.5” Color LCD
USB

• 12x Optical Zoom
• 3.5” LCD Screen

• 12x Optical Zoom
• 2.5” LCD Screen
$
99

$

FP 3100....$199.99 FP F440 ...$219.99
FP A345 .......CALL FP A350 .......CALL
FP F10 .........CALL FP Z1 ...........CALL

Optura 30.....................$449.99
NEW! Optura 50 .........$549.99
NEW! Optura 60 .........$609.99
NEW! Optura 400 .......$589.99
Optura XI .....................$719.99

SONY HDR-FX1

SONY DCR-VX2100 NE
W!
• 48x Digital Zoom

NEW!

DX6490 . $279.99 DX-7630 ...$249.99
EZShare 1 . . CALL EZShareC300 .CALL
EZShareC340CALL EZShareZ730..CALL
EZS- Z7590 ...........................................CALL
DCS - Pro SLR C / N......................$2949.99

Elura 65 .......................$369.99
Elura 70 .......................$419.99
NEW! Elura 80............$389.99
NEW! Elura 85............$419.99

NEW!
NEW!
NEW!
NEW!
NEW!
NEW!
NEW!

2.3 MegaPixels
10x Optical Zoom
200x Digital Zoom
2.5” LCD Screen

$

$

EOS 1D II ...........................$3149.99
EOS 1DS II.........................$6499.99
EOS 1DS ............................$5099.99

KODAK DX7590

$

•
•
•
•

749

CANON OPTURA 500 NEW!
•
•
•
•

JVC GR-HD1

NEW!

1809

1049
EOS 20D Kit .......................$1119.99

NEW!

49999

NEW!PANASONIC DMC-FZ20 (K/S)

369

X31.........$139.99
G600 ......$219.99

DSC-P73......$189.99
DSC-P93......$239.99 DSC-P150 ...$339.99
DSC-H1............CALL DSC-W1.......$259.99
DSC-W5.......$299.99 DSC-W7...........CALL

• 4.0 MegaPixels
• 10x Optical Zoom
$
99

EX-P700..$389.99
EX-Z50....$239.99 FP E500 ...$174.99 FP E510 ..$199.99
EX-Z750......CALL FP E550 ...$249.99 FP A340...$149.99
QVR-62 .......CALL FP S20 Pro.....$409.99 FP S2..........$1049.99

509

NEW!

FUJI Finepix S5100

• 12.3 Mega Pixels
• 2.0” LCD
NEW!
$
99

• 8.0 MegaPixels
• 7x Optical Zoom
$
99

SONY DSC-P200

• 5.4 MegaPixels
• 10x Opt./3x Dig. Zoom
$
99

NEW! FUJI FinePix S3

• 5.0 MegaPixels
• 3x Opt./4x Dig. Zoom
$
99
EX-P505 .....CALL
EX-S100 .$239.99
EX-Z57 .......CALL
QVR-61 ..$259.99

CANON PowerShot S500

SD200....$219.99
SD400....$319.99
S410 ......$249.99
S70 ........$359.99

S5N ...........CALL
S5i .........$259.99
WP ............CALL

319
DSC-P41......$154.99

• 5.0 MegaPixels
• 3x Optical Zoom
$
99

A95 .....$249.99.
A400 ...$579.99
A520 .......CALL

50...............CALL
S50 ........$204.99
SV ..........$299.99

• 7.2 MegaPixels
• 3x Optical Zoom
$
99

• 4.0 MegaPixels
• 2.5” LCD Screen
$
99

• 7.1 MegaPixels
• 4x Optical Zoom
$
99

469

NEW!

399

Rebel Digital XT.....................$749.99
Rebel Digital .........................$549.99
SD20 ......................................$269.99

A85..........$194.99
Pro 1 .......$579.99
A510........$159.99

PENTAX Optio 750Z

609

DSC-L1.....$244.99 DSC-M1 . . $409.99
DSC-T11 ..$304.99 DSC-T33. . $329.99
DSC-V3 $449.99 DSC-T1 . $309.99

CANON PowerShot G6 NEW!

NEW!

549

• 7.0 MegaPixel CCD
• 8x Dig./5x Opt. Zoom
$
99

649

304

NEW! D2HS ..........................CALL
NEW! D2X.......................$3699.99

OLYMPUS C-8080

• 1.33 MegaPixels
• 20x Optical Zoom
• 2.5” LCD Screen

$

NEW! Coolpix 4600 ...........$174.99
Coolpix 5400 ......................$319.99
Coolpix 8700 ......................$499.99

Coolpix 5900 ...........$279.99
Coolpix 7600 ...........$309.99
Coolpix 7900 ...........$329.99

CANON ELURA 90

• 20x Optical Zoom
• 100x Digital Zoom
• 2.5” LCD Screen

• SLR Type Dig. Camera
• 5.47 MegaPixels
• Uses Nikon AF-D/I/S Lenses
$
99

2099

$

2499

99

SHARP LC-37HV4U
• 37”
• Aquos Liquid
• TFT Active Matrix
$
99

3199

LC-30HV4U ...............$1949.99
LC-20E1U ....................$649.99
LC-20B4U ....................$699.99

PRINTERS

• USB/Serial Port
• PC or Mac
• 6 Color Small
Archival Links
$
99

539

NEW!

• Smudge Free Inks
• PC or Mac

39999

$

NEW!

NEW!

OLYMPUS
P440

NEW!

• Dye-Sublimation
• 1.8” LCD
• USB

379

LS-8000 .....................$1909.99
$
99
LS-4000 .......................$899.99
Stylus 3000 ................$1179.99
Policy: Visa, Mastercard, Discover, American Express, Diners Club, Money Orders, Certified Check, (Personal Checks up to 14,000.00 with name and address imprinted on check). C.O.D. orders are also accepted. Orders by mail please
print name address and phone number clearly. Shipping methods - in the Continental U.S.A. will be via Fedex, U.P.S. or Air Mail. Over size items via truck. Shipping and Handling are additional. 21 days for return or exchange (video & digital 7 days) with prior authorization only. (Call customer service for authorization number). Shipping and Handling are not refundable. All returns are subject to a minimum restocking fee of 5%. Prices may reflect mail-rebate. All returned
merchandise must be in new condition and must include all packaging and printed material in original, unaltered condition. Broadway Photo is not responsible for typographical errors. All items are covered by USA, International or Broadway
Photo and Video Warranty. Prices subject to change. Please check our website for current prices. All our merchandise is brand new and factory fresh. Quantities are limited. Thank you and enjoy your order.
MA 5/05
LS-40 ...........................$409.99
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DATA RECOVERY: 800-440-1904

7 great reasons to choose DriveSavers:
Fast, advanced, proprietary techniques.
All operating systems; Mac, Windows, OS/2,
Netware and UNIX.
� All storage devices including SAN, RAID and
NAS systems.
� Instantly retrieve recovered data
with DataExpress™.
� Recommended and certified by all
hard drive manufacturers.
� Government Contracts
� Featured on MacAddict,MacWorld,
Since 1985
CNN, BBC and others.
�
�

DATA RECOVERY: 800-44

“We Can Save It!”

Visit DriveSavers at www.drivesavers.com

©2003 DRIVESAVERS, INC. 400 BEL MARIN KEYS BLVD., NOVATO, CA 94949 INTL: 415-382-2000

Stereo Speaker / Charger

Bluetooth Stereo And
Tune Streaming Headset

Portable Stereo Speakers

All New iPod Accessories

Call us for dealers near you 1.800.644.1132 or visit us at: ww w.m aca ll y.co m
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FAMILY HISTORY - GENEALOGY

REUNION 8
®

Reunion 8 is the perfect tool to
organize your family history. Plenty of
room for names, dates, places, stories,
notes, tidbits, and
sources. Include
all your favorite
pictures, sounds,
and home movies.
Automatically
build multimedia
web pages to
share your family
history on the
Internet! Print large, colorful tree
charts, timeline charts, and fan charts
for family reunions. Fun
and educational for the
whole family. Reunion 8
takes advantage of OS X
and includes over
100 new features
and enhancements!

Leister Productions

web site/demo: www.LeisterPro.com
e-mail: info@LeisterPro.com

To order, call...

MacConnection 800-800-2222
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OmniCleanz™

New!

8:02 PM

Page 1

Advanced molecular
release agent safely
cleans ALL Displays,
Lenses, CDs and
much more!

“...it’s the bestjuicedisplay-cleaning
I’ve ever used.
”
May 05 MA

3/14/05

11:10 AM

Bob Levitus
Houston Chronicle

Page 1

www.radtech.us/ma

Software Savings for Students, Teachers, and Schools!
Get up to 85% off retail software prices on the brands you know and use…
Adobe®
Photoshop CS

Macromedia®
Studio MX 2004

Quark®
QuarkXpress 6.1

Wacom ®
Intuos3 6x8

Order Today!

Now! $189.95

Now! $189.95

Now! $279.95

Save! 57%
Get the Best for Less!

Save! $710

4 Programs - 1 Price!

Save! $856

The Industry-Standard!

Save! $50

Great Graphics Tool!

We carry thousands of industry-leading software and hardware products at huge discounts for students, teachers and schools. These special prices are
ONLY for the academic community. And our prices are typically $10-$20 lower than most college bookstores! Call or visit us online today and start saving!

Adobe®
Acrobat Pro 7............Save 69%
Creative Suite............Save 69%
Video Collection........Save 55%

Macromedia®
Flash MX 2004 .....................$95
Dreamweaver MX 2004 .......$95
Contribute 3 .........................$89

Alias®
Maya Complete Student.....$289

MakeMusic®
Finale 2005.............................$199

Canopus®
ADVC-300 A/D Converter ...$399

Microsoft®
Office 2004 Student/Teacher ..$139

This Month’s Featured Titles:
hp Business Inkjet 1200d ...$309
Eovia Carrara 4 Pro ............$139
Apple iWork..........................$75
Inspiration 7.6 ......................$49
Avid Xpress Pro Student.....$295
Painter IX..............................$95
Epson Stylus Photo R1800 ..$499
Sibelius 3............................$209

Parents:

Buy for your
students at home
or away at college!

Give us a call anytime! 1-800-294-4035
Visit us online! MA.AcademicSuperstore.com
Mac Shop MAY/05
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3/9/05

4:40 PM

MEGAMacs

W
W
W.

WE BUY MACS!

G3 366 $379 †
G3 500 $449 †
G3 700 $529 †
G3 800 $609 †

Print Shop 7 for OS 9
Print Shop 8 for OS X

G3 Trayload $199†
G3 Slotload $299†
G4 Flat Panel $449
†
AirPort Cards
$14
$109
$47

C
O
.M

We stock many parts!

Beige $69†
Blue & White $219†

Page 1

918-664-MACS
fax
918-663-6340 (6227)

DP 1.8 Ghz $1749 †
DP 2.0 Ghz $2149†
Rechargeable Optical Wireless Mouse

Kensington
StudioMouse Wireless
$34

AirPort Extreme
$69

Intego
Internet
Security
Barrier

Iomega Clearance Specials

Zip 100MB disks 3/4/6/10 pack
$10/13/19/32
Zip 250MB disks 4/6/8 pack
$19/24/31
Zip 100MB USB Powered Drive
$29
HipZip 80MB MP3 Player
$29
HipZip Auto Adapter
$14
Pocket Zip Disks
$4
Peerless FW drive 10GB
$49
Peerless 10GB Cart/ Extra FW Base
$34/14
$19/19
FotoShow Travel Kit / Remote
FotoShow AC Adapter/S-Video Cable
$19/4
Ditto Cartridges 3.7/5GB
$6/9
24x10x40 USB CDRW
$44
40x12x48 FW CDRW
$65
Jaz 50pin HD to 50pin Centronics Cable $14
Zip Monitor Mirror
$4
FREE w / online $10 purchase.cwww.meg-

Family Edition Professional Edition

Final Cut Express v.1~/ HD** $59/149
Final Cut Pro HD**
$549

$138
$144
$966

Ext. P2 40GB FW&USB
Ext. Porsche P3 160GB FW
See Megamacs.com/lacie

$147
$148

FREE ground shipping on LaCie drives! ‡‡

Notebook Accessories

Body Glove Notebook cases fits up to 17”
$24
Olympia Backpack Ergonomic!13”x17”x7”
$14
Notebook Locks Kensington Microsaver/Targus Defcon $29/14
Brenthaven High Performance Computer Cases up to 50% off MSRP
Profile 12”/15” • Pro shoulder 15”/17” $48 / 52 / 85 / 85
Mobility One • Oversized / Fusion Flex $56 / 94 / 94

Keyboards

Mice

Nyko 2button Optical
Logitech Cordless
Kensington Orbit
$9 Apple Pro Mouse~

MacAlly Media Keyboard $34
Internet Navigator
$21
USB Rollup keyboard
$19
Gravis USB Gamepad

JBL

$34 Creatures white, silver or blue
$34 19.5 Speakers
$24 Invaders (80 watts!)

Net Barrier
Virus Barrier
Content Barrier
Personal Backup

$49

$129 MSRP

Get all for $29 (save $32!)
PCalc2, Acrobat 5, Deimos Rising,
FaxStf X, Otto Matic

Office 2004

Standard ~$179/249
Pro
$469

Applecare MegaDeals
iPod
iMac / eMac
PowerMac G4/G5
iBook
Powerbook G4

$46
$117
$168
$177
$244

$19
$8
$4
$4 / 4
$4 / 4
$5
$9

Mac OS
$34
8.1
$79
8.5~
9.1~
$39
X.2 Jaguar**~
$22
X.2 upgrade~
$44
X.3 full install~
$59
X.3 retail
$99
Panther X.3 CD~
w/ iLife ‘03 / ‘04
$64/79

$12
$14
$15
$38

Virtual PC 7 w/Windows XP~
$194

Speaker BLOWOUT!

Harman Kardan

Champagne black
Champagne woodgrain, white
Duets

$39

$99 MSRP

•
•
•
•

Appleworks 6.2~
iLife 03~
Games CD~ Bugdom, Nanosaur and CroMag Rally!
Mayo Family Health / World Book Encyclopedia~
Bodyworks 5.0~ /Master of Orion II~
Grolier 1997 Multimedia Encyclopedia~
Adobe Pagemill 2.0~

www.megamacs.com/iomega

16x FW DVD+-RW
160GB FW / USB 2 HD
800GB FireWire 800
See megamacs.com / fantom

• Net Barrier
• Virus Barrier
• Content Barrier

$59
$13
$49

SystemWorks 3.0.1 $69

iLife ‘04~
$35

Mac OS X.3 Panther

OEM / Retail $59/99

OEM w/iLife 03 / 04 CD~ $64/89
OEM w/ Tech Tool Pro 4 $150
Retail w/ Tech Tool Pro 4 $164

FREE Norton SystemWorks 1.0 (OEM) available with any $20 online purchase!

All prices rounded down • Credit cards accepted
Prices subject to change • Not responsible for errors
See website for Pricing Policies

WE BUY MACS!

* Refurbished, † Pre-owned ^ Upgrade
~OEM, ** Upgrade with previous version

We stock many parts! ‡‡Free ground shipping only available for online orders
See all these deals and more at www.megamacs.com/macaddict
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MEMORY for PC and Apple, Laptops,
Digital Cameras, MP3 Players and more ...

WE CAN BEAT
Crucial, Kingston,
Comp-USA, ANYONE!
AND, WE GIVE YOU

FREE SHIPPING!

 We Manufacture Our Memory Using the
Highest Quality Components
 Lifetime Warranty
 Compatibility Guaranteed
 Free Technical Support
 Experienced Sales Staff Since 1994

TM

.com

1-800-4-MEMORY
1-800-463-6679
http://www.18004memory.com

Mac Shop MAY/05
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12 issues for only $12
A
A savings
savings of
of 83%
83% off
off the
the
newsstand rate!

Subscribe to Mobile at
www.mobilemagazine.com
or call toll-free
800-266-3312
MOBILE MAGAZINE is the world’s leading
authority on mobile technology
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Simply Talk…

…and leave the typing to us.
Still only

$149.00
with USB
headset!

MacSpeech is the only company currently developing
dictation software for Macintosh. iListen users enjoy the
ability to dictate into virtually any application, hands-free
correction, and the largest set of voice commands available
on any platform.
Available at the ﬁnest Mac resellers
or from www.macspeech.com.

A
“Mac-only”
company
Mac Shop MAY/05
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78
tell us how you really feel

PATTERN
RECOGNITION
Here’s something I came
across recently that I
haven’t seen mentioned
elsewhere. Look at the
Mac OS 10.3 (aka Panther)
install disc (top left) and
the soundtrack CD for the
Denzel Washington biopic
Malcolm X (top right).

Imitation is the
sincerest form
of ﬂattery.

Notice anything? Makes you
wonder about Tiger—will its
logo resemble my design
with the crossed golf clubs
(bottom left)?—Peter Weisz

MAKES CENTS
I noticed in What’s New
(Mar/05, p15) that Iogear
(www.iogear.com) is selling
its 20GB 1.8-inch Ion combo
drive for $249.95—the same
price as its 40GB model.
I think I’ll buy two of the
20GBs instead of one 40GB.
That’s just good shopping
cents. (Tee-hee … get it?
Cents? Sense?)—Paul Barker
We get it, Paul, we get it—
and we got the prices of the

Survey
Says

Here are the results
of our January 2005
survey. Check out
www.macaddict.com
each month for a new
online poll.

Ion drives wrong. At press
time, they were $209.95 for
the 20GB unit and $259.95
for the 40GB one.—Max

INSTABLOG
I enjoyed “Blog Your .Mac
HomePage” (Mar/05, p52).
I have a blog of my own (www
.wizardswords.blogspot
.com) that I built in about 30
minutes using Blogger. To
ﬁnd this service (it’s free, by
the way) go to Google.com,
click More, scroll down, and
click the red-orange B icon.
If you like what you see, get
busy and make a blog! I can’t
write a line of code, but I can
use Blogger.—Wizard
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Separated at birth?

TAPED DECK
My son Ben, an avid cardtrick enthusiast as well as
a creative artist, did some
cutting and taping when he
got his new iPod last week.
The result was his new
Loaded Deck iPod case!
—James Steele
Oh, that Ben—what a
card!—Max

Giving new meaning to the
term recording deck.

WINDOWS XXXP
Bill Gates is sleeping in my bed. How can I get
him to go away?—A. Venglar
Aww, why would anyone want to boot cute lil’
dreamboat Billy outta bed?—Max

LAST YEAR,
LOST YEAR
In your iWork ’05 preview
(“Think Big,” Mar/05, p16),
you claim Keynote 2 is “an
upgrade to the presentation
software released last
year.” This isn’t true.
Keynote was released in
2003, not 2004. Keynote
2 was released a full two

Which Apple expo announcement
most thrilled you?

10% iPod shufﬂe
70%
Mac mini

9% iLife ’05
7% iWork ’05
4% John Mayer’s
Grammy nominations

935 respondents
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Bedroom eyes,
boardroom soul.
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LETTERS

years after the original
Keynote.—Tony
Ah, how time flies when
you’re having fun.—Max

BAND OF
iBROTHERS
I teach Intermediate Band
at a high school. Last year,
in an attempt to update
what I felt was a slightly
demeaning name, I started
calling it the iBand. The kids
loved it, and the name has
really caught on.—D. Rutan

BITTER PHIL
Your articles on Halo
(“Halo’s Here,” Nov/03,
p39; Reviews, Mar/04,
p38) have made my life a
wasteland of Grunts, Elites,
and Hunters covered in
purple pus, not to mention
frumpy, creepy Flood
dripping in brown goop.

WRITE TO US!

MacAddict, 150 North Hill Dr., Ste. 40,
Brisbane, CA 94005
or letters@macaddict.com

The Flood remind me of
my ex-wife—they just keep
coming and coming, just
like the ex and her attorney
at the divorce hearing.
—Phillip Anthony Briles

MOM’S AN ADDICT
Our family got a new iBook
G4 after a recommendation
from me, a die-hard Mac
fan. After showing my mom
how it works, she’s now
on the thing all the time!
Is there any way to get her
off the iBook and back to
Windoze?—Lucas Wagner
Lucas, Lucas, Lucas—that’s
your poor, long-suffering
mom you’re talking about!
Save your lunch money,
buy a Mac mini, and let
the ol’ lady have some
fun.—Ma
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LOG OUT

FOR CD PROBLEMS:
go to www.futurenetworkusa.com
FOR SUBSCRIPTION QUERIES:
call (toll-free) 888-771-6222

MPEG movie ﬁles (mostly
EyeTV-archived shows),
and 150 DVD movies. I
have no problems playing
a movie downstairs on my
EyeHome unit while doing
other work on my Mac—it
works ﬂawlessly. If I were to
rate the updated EyeHome,
I would give it four-plus
stars.—Greg Speck
Glad to hear that Elgato has
spruced up its EyeHome—
but we call our blue reviewratings buttons “widgets,”
not “stars.”—Max

WIN!
Win a Set
of ProSticks!

This month, win a set of ProSticks—maxi-muscular,
audiophile-quality powered speakers from DVForge ($399,
www.macmice.com). Just write the best caption for the
picture below and send it in!
Only one entry per contestant.

Entry Form

EYEHOMEOWNER
I recently purchased an
Elgato EyeHome digital
media player ($199, www
.elgato.com) and found
that many of the problems
associated with your earlier
review (
May/04,
p55) have been eliminated
with the new EyeHome 1.52
update. I have a dual 1GHz
Power Mac G4, four internal
and six external drives,
4,000 photos in iPhoto 5,
15,000 songs and books
in iTunes, 96 TV shows
in an EyeTV archive, 100

The new Mac mini cookie
requires little dough.

SMART COOKIE
When I was making
Christmas cookies with my
grandparents, we had a
little blob of dough left, so
I made an Apple. That tells
you how often this loyal
12-year-old reader is
thinking about Macs.
—Keanan Koppenhaver
Kudos to Keanan “Keebler”
Koppenhaver, the Cookie
King!—Max

MORE FUN WITH SSH
The March ’05 issue’s Unix University mentions that you
can connect to a Remote Login–enabled Mac from another
Mac. What you forgot to mention is that you can connect
from just about any other computer that has an SSH
client, no matter what OS it’s running—Windows, Mac OS
9 or earlier, Linux, Solaris, Irix, whatever. For example, I
regularly control iTunes on my Mac OS X–equipped eMac
by running MacSSH (free, www.macssh.com) on my Mac OS
8.1–equipped PowerBook 540. I use one of the more useful
commands in Mac OS X, osascript, to run iTunes-controlling
AppleScripts on my eMac from the command-line interface
of MacSSH on the PowerBook 540.—Andrew Seidl

Write a caption for this picture.
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CONTESTANT INFORMATION
Full Name:
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Address:
City:

State:

Zip:
Email or telephone:
Send email entries to: contest@macaddict.com with the subject: ProSticks Contest
(Don’t forget to include your address information!)
Send snail-mail entries to: ProSticks Contest, MacAddict magazine,
150 North Hill Dr., Ste. 40, Brisbane, CA 94005.
Deadline for entry: May 31, 2005.
Contest results will appear in our Sep/05 issue.
Contest Rules The judges will be MacAddict editors and will base their decision on 33 percent humor, 33 percent
originality, and 33 percent creativity. All entries must be received no later than May 31, 2005, with the winner
announced around September 2005. By entering this contest, you agree that Future Network USA may use your name,
likeness, and Web site for promotional purposes without further payment. All prizes will be awarded, and no minimum
number of entries is required. If two or more people enter identical winning captions, the entry received ﬁrst will be
awarded the contest prize. Prizes won by minors will be awarded to their parents or legal guardians. Future Network
USA is not responsible for damages or expenses the winners might incur as a result of this contest or the receipt of a
prize, and winners are responsible for income taxes based on the value of the prize received. A list of winners may also
be obtained by sending a stamped, self-addressed envelope to Future Network USA c/o MacAddict Contest, 150 North
Hill Dr., Ste. 40, Brisbane, CA 94005. This contest is limited to residents of the United States. No purchase necessary,
void in Arizona, Maryland, Vermont, Puerto Rico, and where prohibited by law.

Winner!
Congratulations to Matthew Echert,
who won a copy of Macromedia’s
Studio MX 2004 ($899, www
.macromedia.com). And special
thanks to the 117 readers who
contributed some variation of
“C’mon baby, light my ﬁre.”

OK, now where are the
Rip and Mix ports?
May 2005
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SHUT DOWN

don’t let the back page hit you on the way out

Bread,
Milk—
and Don’t
Forget the
Apples
Grande lattes come with Wi-Fi
connections, iPod shufﬂes are sold
next to Wrigley’s gum in Japanese 7-11
stores—it won’t be long before the dream
of a Mac in every home and a ’Book under
every arm comes true. Don’t believe us?
Take a look at what we came upon while
shopping for bananas and toilet paper at
our local supermarket.
NE T W
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Let the PC world come to you.
Copy and paste. Drag and drop. Switch between Mac
and Windows® applications as easily as clicking between
documents. Microsoft ® Virtual PC for Mac Version 7 lets
you run PC programs on your Mac like a pro – sans the
suit and tie. See it work at www.microsoft.com/mac

